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A. Project Management

Quality Assurance Project Plan
Fenceline Monitoring for the Phillips 66 Los Angeles Refinery in Carson, California

The attached Quality Assurance Project Plan (QAPP) is hereby recommended for
approval and commits the Phillips 66 Los Angeles Refinery — Carson Operations (P66
Carson Refinery) to follow the elements described within.
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Review and Revision History

R R I
SIS Date esponsible Description of Change
Number Party

October 2, 2019 Initial Submission to South Coast AQMD
2 October 7, 2019 P66 Revised Submission to South Coast AQMD
3 August 5, 2024 P66 Updated in response to the January 5, 2024,

adoption of amended Rule 1180

This QAPP is intended to be a living document, meaning it will undergo regular review to ensure that
data quality assurance practices are robust and current. The QAPP will be reviewed at least annually
and any proposed updates will be submitted for approval to South Coast Air Quality Management
District (South Coast AQMD). The official version of this QAPP is maintained by P66 in Carson, CA.
This QAPP contains all critical documents for this program, including Standard Operating Procedures
(SOPs) and blank data entry forms.
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A.3 Distribution List

_ Neme | Omaniation | Role

Environmental Services

S Phillips 66 Carson Refinery Contact(s)
Public Relations Department Phillips 66 Carson Field Communication Advisor(s)
Wayne Nastri South Coast AQMD Executive Officer
Andrea Polidori, PhD South Coast AQMD A&is:;:):ir?gezl:giﬁ:;:;:;g::::’
Olga Pikelnaya, PhD South Coast AQMD Rule 1180 Program Manager
Hilary Hafner Sonoma Technology Quality Assurance Officer
All Project Personnel Sonoma Technology Various

Personnel included in above list will be provided with revisions of all critical documentation.

A.4 Project Organization

This QAPP details the specifications for operating the monitoring network. It outlines the operation
and maintenance of all instrumentation and equipment, data management and quality control (QC)
procedures, and public reporting via automated notifications and a publicly accessible website.

Refinery staff work with a designated contractor to achieve the goals of the fenceline monitoring
network. An organization chart (Figure 1) and various project roles are detailed below. Project
contact information is provided in Table 1.
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Refinery South Coast
Contact AQMD

Project QA
Manager Manager

Data Systems Field Staff QA

Manager Manager Analyst

Field On-Call

Technicians Support Staff Sl

Figure 1. Organization chart for the refinery’s fenceline monitoring project.

Refinery Contact. The Refinery Contact is responsible for project oversight and serves as the primary
point of contact for the refinery. They facilitate communication between the refinery and South Coast
AQMD.

Project Manager. The Project Manager is responsible for the successful execution of the fenceline
monitoring project and serves as the primary point of contact for the contractor. The Project
Manager oversees day-to-day monitoring operations, coordinates with all project personnel, and
reports to the Refinery Contact. They also work closely with the Quality Assurance Manager to ensure
that the QAPP and SOPs are followed, and oversee corrective action plans when needed.

Quality Assurance Manager. The Quality Assurance Manager (QA Manager) provides overall
guidance for the evaluation of data. The QA Manager is responsible for evaluating data for
adherence to project specifications and ensuring that QA activities remain independent from data
collection. If deviations are discovered, the QA Manager coordinates with the Project Manager to
determine and implement necessary corrective actions.

Field Staff Manager. The Field Staff Manager oversees the team responsible for operating and
maintaining all instrumentation and equipment at the refinery fenceline monitoring sites. They work
closely with Field Technicians and Subcontractors, coordinate staff coverage and additional science
support as needed, and regularly provide updates to the Project Manager.

Field Technicians. Field Technicians are responsible for the successful operation of instrumentation
and equipment, providing routine maintenance according to SOPs. They are qualified to work on
refinery property and with all scientific instrumentation. They also perform required quality checks
according to this QAPP and document their work in site logs.

On-Call Support Staff. On-Call Support Staff are responsible for responding to automated system
alerts outside of normal business hours, including remotely troubleshooting data flow outages and
validating potential detection events. They are trained on the theory of operation for all field
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instrumentation and equipment, and conduct abbreviated data checks to identify operational issues
requiring field support.

Subcontractors. Subcontractors may be used to provide additional technical support for
instrumentation and equipment. They are overseen by the Field Staff Manager and adhere to all
project requirements.

Data Analysts. Data Analysts conduct routine daily data checks to ensure accuracy of real-time
reporting on the public website, and relay issues to the Field Staff Manager as needed. They also
conduct an extended analysis every calendar quarter to generate data products for regulatory
reporting efforts, including the assembly of final data sets.

Quality Assurance Analyst. The Quality Assurance Analyst (QA Analyst) conducts independent
reviews of data products to confirm data analysis activities have been conducted according to the
QAPP. The QA Analyst works closely with the QA Manager and Data Analysts.

Data System Manager. The Data System Manager is responsible for continuous real-time data flow,
routine operation of the automated alerting system, and proper data display on the public website.
They work closely with Field Technicians, Data Analysts, and the Project Manager to ensure the
system is operational and real-time data are reported to the public.

Table 1. Project contact information.

| Name | Organization ] __Role | __ContactInformation

24-Hour Field larpaac@p66.com
Community P66 Carson Refinery Communication 310-543-7431
Awareness Advisor(s) (English and Spanish)

hilary@sonomatech.com

Hilary Haf S Technol AM
ilary Hafner onoma Technology QA Manager 707-665-9900

A.5 Problem Definition and Background

The P66 Los Angeles Refinery conducts air quality monitoring at its refinery in Carson, CA, pursuant
to South Coast AQMD Rule 1180." Measurements are collected according to a Fenceline Air
Monitoring Plan (FAMP) consistent with Fenceline Air Monitoring Plan Guidelines,? and data are
reported in real time on a publicly accessible website.

The required compounds to be measured under amended Rule 1180 include criteria air pollutants
(sulfur dioxide [SOz2], oxides of nitrogen [NOx], particulate matter less than 10 and 2.5 microns in

" https://www.agmd.gov/docs/default-source/rule-book/reg-xi/r1180.pdf
2 https://www.aqgmd.gov/docs/default-source/rule-book/support-documents/1180/rule-1180-guidelines.pdf


mailto:joya.c.gathe@p66.com
mailto:sschill@sonomatech.com
https://www.aqmd.gov/docs/default-source/rule-book/reg-xi/r1180.pdf
https://www.aqmd.gov/docs/default-source/rule-book/support-documents/1180/rule-1180-guidelines.pdf
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diameter [PM10and PMzs)), volatile organic compounds (total VOCs, formaldehyde, acetaldehyde,
acrolein, 1,3-butadiene, naphthalene, polycyclic aromatic hydrocarbons [PAHs], styrene, benzene,
toluene, ethylbenzene, and xylenes [BTEX]), metals (cadmium, manganese, nickel), and other
compounds (hydrogen sulfide [H2S], carbonyl sulfide, ammonia, black carbon [BC], hydrogen
cyanide, hydrogen fluoride). Facility-specific exemptions and justifications for monitoring are detailed
in the FAMP.

The California Environmental Protection Agency (EPA) Office of Environmental Health Hazard
Assessment’s (OEHHA) acute 1-hr reference exposure limit (REL) values are used as a reference for
fenceline monitoring because they represent the concentration thresholds above which compounds
are considered hazardous to human health. For criteria air pollutants, the National Ambient Air
Quality Standards (NAAQS) values are used where they are lower than OEHHA RELs.

Rule 1180 requires public notifications when hourly concentrations measured by the fenceline
monitoring system exceed defined thresholds. Table 2 lists the notification thresholds for the
compounds included in this fenceline monitoring program, for which sampling methods capable of
measuring below these values were selected. All thresholds are defined on an hourly basis and units
are ppb, unless otherwise indicated. Detailed information regarding monitoring methods is provided
in the FAMP and Section B of this document.
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Table 2. Rule 1180 notification thresholds.

Health Standard-Based Information-Based
Compound o e
Notification Threshold (ppb) ] Notification Threshold (ppb)

Criteria Air Pollutants

Sulfur Dioxide 75 --
Oxides of Nitrogen 100 --
PMzs 35 pg/m?3(24-hr) -

PMio 50 pg/m? (24-hr) -

Volatile Organic Compounds

Total VOCs = 730
Formaldehyde 44 =
Acetaldehyde 260 ==

Acrolein 1.12 =
1,3-Butadiene 297 --
Naphthalene = =

Styrene 5,000 ==

Benzene 8 ==

Toluene 1,300 --
Ethylbenzene == =

Xylenes 5,000 --

Other Compounds
Hydrogen Sulfide 30 =
Carbonyl Sulfide 270 -
Ammonia 4,507 =
Black Carbon = =
Hydrogen Cyanide 309 —

@ The minimum detection limit (MDL) is greater than the notification threshold for this compound, so
notifications are not sent, as described in the FAMP

A.6 Project Description

The P66 Carson Refinery currently conducts fenceline monitoring of criteria air pollutants (SOz, NO2),
volatile organic compounds (total VOCs, formaldehyde, acetaldehyde, acrolein, 1,3-butadiene,
styrene, BTEX), and other compounds (HzS, carbonyl sulfide, ammonia, BC, hydrogen cyanide).
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Naphthalene and PM will be monitored following the January 5, 2024, amendment of Rule 1180, as
described in the FAMP. The Carson Refinery is exempt from monitoring hydrogen fluoride, metals,
and PAHs.

Sampling sites were selected in consideration of nearby local receptors (e.g., schools and daycare
facilities, recreational areas, hospitals, and residences) and dominant winds in the area. Preliminary
data from fenceline monitors are quality controlled and reported in real time to a publicly accessible
website, and final quarterly data sets will be (1) made available for public download and (2) made
available to be transmitted electronically to the South Coast AQMD Executive Officer. Additional
details are provided in the FAMP and Section B of this document.

Additional details about the fenceline monitoring project are provided in the FAMP.

Data quality objectives (DQOs) outline the major question(s) to be answered by a monitoring project
and ensure collected data are of sufficient quality to support project goals. The U.S. EPA provides a
seven-step process to establish DQOs:

1.

Problem Statement: The goal of this monitoring program is to meet the requirements of
South Coast Rule 1180, which was established to provide the public with information
regarding concentrations of target compounds at the fencelines of refining facilities.

Decision: Refineries provide information to the public regarding concentrations of target
compounds consistent with South Coast Rule 1180 and their facility’s FAMP.

Information Inputs: Concentration data from open-path analyzers and point monitors are
provided as 5-min and 1-hr rolling average concentrations. Data are reviewed with respect to
representativeness and comparability, using measurements from other available sources in
similar geographic locations serve as a basis of comparison.

Study Boundaries: Concentration measurements are collected along refinery fencelines, in
accordance with South Coast AQMD Rule 1180 and each facility's FAMP.

Decision Rule: Measurements are collected and reported in real time, in accordance with
South Coast AQMD Rule 1180 and the facility’s FAMP.

Acceptance Criteria: Data will be considered acceptable for reporting provided they meet the
defined performance criteria for the project.

Data Collection: Unless otherwise noted in the FAMP, data are collected every 5 minutes,
24 hours a day, 7 days a week. Automated screening is performed in real time before data
are posted to a publicly accessible website.
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Data quality indicators (DQIs) are the quantitative statistics and qualitative descriptors used to
interpret data’s degree of acceptability or utility in consideration of the project’s DQOs. The DQIs for
the South Coast AQMD Rule 1180 fenceline monitoring project are defined below. Accuracy and
precision are quantitative metrics, representativeness and comparability are qualitative metrics, and
completeness is a combined quantitative and qualitative metric.

Accuracy is the metric of agreement between an observed value and an accepted reference value,
and is calculated using some derivation of error or recovery from a bump test data set. Additional
details are provided in Section B.7 of this document.

Precision is the metric of mutual agreement among individual measurements of the same parameter,
otherwise known as the random component of error. Precision is calculated using some derivation of
the standard deviation of a bump test data set. Additional details are provided in Section B.7 of this
document.

Representativeness refers to the degree to which data collected by the monitoring project broadly
represent ambient conditions, variations between sampling sites, and potential detection events.
Representativeness is primarily controlled by the sampling locations, which are detailed in the FAMP.

Concentrations of target compounds will be reported in parts per billion (ppb) and micrograms per
cubic meter (ug/m?3), consistent with the requirements of Rule 1180. Routine bump tests with
National Institute of Standards and Technology (NIST)-traceable reference gases ensure that
concentrations reported by open-path analyzers and point monitors are comparable to other
available measurements.

Completeness is a measure of the amount of usable data obtained by the monitoring project
compared to the potential amount expected to be obtained under normal operating conditions. The
goal of the monitoring project is to maximize system uptime through robust analyzer maintenance,
routine data review, and short response times for addressing system issues. Quantitative metrics for
calculating completeness are detailed further within this section.

Measurement quality objectives (MQOs) are individual performance or acceptance goals that directly
translate each DQI into discrete analytical performance criteria. The MQOs for this fenceline
monitoring project are detailed below.
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Accuracy and precision are assessed for open-path analyzers and point monitors through routine
bump and span tests with NIST-traceable reference gases (where possible). The acceptance criteria
shown in Table 3 are used for periodic testing (i.e., monthly, quarterly, annually), as well as for
continuous, automated QC (AutoQC) of real-time data.

An appropriate manufacturer-specific reference kit is used to assess accuracy of the meteorological
sensors (wind speed and direction, temperature and relative humidity, and visibility) by comparing
observations to reference measurements.

Additional details regarding instrument calibration and frequency are provided in Section B.7.
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Table 3. Acceptance criteria for instrumentation and equipment.

Bump Test (Accuracy and Precision)

Spectral Match (r?)
Signal Intensity

Bump Test
(Accuracy and Precision)

Amplitude Ratio
(Analogous to Spectral Match)

Zero Path Difference (ZPD)
Peak to Peak Voltage
(Analogous to Signal Intensity)

ZPD Position

Span Test
(Accuracy and Precision)

Zero Test

Multipoint Calibration

Flow Check
Neutral Density Check

Flow Check
Span Dust Check

Wind Speed (accuracy)

Wind Direction (accuracy)
Temperature (accuracy)

Relative Humidity (accuracy)

Extinction Coefficient (accuracy)

UV-DOAS

Quarterly
(and after major service)

Continuous
Continuous
FTIR

Quarterly
(and after major service)

Continuous

Continuous

Continuous
H,S Point Monitor

Biweekly
(and after major service)

Biweekly
(and after major service)

Quarterly
(and after major service)

Aethalometer
Monthly
Quarterly

PM Analyzer
Monthly
Quarterly

Meteorological Sensors

Semiannual

Semiannual

Semiannual

Semiannual
Visibility Sensor
Annually

QA/QC Checks

+25%

0.8-1.0
>10%

256-257

+15%

12 ppb

12 ppb (zero)
+15% (each nonzero test conc.)

£10%
+10%

+5%

+0.5 channel tolerance

+0.25 m/s (below 5 m/s)
+5% (above 5 m/s)

+5 degrees
+0.5 degrees C
7%

+25%
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Data completeness is assessed by reviewing the data QC/OP codes assigned for each sample
path/site and compound. Completeness statistics are defined as follows:

Possible: The maximum number of data points that could theoretically be logged in the Data
Management System (DMS) during this quarter.

Captured: The number of data points that were logged in the DMS during this quarter.

Missing: The number of data points not logged in the DMS during this quarter.

e Missing = Possible — Captured

% Missing: The percentage of Missing data points relative to Possible during this quarter.

e % Missing = (Missing / Possible) * 100

Invalid-Weather: The number of data points that are invalid due to weather during this quarter.

e These data are designated as QC = 9, OP = 73 — "Low Visibility Conditions”

Planned Maintenance: The number of data points that are invalid due to planned instrument
maintenance during this quarter.

e These data are designated as QC = 9, OP = 28 - “Planned Instrument Maintenance”
Unplanned Maintenance: The number of data points that are invalid due to unplanned instrument
maintenance during this quarter.

e These data are designated as QC = 9, OP = 29 — "Unplanned Instrument Maintenance”
Expected: The number of Possible data points corrected for periods of low visibility conditions and
planned instrument maintenance during this quarter.

e Expected = Possible — Invalid-Weather — Planned Maintenance
Invalid: The number of data points with an invalid QC code (QC = 9) during this quarter.

% Invalid: The percentage of Invalid data points relative to Possible during this quarter.
e % Invalid = (Invalid / Possible) * 100

Suspect/Questionable: The number of data points with a suspect QC code (QC = 5) during this
quarter.

% Suspect/Questionable: The percentage of suspect/questionable data points relative to Possible
during this quarter.

e % Suspect = (Suspect / Possible) * 100
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Valid: The number of data points with a valid QC code (QC = 0) during this quarter.

% Valid: The percentage of Valid data points relative to Possible during this quarter.

e % Valid = (Valid / Possible) * 100

Public Recorded: The number of data points with a valid or suspect QC code (QC = 0 or 5) reported
on the public website for this quarter.

% Complete: The percentage of Public Recorded data points relative to Expected during this quarter.

e % Complete = (Public Recorded / Expected) * 100

All project personnel are provided with necessary training and oversight, including:
1. Safety courses administered through the Occupational Safety Councils of America (OSCA)
2. Instrument-specific training from vendors
3. Data validation training from experienced Data Analysts

4. Routine operations and maintenance training from experienced Field Technicians

Training is conducted by (1) senior staff with at least one year of experience operating refinery
fenceline monitoring systems and (2) analyzer manufacturers. Project personnel are provided copies
of the FAMP, QAPP, and SOPs, and receive updated versions when available. Initial training is
provided prior to personnel performing work on the system, and refresher trainings are conducted
on an annual basis. The QA Manager will identify specific training requirements for all project
personnel and will determine when trainees are qualified to work independently. Training records will
be maintained by the Field Staff Manager. Additional details regarding training and certification are
provided in the SOPs attached to this QAPP (Attachments 1-8).

Quality system documentation, including the FAMP, QAPP, and SOPs, are routinely revised to reflect
current best practices, improvements to available technology and data control practices, and
fenceline monitoring program changes. Revisions are undertaken at the direction of the QA
Manager. In addition to quality system documentation, quarterly reports are produced to provide a
summary of system performance over each calendar quarter, which may include data summaries,
statistical analyses, and results of QC tests. These reports are generated by relevant project staff,
overseen by the QA Manager, and delivered to South Coast AQMD. They will also be made available
for download on the public website.
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The fenceline contractor (Sonoma Technology) achieves work product quality through a series of
internal review-and-correction cycles and an external review by the client. Documents undergo at
least two internal reviews—the first by a senior technical staff member who is knowledgeable about
the subject matter but is not the primary author of the work, and the second by a technical editor
who is skilled in English mechanics and writing style. Before any document (draft or final) is delivered
to the refinery, the lead author or Project Manager conducts a final quality review and approves it for
delivery. Final approved versions in PDF format are distributed to refinery staff and/or appropriate
project personnel via email.

Sonoma Technology employs a robust, systematic approach to version tracking and file maintenance.
Each document is stored by project number on a shared fileserver. Only the most recent version is
stored in the top-level folder, and each draft version is tracked by a timestamp as well as all
reviewers' initials in a subfolder. A unique Master File Number is assigned to each document and all
versions of that document retain that number.

Sonoma Technology's proprietary Deliverables Organizer and Tracking System (DOTS) is used to track
progress and facilitate management of all quality documentation and work products. The web-based
system retains information on document versions, including the dates and names of employees who
edited, reviewed, and revised each document. DOTS also contains standard reports for tracking
deliverables through the QA/QC and delivery process, and ensures that document information can
be easily retrieved. A lead author or Project Manager creates a DOTS entry for each upcoming
deliverable, and then the project Technical Editor maintains the DOTS record as each deliverable
progresses through the update, review, delivery, and archiving process. Microsoft Word and PDF
versions of all final approved documents are preserved on Sonoma Technology's fileserver in a
secured Master File Library.

All staff involved in fenceline monitoring have been provided with electronic copies of SOPs. Revised
versions of SOPs will be distributed to both refinery and contractor staff via email, and will be stored
on a shared drive. Additionally, hard copies of the SOPs and analyzer user manuals are kept in the
analyzer shelters and replaced when revisions are completed. Updating digital and hard copies of the
QAPP and SOPs ensures that staff only use the most recent version to meet measurement and data
quality objectives.

The analyzer shelters also contain logbooks where all onsite activities related to the fenceline
monitoring system are recorded. This includes planned maintenance activities and emergency site
visits. The field logbooks are scanned each month to generate electronic copies.

Any corrections made to hard-copy documents will be indicated by (1) a cross out of the previous
entry, (2) the addition of a new entry, (3) the date of correction, and (4) the initials or name of the
individual making the correction. Electronic documents (reports and data) are stored on a password-
protected server at Sonoma Technology, with current and previous versions stored by project and
document.
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All project documentation will be retained by P66 for at least 5 years following the end of the
project.
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B. Data Generation and Acquisition

The fenceline monitoring system is designed to meet the following key sampling objectives:

e Provide measurements of air pollutant concentrations in real-time with short enough time
resolutions to adequately address significant emissions changes from facility operations;

e Gather accurate meteorological data to identify factors that may impact air pollutant levels
near facility operations; and

e Track long-term air pollutant levels, variations, and trends over time at or near refinery
property boundaries.

A combination of open-path analyzers and point monitors were selected after consideration of all
Rule 1180 requirements, including (1) spatial coverage necessary to monitor hundreds of meters of
refinery fenceline, (2) 5-min resolution for real-time data, and (3) required detection limits, accuracy,
and precision of target compounds. Heavy fog, rain, or smoke may block the signal from an open-
path instrument and prevent data collection, but even light fog can partially absorb the signal and
interfere with measurements. Once installed, visibility sensors will confirm when low-visibility
conditions result in invalid data from open-path instruments.

Sampling locations are shown in Figure 2 and are further described in the FAMP. Additional details
about open-path analyzers and point monitors are provided in Section B.2.
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Figure 2. Sampling locations for the P66 Carson Refinery fenceline monitoring system.

B.2 Sampling Methods

BTEX, SOz, and naphthalene are measured by bistatic UV-DOAS (source and detector on opposite
ends of the sampling path) with a xenon light source. The xenon light source is required to achieve
sufficient detection limits for target compounds. Each of these compounds has a unique absorbance
spectrum, meaning they absorb different amounts of light at discrete wavelengths. This is measured
by the analyzer, which then compares regions of a sample absorbance spectra to the same regions of
a reference absorbance spectra.

Total VOCs (measured as a sum of hexane and 1,3-butadiene), formaldehyde, acetaldehyde, acrolein,
1,3-butadiene, styrene, carbonyl sulfide, ammonia, hydrogen cyanide, and NO: are measured by
monostatic FTIR, which operates similarly to the UV-DOAS. A combination of industry standard and
proprietary methods are used to mitigate interference from water vapor and interference gases.

For both UV-DOAS and FTIR, a classic least squares regression analysis provides a spectral match
parameter (r?), which is used to identify potential interferences present in the sample path. The
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primary means of avoiding absorbance due to interfering gases is to select regions of the
absorbance spectrum specific to the target compounds and free of absorbance due to other gases.
Spectral subtraction is used in cases with overlapping absorbance features, and the subtraction
technique is proprietary to the instrument manufacturer. Spectral matching is used to identify target
compounds, and Beer's Law is used to report the concentration. This approach is comparable to U.S.
EPA’s TO-16 Methodology.?

HzS concentrations are measured through UV-induced fluorescence, whereby HzS is converted to
SO, exposed to UV light, and the resulting emitted photon is measured in real time. BC is measured
with aethalometers, which draw air through permeable tape and measure the absorbance at a
defined wavelength of the deposited samples. This system detects particles in the air commonly
associated with vehicle emissions (diesel exhaust) and wood burning (soot). PM10 and PMzs will be
measured with optical scattering.

MDLs for each analyzer are provided in the FAMP. Instrument operations and maintenance,
emergency site visits, and corrective actions are detailed in Section B.6 of this document.

Analyzers are located in secure sites to prohibit tampering or handling by anyone other than
authorized personnel. Technicians keep sampling shelters clean and routinely check analyzers for
debris or residue during site visits. Real-time data are transmitted to the DMS by cellular modem and
can only be accessed by authorized personnel. All changes to data within the DMS are tracked
through chain-of-custody logs.

No laboratory analyses are required for this monitoring project, so no discussion of sample
preparation, storage, or transport is required.

Refer to Section B.2 of this document for information regarding real-time sampling methods. No
laboratory analyses are required for this monitoring project.

3 U.S. Environmental Protection Agency (1999) Compendium of methods for the determination of toxic organic compounds in
ambient air: compendium method TO-16. Second edition, prepared by the U.S. Environmental Protection Agency, Office of Research
and Development, Cincinnati, OH, EPA/625/R-96/010b, January. Available at


https://www3.epa.gov/ttnamti1/files/ambient/airtox/tocomp99.pdf
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B.5 Quality Control Requirements

Real-time data from open-path analyzers undergo several rounds of QC, including AutoQC logic
which flags data before they are posted on the public website. Analysis and QC of real-time data is
described in Section D.2 of this document and the SOP for Data Verification and Validation
(Attachment 8).

B.6 Instrument/Equipment Testing, Inspection, and
Maintenance

Routine Maintenance

Tables 4 and 5 summarize the routine maintenance activities as recommended by the UV-DOAS and
FTIR instrument manufacturers, and additional details are provided in the instrument SOPs
(Attachments 1 and 2). Preventive maintenance frequency depends on the operating environment,
and may need to be adjusted depending on field conditions. Any necessary changes will be reflected
as an update to this QAPP, which will be submitted to South Coast AQMD for approval.

Table 4. Schedule of routine maintenance activities for UV-DOAS open-path analyzers.

Activity Monthly Quarterly | Annually

Visually inspect the system

AN

Inspect detector optics; clean if necessary

\

Inspect all electrical cables for wear; replace as needed

\

Confirm the alignment of the light source and detector

Ensure that there are no obstructions between the light source
and detector (e.g., refinery equipment, vegetation, or vehicles)

\

Perform bump test
Replace light source

Replace system filters

<N X X

Archive historical data and remove from analyzer computer
Clean detector optics 4

Document signal levels to establish a baseline for light source v
replacement frequency

Verify system settings v
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Table 5. Schedule of routine maintenance activities for FTIR open-path analyzers.

Visually inspect the system

Inspect detector and retroreflector optics; v
clean if necessary

Confirm the alignment of the light v
source/detector and retroreflector

Ensure there are no obstructions between the
light source/detector and retroreflector (e.g., 4
refinery equipment, vegetation, or vehicles)

Perform bump test v
Clean retroreflectors v

Archive historical data and remove from
analyzer computer

Test and document signal levels to establish a
baseline for light source and retroreflector v
replacement frequency

Replace the light source v

Replace cryocooler v

Maintenance activities for the H2S point monitors are summarized in Table 6 and additional details
are provided in the SOP (Attachment 3).

Table 6. Schedule of routine maintenance activities for H,S point monitors.

Vonthly Annually

Perform Zero and Span (Z/S) check

AN

Review and verify test functions

AN

Inspect sample lines

AN

Change inlet particulate filter

{\

Perform flow check
Perform multi-point check 4
Replace SO, scrubber material and sintered filters v

Check for H,S->SO; converter efficiency (CE), replace or service
the converter if CE < 96%

Replace the critical flow orifice assembly

AN

Perform a pump check and rebuild if needed
Perform leak check

AN N NN

Perform UV lamp adjustment
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Activity Monthly | Quarterly AnnuaIIy

Perform photomultiplier tube (PMT) sensor hardware calibration

Calibrate offset and slope v

Maintenance activities for the aethalometers are summarized in Table 7 and additional details are
provided in the SOP (Attachment 4).

Table 7. Schedule of maintenance activities for the Magee AE33 Aethalometer.

Activity vorty

Visually inspect the system
Inlet flow check

Clean size selective inlet
Clean cyclone

Verify date and time

Bl By

Calibrate flow

Inspect tape roll and replace as needed

Inspect optical chamber and clean as necessary
Calibrate tape sensor

Clean air test

Stability test

A N N N NN

Neutral density filter test
Grease optical chamber sliders

Inlet leakage test

<N X X

Change bypass cartridge filter

Maintenance activities for the PM point monitors are summarized in Table 8 and additional details
are provided in the SOP (Attachment 5).

Table 8. Schedule of maintenance activities for the Teledyne T640X.

Activity Bl

Clean inlet

Check/adjust PMT with SpanDust™

Check pump performance

Flow rate verification (sample, bypass and total flow)

Perform leak check

D N N N NN

Inspect inner and outer sample tubes
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Monthly

Inspect and clean optical chamber and RH/T sensor

Change disposable filter for 5-LPM flow and bypass flow v

Semiannual maintenance activities for the meteorological sensors are summarized in Table 9 and
additional details are provided in the SOP (Attachment 6). Calibrations are conducted according to
EPA recommendations.*>¢

Table 9. Semiannual maintenance activities for meteorological sensors.

Tower

Anemometer

Temperature/
RH Sensor
and Shield

Visibility
Sensors

Data Logger
Enclosure

Guy Wires

Solar Power

Check that the tower is securely anchored to the shelter

Check the tower for signs of damage or excessive wear

Inspect all bolts at the tower base for any signs of corrosion (rust)

Check the tower's vertical alignment

Note if any component (tail, propeller) is missing or has suffered obvious damage

Check that the whole sensor moves freely with a changing wind direction and the
propeller rotates freely when windy

Inspect the hardware holding the temperature/RH sensor shield assembly to the tower
and tighten the bolts if necessary

Check that the cable connections are secure

Inspect the sensor for dirt, spiderwebs, birds' nests, or other obstructions and clean the
glass windows

Check that the cable connections are secure

Inspect the hardware holding the sensors to the tower and tighten bolts if necessary
Verify that the enclosure is secured inside the shelter and is operational

Check that the cabling to the enclosure is secure and undamaged

Check the integrity of the cables connecting the data logger box to the sensors

Where guy wires are used, check if they are taut and the attachment points are tight;
verify cables are not frayed and the integrity has not been compromised in any way

Where solar power is used, check that the solar panel is clean and free of debris;
confirm all connections to the battery are secure and free from corrosion.

4 U.S. Environmental Protection Agency (1994) Quality assurance handbook for air pollution measurement systems, Volume I: a field
guide to environmental quality assurance. EPA/600/R-94/038a. Available at https://www3.epa.gov/ttn/amtic/qalist.html.

> U.S. Environmental Protection Agency (2017) Quality assurance handbook for air pollution measurement systems, Volume II:
ambient air quality monitoring program. EPA-454/B-17-001, January. Available at https://www3.epa.gov/ttnamtil/qgalist.html.

6 U.S. Environmental Protection Agency (2008) Quality assurance handbook for air pollution measurement systems, Volume IV:
meteorological measurements version 2.0 (final). EPA-454/B-08-002, March. Available at
https://www3.epa.gov/ttn/amtic/qalist.html.


https://www3.epa.gov/ttn/amtic/qalist.html
https://www3.epa.gov/ttnamti1/qalist.html
https://www3.epa.gov/ttn/amtic/qalist.html
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Maintenance activities for the visibility sensor are summarized in Table 10 and additional details are
provided in the SOP (Attachment 7).

Table 10. Schedule of routine maintenance activities for visibility sensor.

Monthly | _Annually

Visually inspect the system, including all cables v
Inspect detector optics; clean if necessary 4
Perform calibration (extinction coefficient) v

Emergency maintenance occurs when problems are identified with the fenceline monitoring network.
Two teams of after-hours (on-call) support personnel remotely monitor the status of instrumentation
and the data pipeline (acquisition, DMS, public website) 24 hours a day, 7 days a week. Automated
alerts are sent if potential issues are identified, such as:

1. Missing data
2. Reported concentrations outside of an expected range

3. Instrument diagnostics indicate a potential malfunction

The Sonoma Technology field operations team (Field Ops) is led by the Field Staff Manager, and the
information systems team (IS Ops) is led by the Data Systems Manager. The nature of potential
issues determines which team receives automated alerts. On-call personnel are required to
acknowledge alerts within 30 minutes of receipt and attempt to resolve potential issues remotely.
This approach ensures that issues are identified and addressed in a timely manner, which maximizes
fenceline monitoring network uptime.

The Field Ops team addresses most issues pertaining to instrumentation and equipment. In the case
of missing data, refinery personnel are notified if the cause of the alert cannot be resolved remotely,
South Coast AQMD is notified of monitoring downtime as required by Rule 1180, and a maintenance
message may be posted on the public website. Backup monitoring may be conducted as described
by the FAMP if an extended outage is anticipated. In the case of elevated concentrations, data are
reviewed and the refinery is notified whether the detection is legitimate or due to a potential
instrument malfunction. Data flags are updated on the public website during daily data checks to
ensure accuracy, including for potential after-hours events. Any required field site visits occur on the
next business day, and all corrective actions performed are documented in on-site logbooks.

The IS Ops team addresses most issues pertaining to data flow and the public website. Table 11
outlines examples of automated screening, which the IS Ops team may review to troubleshoot
potential issues.
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Table 11. Examples of automated screening pertaining to the data pipeline and public website.

HTTP test of th
Website Availability . . est of the . 300 sec Pass/Fail
public and internal websites

CPU utilization >60%

DMS Memory use 300 sec >75%

Disk space used >75%
Data Flow Time since last datum received 30 min Pass/Fail
Data Processing Errors Process scheduler 300 sec Pass/Fail

As discussed in Section A.7, DQIs for open-path analyzers are assessed through completion of bump
tests and calibrations. These are part of the routine operations and maintenance of the system, which
are further detailed in Section B.6 and in the instrument SOPs (Attachments 1-8).

A new and improved bump test procedure using NIST-traceable reference gas and flow through test
cells is currently under development. Bump testing verifies open-path analyzer detection capability,
accuracy, and precision. Concentrations are selected such that they are well above the level of
guantitation, but near or below levels of concern for target compounds. Accordingly, path-average
concentrations for benzene and ammonia are typically on the order of 1-20 ppb. Bump tests are
performed when the atmospheric influence on sample variability is assumed to be minimal, meaning
tests are not conducted in rain, fog, or when ambient concentrations of target compounds or
interfering gases (e.g., ozone) are changing rapidly. Retroreflector housings include a heater/fan
system designed to mitigate the effects of condensation and particulates on the retroreflector
surface.

Bump tests are performed by introducing NIST-traceable reference gases (where possible) into the
open sampling path using a test cell. During the test, light passes through the test cell and entire
atmospheric path length, and then to the detector. Because the light travels through the ambient
atmosphere, which includes other gases and particles as it would during a normal measurement, this
test is a representative assessment of the instrument’s capabilities under the influence of
environmental conditions. During bump tests, a number (N) of replicated measurements (x;) of a
standard reference material of known magnitude (x,:4) will be measured. An acceptable number of
trials is defined as 7<N<15, and a subset of test data which meet the acceptance criteria (Section
A.7) will be used for subsequent calculations. The average value of these measurements is calculated
as:
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The standard deviation (o) is defined as:

Yi(x—%)?
N-1

o =

From these definitions, accuracy (as % error) is defined as:

m x 100%

% error = |
Xstd

Precision (as the % coefficient of variation, CV) is defined as:
o
Precision = %CV = 7 X 100%

The frequency of bump testing may be decreased over time if measurements prove adequate
stability or metadata provide assurance that instruments are working properly. Any potential changes
will be reflected as an update to this QAPP, which will be sent to South Coast AQMD for approval.

The Field Staff Manager is responsible for inspection and acceptance of all supplies and consumables
for the monitoring project. A certification of reference gases used for routine bump and span tests
will be requested from the gas supplier (where possible), and standards will not be used past their
expiration dates.

Part of the data validation methods detailed in Section D.2 includes comparison of fenceline
monitoring data to remote background and average urban concentrations with the goal of
determining overall data reasonableness. This comparison includes a combination of qualitative and
guantitative assessments of general spatial or temporal trends in target compound concentrations,
such that measurements from this monitoring program may be compared against other external
data sources. Though no direct quantitative data product is generated from this comparison effort,
comparisons to external data sources generally increase the confidence in data products and, by
extension, the overall value of the monitoring project.

External sources of data used for comparison may include the National Oceanic and Atmospheric
Administration (NOAA), the National Aeronautics and Space Administration (NASA), South Coast
AQMD (e.g., MATES-V), and the U.S. EPA. Common target compounds may include PM, BC, or criteria
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air pollutants, depending on available data sets. Data used for comparison will include quality
controlled final data where available, though preliminary data may be considered for qualitative
assessments.

Importantly, because these data sets are external and were not collected, verified, or validated by this
project’s personnel, they will not serve as an independent benchmark for data validation or
invalidation. They will only be used as secondary references to gauge overall reasonableness of data
once all QC steps have been completed. Additional information regarding data verification and
validation methods is provided in Section D.2 and the SOP for Data Verification and Validation
(Attachment 8).

Raw data collected at each monitoring site are stored on the analyzer computer and only reviewed if
data validation efforts identify potential issues that require additional investigation. A Data
Acquisition System (DAS), or data logger, performs basic QC, averages to 5-min resolution, and
aggregates data into a desired file format. Data are then transmitted from each sampling site to a
cloud-based file storage service via cellular modems, where they are stored and available for retrieval
as needed. Data from the cloud are ingested into Sonoma Technology's Insight® DMS where a
robust AutoQC logic assigns data flags in real time based on instrument diagnostics and local
meteorological measurements. From this point forward, data are persisted within the DMS and any
changes to data are recorded via chain-of-custody logs.

These preliminary data are displayed on the public website within 10-15 minutes of collection. Data
are reviewed daily by air quality Data Analysts to assess system operations, confirm the automated
data flagging is correct, and ensure any corrections to data flagging are propagated to the public
website immediately. Extended analyses are performed every calendar quarter and reviewed by the
project QA Manager. Figure 3 illustrates the general data flow and QC schematic. Additional details
regarding data verification and validation are provided in Section D.2 and the SOP for Data
Verification and Validation (Attachment 8).



Phillips 66 Carson Refinery 1180 Fenceline Monitoring
QAPP Revision 3

August 5, 2024

Page 32 of 45

Automated QC

Data Management
System
Y Public Website

Automated QC

Data
. Cloud-Based
- Acquisition > .
File Transfer
System

External Data
Back Up

Manual QC
Daily Data Quarterly
Checks Review

Figure 3. Data flow and QC schematic.

As described in Section B.6, data archival and management on the analyzer computers is part of
routine operations and maintenance. Data are copied to external hard drives either manually or via
an automated copy script and deleted from analyzer computers after confirmation that copy efforts
were successful. Old files are deleted from the analyzer computer to allow continued data collection.

All ingested data are retained in the DMS. During quarterly analysis, data are downloaded from the
database, analyzed, validated, and then backfilled into the DMS as final data sets. Redundancy of
DMS data is maintained on a cloud-based system and data will be stored for 5 years after sampling.

Absorbance spectra for open-path measurements are validated with analytic software packages
provided by manufacturers. Reference libraries and runtime settings are copied from analyzers in the
field onto the auxiliary system where analysis is performed. Doing so ensures accuracy of spectral
information and allows qualified analysts to view individual absorbance spectra and associated fits.
The ability to retain spectral files and independently validate spectral matches and reported
concentrations is a key part of the data validation process for open-path analyzers.
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C. Assessment and Oversight

On an annual basis, the refinery will work with the fenceline monitoring contractor to assess network
performance through:

1. Review of data completeness by monitoring path, instrument, and compound
2. Comparison of bump test results via control charting

3. Analysis of reported concentrations in the context of refinery operations

4.

Analysis of reported concentrations with respect to meteorological conditions

Using analyses similar to those used to support the network design, the contractor will further
evaluate the overall performance of the network to ensure it is meeting project objectives. The
contractor will also prepare an internal technical memorandum summarizing findings for the refinery.
Following the monitoring network assessment, any necessary changes will be reflected as an update
to this QAPP, which will be submitted to South Coast AQMD for approval.

Posting data to a public website constitutes the most immediate and frequent reporting effort.
Preliminary data collected by the fenceline monitoring network are displayed on a public website
(usually within 10-15 minutes of acquisition) with time series plots and map marker visualizations of
5-min and rolling hourly concentration values. Data are quality controlled in real time with AutoQC
logic, and the resulting data flags (QC and operational [OP] codes) assigned to each data point
determine how they appear on the website. Additional information regarding data display on the
public website is provided in Section D.2.

The website is operated and maintained by the refinery’s fenceline monitoring contractor, and the
general public is the intended user of the preliminary data. Accordingly, the public website contains
supplemental information written at a public-friendly level about the monitoring network, target
compounds, how to interpret data visualizations, and frequently asked questions.
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The most recent 5 calendar years of electronic historical data collected by the fenceline monitoring
system will be made available within 60 calendar days after the conclusion of each quarter for public
download in an easily downloadable, accessible, and interpretable electronic format that is approved
by the South Coast AQMD Executive Officer.

Upon request, the most recent 5 calendar years of electronic historical data collected by the fenceline
monitoring system will be available to be transmitted electronically to the South Coast AQMD
Executive Officer within 60 calendar days after the conclusion of each quarter in a format that is
approved by the Executive Officer.
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D. Data Validation and Usability

Data verification is a process of comparing how the data were gathered to the procedures
established by the project QAPP and SOPs. It is a data review technique that evaluates the
conformance of data collection practices to established methods, procedures, or specifications. Data
verification usually consists of checking that SOPs were followed and QC activities were performed.”

Data validation is a process of confirming that reported values meet the quality objectives of the
project. It is a data review technique that examines whether the particular requirements for a specific,
intended use are fulfilled. Data validation examines whether acceptance criteria outlined in the QAPP
were achieved.’

To produce defensible, high quality environmental information for its intended use, data shall:

e Meet regulatory requirements
- Monitor in accordance with the FAMP
- Achieve the acceptance criteria outlined in the QAPP
- Follow the procedures outlined in the relevant SOPs

e Maintain scientific robustness
- Use validated methods and accepted practices for scientific quality
- Include standard materials traceable to an authoritative source (NIST or equivalent)
- Systematically review data usability against program objectives

e Ensure defensibility
- Document all data collection steps and retain associated raw data
- Maintain data integrity and reliability through chain-of-custody logging
- Ensure ethical practices in achieving all project objectives

Additional details are provided in the SOP for Data Verification and Validation (Attachment 8).

Data collected at each monitoring site receives five rounds of QC between the point of collection and
final data set submission to South Coast AQMD. A detailed process flow diagram of the data pipeline
is provided in Section B.10.

" EPA Quality Assurance Handbook Vol II.



Phillips 66 Carson Refinery 1180 Fenceline Monitoring
QAPP Revision 3

August 5, 2024

Page 36 of 45

Data proceed through a tiered order at each point of the data flow and QC schematic as follows.

Level 0. Raw data collected on analyzer computers are referred to as Level 0 data. They do not
receive any QC but are retained for future review as needed.

Level 0.5. These data have been logged by the DAS and received only the most basic AutoQC. This
stage of QC includes checking basic instrument diagnostic thresholds and whether a sufficient
number of raw analyzer data points were collected to generate a 5-min average. Maintenance and
calibration periods are commonly flagged at this stage, which do not receive additional QC because
they are not representative of ambient monitoring data.

Level 1. Upon ingest to the DMS, a robust AutoQC logic further assesses data quality and assigns a
QC and OP code to each individual data point in real time. The QC codes categorize data as valid,
suspect/questionable, or invalid, and the OP codes provide additional context relevant to the
assigned QC data flag. Unique AutoQC logic trees are developed for each piece of instrumentation
and equipment by air quality scientists with input from instrument manufacturers where needed.
Level 1 preliminary data are displayed on the public website within 10-15 minutes of collection.

Level 2. Daily review by Data Analysts allows system operations assessment and ensures that
automated data flagging is correct. Data Analysts may adjust the QC and OP codes to reflect recent
operational issues and have the ability to adjust data values if an independent validation of the raw
data requires this action. Any and all changes to QC and OP codes or data values are recorded by the
DMS via the chain-of-custody logs and are made according to processes outlined in the SOPs and
this document.

Level 3. Extended analyses are performed by Data Analysts every calendar quarter to validate data
over longer time periods and with respect to other benchmarks, such as known background
concentrations. As with Level 2 data, any and all changes to QC codes, OP codes, or data values are
recorded by the DMS via the chain-of-custody logs and are made according to processes outlined in
the SOPs and this document.

Level 4. The final stage of QC is an independent review of data by the QA Analyst to confirm that
analysis activities have been conducted according to the QAPP. Final data sets are prepared for
submission to the regulatory agency and in support of quarterly reporting activities.

Data flags within the Sonoma Technology DMS are composed of QC and OP codes. QC codes are
defined as follows:
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¢ Invalid (QC=9). Data that do not meet defined thresholds for acceptance are flagged with
this QC code in the DMS. Causes of invalid data include low visibility conditions, maintenance
and calibration, open-path analyzer misalignment, and instrument malfunction. Data are only
invalidated if acceptance criteria are not met or if a clear cause is identified that warrants
invalidation. If data are anomalous but no clear cause is identified, data are flagged as
suspect/questionable.

e Missing (QC=8). If insufficient data to generate a 5-min average are received by the DAS,
data is considered missing and flagged with this QC code in final data deliveries.

¢ Insufficient Data (QC=7). If insufficient data to generate an hourly average are received by
the DMS, rolling hourly data is flagged with this QC code.

e Suspect/Questionable (QC=5). Data which meet the defined thresholds for acceptance but
indicate marginal operating conditions based on secondary review criteria are flagged with
this QC code. For example, elevated integration time reported by the UV-DOAS analyzer that
coincides with elevated signal strength may indicate that the data require additional review
but are likely accurate. Other causes of suspect/questionable data include concentrations out
of expected range, concentrations exceeding a defined rate-of-change, or stuck data values.

e Valid (QC=0). Data that meet all defined thresholds for acceptance are considered valid and
flagged with this QC code.

Because data validity is assessed based on instrument diagnostics like signal strength and integration
time, valid data (QC=0) do not necessarily indicate that the raw concentrations reported by the
open-path analyzers are accurate. Depending on the instrument, additional parameters are reviewed
by the AutoQC logic to further evaluate concentration data, such as the correlation between
measured and reference library spectra (spectral match) and evaluation of the reported
concentration to the defined instrument MDL. Additional information regarding how data is
displayed on the website is included below (see Public Website Display).

QC and OP codes together provide information regarding data quality and additional relevant
context, as shown in Table 12.
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Table 12. QC and OP codes assigned in the Sonoma Technology Insight DMS.

QC and OP Codes

17
28
29
70
72
73
74
76
100
101
102
103

QC Codes
Valid
Suspect/Questionable
Insufficient Data
Missing
Invalid

OP Codes
Valid
Suspect
Insufficient Data
Invalid

Below MDL

Planned Instrument Maintenance

Unplanned Instrument Maintenance

Instrument Malfunction

Marginal Operating Conditions (Good Spectral Match)

Low-Visibility Conditions

Poor Spectral Match

Marginal Operating Conditions (Poor Spectral Match)

Manual Data Review
Range Check
Rate-of-Change Check
Sticking Check

Automated Data Screening

For open-path analyzers, the DAS determines if each raw data point should be included in the 5-min
average based on whether real-time instrument diagnostics are above the defined thresholds shown
in Table 2 (Section A.5), which include signal return and spectral fit metrics. For analyzers with raw
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data resolutions on the order of 2 — 4 minutes (e.g., FTIR), the DAS requires one measurement with
diagnostic parameters above the defined thresholds for the 5-min average data point to be
generated. For open-path analyzers with raw data resolutions on the order of 30 seconds (e.g., UV-
DOAS), the DAS requires six measurements with diagnostic parameters above the defined thresholds
for the 5-min average data point to be generated. The number of data points used to calculate the
5-min average data point are reported in the final quarterly data sets. Following the data screening
by the DAS, data are considered Level 0.5.

In addition to the AutoQC logic conducted upon ingest to the DMS, Table 13 summarizes data
screening checks, which help focus data review efforts on potentially anomalous data. These checks
are based on expected instrument performance and expected concentrations of target compounds
relative to ambient background. The DMS auto-screening checks include:

e Range: This check flags data outside of an expected or reasonable range when 5-min
concentration values are greater than the defined threshold.

e Rate-of-Change: Rapid changes between individual 5-min values without a clear cause are
flagged for additional review as they may be anomalous.

e Sticking: Stuck values are flagged for additional review as they generally do not represent
ambient data. Sticking checks are not applied to data that are below the instrument
detection limit (i.e., concentration values of 0).

QC flags assigned through AutoQC logic and screening checks are reviewed during daily data checks
and quarterly analysis. Following all automated screening checks, data are considered Level 1.

Table 13. Automated screening checks for 5-min data within the DMS (units are in ppb).

Benzene
Toluene 3,900 1,300
Ethylbenzene 3,900 1,300
Total Xylene 15,000 5,000
50 22> > Four or more stuck
Naphthalene 225 75 values
Total VOCs 2,190 730
Formaldehyde 132 44
Acetaldehyde 780 260

Acrolein 90 30
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891 297

1,3-Butadiene

Styrene 15,000 5,000
Carbonyl Sulfide 810 270
Ammonia 13,521 4,507
Hydrogen Cyanide 927 309
NO; 300 100
H2S 90 30
BC 30 10
PM 150 50

Daily Data Checks

In addition to AutoQC checks, Data Analysts review data from the fenceline monitoring network on
an at least a daily basis to identify operational issues and maximize system uptime, typically with a
one- to two-day running time series plot of select parameters on an internal field operations website.
The Data Analyst assesses the current operational status of the monitoring network and whether
concentration patterns are reasonable with respect to the time of day, season, current
meteorological conditions, facility operations, and concentration levels measured at other sites. Data
are also reviewed on the public website to confirm that data flow and visualizations are current, and
to additionally identify any anomalous behavior. Findings are documented after each check and
made available to the Project Management, Field Staff, Data Analysts performing quarterly analysis,
and the QA Manager.

Examples of observations requiring additional review include low signal strength or high integration
time; spikes or dips in diagnostic parameters or reported concentrations; stuck or missing data;
negative concentrations; and concentrations that are outside of an expected range based on nearby
measurements or known atmospheric chemistry. Data are only invalidated if they do not meet
defined acceptance criteria (Section A.7), or a clear and verifiable cause has been identified and
documented. Examples of reasons for invalidation include instrument malfunction, power failure, and
bump test data that were incorrectly flagged.

Data flagged as suspect or invalid by automated screening may also be validated during daily data
checks if appropriate, meaning that temporary data flags are typically resolved within one to two
business days. Following the daily data check, data are considered Level 2.
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If anomalies are observed during daily data checks, the Data Analyst investigates whether an
instrument malfunction occurred or if the anomalous data are explainable and therefore correct. Any
need for corrective action is communicated to the Project Manager and Field Staff for further
coordination. Technical staff may remotely access analyzers in the field to perform basic
troubleshooting, and site visits are conducted as required.

When elevated concentrations (i.e., concentrations greater than routine background observations)
are reported by open-path analyzers, a visual review of individual absorption spectra is performed
using data processing software provided by the instrument manufacturer. Additional information
regarding spectral validation of open-path data is provided in the SOPs attached to this document. If
this additional review proves data to be invalid, they are flagged accordingly and may be removed
from the public display. The rationale for data invalidation is maintained in the chain-of-custody logs,
and corrective action is overseen by the Field Staff Manager, usually within one to two business days.
If extended instrument downtime is necessary to address a data quality issue, South Coast AQMD
personnel will be notified in accordance with Rule 1180 and backup monitoring will proceed
according to the FAMP.

Similar review processes are completed outside of business hours by after-hours support staff in the
event of missing data alerts or an exceedance of defined concentration thresholds. This helps to
maximize system uptime and ensure the accuracy of data reported to the public website in real time.

Data undergo an extended analysis every 90 days through quarterly reporting, after which they are
considered Level 3. Where possible, quarterly analysis is conducted by the same analysts that have
been completing daily data checks to ensure consistency and familiarity with the monitoring
network. Any and all changes to QC and OP codes or data values are recorded by the DMS via the
chain-of-custody logs and are made according to processes outlined in the SOPs and this document.

Analysts verify that SOPs were followed and QC activities were performed according to the QAPP.
Examples of quarterly data verification may include:

e Review of daily data check documentation and routine instrument maintenance records to
ensure consistency

¢ Confirmation that routine maintenance, calibrations, bump tests, and span tests were
conducted according to schedule

e Review of instrument logbooks to assess whether data flagged as invalid or
suspect/questionable are explainable based on recorded observations
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Review of site operator logbooks to assess whether observations by Field Technicians require
additional examination of data

Review of changes to data QC and OP codes or data values, and confirmation that they were
appropriately recorded

Analysts validate data by exporting quarterly data sets from the DMS and analyzing them with a
robust QC analysis code. Analysis code is maintained through an internal code repository, reviewed
regularly, updated as requirements evolve, and shared with all analysts. The primary goal of quarterly
data validation is to ensure reported values meet the DQOs of the project and acceptance criteria
outlined in the QAPP were achieved. Quarterly data validation typically includes:

Generation of monthly and quarterly summaries of data statistics (including concentration
minimums, maximums, averages, and standard deviations)

Identification and review of statistical anomalies and outliers; negative outliers are defined as
concentration values below -3 * MDL, and positive outliers are usually identified with
automated screening (range) checks

Inspection of measurements before and after anomalous data, missing data, instrument
bump tests, and maintenance activities

Review of data flagged as suspect/questionable, and flag adjustment to valid or invalid
status, as appropriate

Confirmation that bump and span test results are within acceptance criteria detailed in the
QAPP

Comparison of data to remote background concentrations and average urban
concentrations, including assessment of data consistency over longer time periods, to
determine data reasonableness; other data sources for comparison are detailed in Section B.9

Verification that data are realistically achievable and not beyond the limits of what can be
measured by the instrument

Review of data completeness as detailed in Section A.7

An independent review of post-QC quarterly data sets ensures that data are reasonable and analysis
activities were conducted according to this QAPP. This independent review is conducted on a
representative sub-set of data using similar methods to those described for quarterly analysis by the
QA Manager or another data analyst. Daily data check documentation and routine instrument
maintenance records are also reviewed to ensure that the appropriate QC checks were applied. After
this review, data are considered Level 4 (final).
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Final data sets are prepared as a part of quarterly data review and reporting and will be made
available for electronic transmission to the South Coast AQMD Executive Officer and also made
available for public download as required by Rule 1180. Additional details are provided in Section
C.2.

Invalid Data (QC=9) are not representative of ambient conditions and are therefore omitted from
the public website display. On the time series plot and associated “tooltip” detail pane, no
concentration value is shown and data are labeled “Invalid.” The map marker behavior is similar, but
provides an extended message with additional information, such as the identification of maintenance
periods, instrument malfunctions, or low-visibility conditions. Concentration values and diagnostic
information for invalid data are retained within the DMS and included in final data sets.

Missing Data (QC=8) are not displayed on the website. Tooltip detail panes on the time series and
map markers indicate where data are missing for each 5-min record. Null record indicators are
created for these periods as a part of quarterly analysis and are included in final data sets.

Insufficient Data (QC=7) only applies to the rolling hourly average concentrations, and the public
website display behavior is the same as described for missing data.

Suspect/Questionable Data (QC=5) and Valid Data (QC=0) are displayed on the time series and
map marker visualizations. Because suspect/questionable data do not coincide with failed
acceptance criteria and merely indicate marginal operating conditions or the need for further manual
review, concentration values are included in completeness calculations and statistical analyses. As
such, they are also displayed on the public website.

Open-path data with a poor spectral match are considered non-detections because the
concentration of the target compound is so low that the analyzer does not determine it was present.
In this scenario, the numerical output of the analyzer usually represents instrument noise but can
occasionally range in magnitude depending on the result of the analytical fitting routine to the
reference spectra. To reflect the status as a non-detection, data with poor spectral matches are
adjusted to “0 ppb” and subsequently shown on the public website. Tooltip detail panes on the time
series and map markers show “<MDL" or "BD" (below detection) for non-detections. Unadjusted
concentration values for these non-detections are retained by the DMS.

Open-path data with a spectral match greater than the acceptance criteria (Table 2 in Section A.5) are
considered detections, and the concentrations are displayed on the public website time series plots
as recorded. If the recorded concentration is less than the defined instrument MDL, the tooltip detail
panes on the time series and map markers show “<MDL" or "BD." If the recorded concentrations are
greater than the defined instrument MDL, the tooltip detail panes on the time series and map
markers show the recorded concentration.
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A summary of public website display behavior according to QC and OP codes is shown in
Table 14. Additional details regarding QC and OP codes are provided in Table 12.

Table 14. Summary of public website display behavior according to QC and OP codes.

QC Code | OP Code | Concentration | flag |
9 70

None Invalid
9 73 None Invalid
9 28 None Invalid
9 29 None Invalid
5 76 0 Below Detection (BD or <MDL)
5 17 As Recorded Below Detection (BD or <MDL)
5 72 As Recorded Suspect (Questionable)
0 74 0 Below Detection (BD or <MDL)
0 17 As Recorded Below Detection (BD or <MDL)
0 0 As Recorded Valid Data

D.3 Reconciliation with User Requirements

As discussed in Section C.2, the public website constitutes the primary, real-time reporting effort of
preliminary data to the public. Changes to data concentrations or data flags affect how data are
displayed on the website, and are immediately propagated to the public website. In this manner, the
refinery routinely provides the public with information regarding concentrations of target
compounds at the fenceline of refining facilities, consistent with Rule 1180 requirements.

Key components of the public website intended to meet and exceed user requirements of South
Coast AQMD Rule 1180 include visual display of data in real time, context for the public to better
understand the concentrations displayed, and a mechanism for feedback. The website also includes a
functionality to notify the public with custom messaging about instrument maintenance activities,
potential issues with the monitoring network, or any other relevant information affecting the use of
data. Members of the public can also opt in or out of public email and/or SMS notifications through
the public website.
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E. Standard Operating Procedures

Instrument-specific SOPs for the systems listed below are provided as attachments to this document.

e Attachment 1: Standard Operating Procedure for the UV-DOAS

e Attachment 2: Standard Operating Procedure for the Kassay RAM 2000 Open-Path FTIR

e Attachment 3: Standard Operating Procedure for the Teledyne T101 HzS Point Monitor

e Attachment 4: Standard Operating Procedure for the Magee Scientific Aethalometer Model
AE33

e Attachment 5: Standard Operating Procedure for the Teledyne Model 640x Real-Time
Continuous PM Monitor

e Attachment 6: Standard Operating Procedure for Meteorological Instruments

e Attachment 7: Standard Operating Procedure for Belfort Model 6400 Visibility Sensor

e Attachment 8: Standard Operating Procedure for Data Verification and Validation
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1. Scope and Application

This SOP covers the use of the open-path (OP) ultraviolet differential absorption spectrometer (UV-
DOAS) analyzer at the Phillips 66 Los Angeles Refinery — Carson and Wilmington operations (P66
Carson Refinery and P66 Wilmington Refinery) fenceline monitoring systems. This document
addresses routine maintenance activities including visual inspections, instrument checks, data
management, and quality assurance (QA) audit testing. The maintenance forms are provided in
Section 7.

2. Introduction and Overview

The OP UV-DOAS analyzers at the P66 Carson and Wilmington Refineries (P66 OP UV-DOAS) consist
of Argos Scientific hardware with Cerex Monitoring Solutions (CMS) analytic software. The P66 OP-
UV-DOAS analyzer is capable of detecting benzene, toluene, ethylbenzene, xylenes (BTEX), sulfur
dioxide (SOz2), nitrogen dioxide (NO2), and a number of other gases in the ultraviolet (UV) region of
the electromagnetic spectrum. The P66 OP UV-DOAS analyzer is installed in a bistatic configuration,
with an emitter at one end of the monitoring path and a receiver at the opposite end.

The emitter is equipped with a xenon UV source and collimation optics that projects the light beam
to the receiver, and is mounted on a Quickset motorized positioner device that can be controlled
remotely to align the emitter to the receiver. The receiver is equipped with steering optics, a
spectrometer, and a manual pan and tilt mechanism for aligning the receiver to the emitter. The
working range of the spectrometer includes wavelengths between approximately 200 and 315 nm.

This document addresses the routine operations and maintenance procedures for the P66 OP UV-
DOAS analyzer, and is intended to guide field technicians in ensuring and verifying that equipment is
performing to expectations. Proper field maintenance ensures the instrument is operated within
specification. The QA Test process challenges the instrument using a target gas contained within a
sealed cell attached to a linear actuator within the receiver. During the QA Test the linear actuator is
used to insert the cell into the beam path. The resulting concentration measurements are evaluated
for analyzer performance. Precision is calculated according to the QAPP.

3. Safe Work, Hazard Identification, and Precautions
The following information is intended to provide guidance in ensuring a safe work environment.
Operator Qualifications

The P66 OP UV-DOAS analyzers should only be installed, operated, and serviced by personnel who
have been trained in the operation of the system components and are familiar with the potential
hazards associated with the deployment site, installation infrastructure, instrument access methods,
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and the handling of gas delivery and testing equipment. Work should conform to the manufacturer

guidance and site health and safety practices.

The P66 OP UV-DOAS analyzer is not rated for safe operation in hazardous or explosive
environments (not intrinsically safe). Any use in an area that may contain flammable mixtures or
highly corrosive vapors requires special preparation to ensure operator safety and safe operation of

the equipment.

WARNING - Eye hazard. Risk of eye injury. P66 Opp UV-DOAS analyzers

UV light contain an UV light source that may cause eye injury after prolonged
% hazard exposure. Always wear UVA/B/C eye protection when working on or near
oy o the operating equipment.

Procedure Warnings

The procedure contained within this document requires the handling of toxic substances, including
but not limited to benzene, aromatic hydrocarbons, and sulfur dioxide gas, and it requires the
operation of equipment designed for toxic gas containment and dispensation. Improper handling of
materials or hardware may result in serious injury, destruction of property, or damage to the P66 OP
UV-DOAS analyzer. Only qualified individuals should attempt or perform analyzer operation or
testing activities.

Safe Operating Precautions
Ensure that a clear escape path is identified.

Standard site personal protective equipment (PPE) is appropriate. If gloves are required for work on
optics, powder-free nitrile or latex should be used.

NOTICE

Please check off the following steps before conducting maintenance. Doing so reduces the

chances of false notifications to the public and clients.

O Notify the client and project manager of maintenance tasks.

O Using the Field Tech Tool (FTT) at , place the equipment into
planned or unplanned maintenance mode.

O Confirm that the data are invalidated on the public website before proceeding with
maintenance.
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When maintenance is complete, check the public site for at least 15 min to ensure proper

reporting (no missing data, no high values, etc.).
Take equipment out of maintenance mode.
Notify the project manager and client when maintenance is complete.

4. Routine Operations

To set the P66 OP UV-DOAS analyzer to acquire data for normal operations, the instrument CMS
must be operating and the instrument must be aligned.

Alignment Procedure

The P66 OP UV-DOAS analyzer system requires alignment of both the emitter and receiver

components. In most instances, proper alignment can be achieved by only adjusting the position of

the emitter. The receiver component generally only requires alignment after having been physically
bumped or exposed to a seismic event. Always verify proper alignment of the emitter through direct
observation before adjusting the receiver component.

1.
2.

5.

Log Activity in the site logbook and/or an electronic notebook.

Log into FTT, place the analyzer in planned maintenance mode, and disable missing data
alerts.

Start the PTCR-96 software on the analyzer computer. This software allows remote
adjustment of the emitter.

Connect PTCR-96 to the Auto-positioner by pressing Start within PTCR-96. The software will
attempt to communicate with the auto-positioner. Multiple attempts may be required to
successfully connect to the auto-positioner.

a. Upon successful connection, all tabs in the PTCR-96 graphical user interface (GUI) will
become available.

b. Note the current coordinates by saving them as a preset or writing them down.
c. If PTCR-96 fails to connect to the auto-positioner:

i. Open CPR Manager software (Desktop Icon) to confirm there is a network
connection to the MOOG positioner. Exit PTCR-96 and try again. Repeat as
necessary.

ii. Rebooting the computer may be required to regain network connection to
the MOOG positioner.

Open the CMS Align Window. In CMS, press Stop > UV Tab > Align. Observe the intensity
reported in the lower left corner (see the red box in Figure 1) of the Align window while
adjusting alignment.
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In PTCR-96 (Figure 2) press the Presets Tab. Select the first preset 0 and click Save Current
Position As Preset. Select preset 1 and click Save Current Position As Preset. With preset 1
selected, modify the Pan or Tilt coordinates to adjust the position, clicking Save Coordinates
As Preset after each adjustment and double clicking preset 1 to move the MOOG positioner
to those coordinates. Leave the positioner at the coordinates resulting in the highest
maximum signal as observed in the Align window and click Save Current Position As Preset

to save those coordinates to preset 0.
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Figure 2. PTCR-96 software.
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a. If the system saturates (identified when the top of the intensity curve is not visible
due to being maxed out), reduce the integration time value in the Align window to a
value resulting in a maximum intensity of approximately 50% (do not set integration
time to less than 8 msec). Repeat testing coordinates to maximize intensity. For some
paths, it may be necessary to repeat this process several times if xenon UV sources

are new.

b. If the auto-positioner stops responding to coordinates, change the following
commands:

i. Press the Fault Reset button and try again. You may observe that a timeout
indicator is lit.

ii. Pressthe SL Override button and try again.
iii. Restart PTCR-96 and try again.

If it is not possible to achieve signal intensity greater than 20% at 1,000 msec integration
time, notify the project manager.

Dismiss the Align window and press Yes if prompted to save any changes on exit.

When normal data flow has resumed, place the analyzer in normal operation mode and
enable missing data alerts in FTT.

Note: If you need to change any setting back to the original configuration, click File > Save >
Save As Default. If you change settings, record why they were changed and what they were
changed to in the instrument logbook. If settings are changed, they are automatically saved
under the directory: C:\Users\CMS-USER\Documents\Cerex\CMS.

Example CMS settings are shown below.

RunTime
o General
» Operator Name: Default (these will change based on the path and site you
are working on)
= Sitename: Cerex (these will change based on the path and site you are
working on)
= Auto Run: m
»= Auto Run Delay (s): 15
o File
» File Type: .CSV
= Primary Data Logging File: m
e (C\Users\CMS-USER\Documents\Cerex\Data
= Secondary Data File Logging: m
= Single Data Folder: m
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* Primary Summary File Logging: m

o C\Users\CMS-USER\Documents\Cerex\Data
= Secondary Summary File Logging: m
= Single Summary File:

o Library
= Library File: C:\Users\CMS-USER\Documents\Cerex\Library\
o Ul
= Sort Column: Compound Name
= Data Summary Chart: m
= Concentration Chart: m
= Password Protection Settings: m
= Pump Control: m
= Status Control: ﬁ
= Testing Control: ﬁ
e Analysis
o General

= Moving Average Interval: 12
= Display Units: PPM
o Concentration
= Zero Readings on Non-Detect: m
= Zero Readings on Negative Concentrations: m
= Display BDL: m
= Quick Analysis MDL Wave length Range: 276-280 (range does not matter)
= Temperature/Pressure Concentration: m
o Filters
= Absorbance Savitzky-Golay: m
e Derivative Order: 0
e Polynomial Order: 1
¢ Wavenumber Range: 200-307
e Window Size: 3
= Baseline Correction Savitzky-Golay: m

e Instruments
o UV
= Operation

o UV: m

e Acquisition Time (s): 60 (this is the “averaging time" of the instrument)

e Integration Time (msec): Self adjusting if auto integration is turned
on. This is the amount of time that the instrument will collect light.

e Path Length (m): 1 (2 for monostatic, 1 for bistatic)

e Trigger Mode: Normal
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= Auto Routine
e Auto Integration: m (the software will determine integration time)
e |Intervals (s): 60
e Wavenumber Range: 295-300 (this is the range where the intensity
will be measured for autointegration determination. This is different
on all instruments due to spectral background and intensity range)
¢ Intensity Range: 80-92 (this is the target intensity range for the
autointegration routine)
e Maximum Integration: 1,000
e Auto Background: m
e Interval (Acquisitions): 5
e Wavenumber Range: 295-300
» Verification
e \Verification: m (this inactivates all inputs)

Controller
o General
= Serial Port: n/a
= Sensor Refresh Interval (s): 15
o Sensors
= Do not Touch Anything
o Alarms
* Do not Touch Anything
Email
o General
= Data Recipient: Blank
» Email Sender: Blank
= Email Periods (s): 60 (time does not matter as we do not use this setting)
» Send Data: m
o SMTP
= Server: smtp.gmail.com
= Port: 587

» Username: Blank
» Password: Blank
=  Timeout (s): 100
= SSL Authentication: m

Auxiliary Coms
o Modbus

= Modbus: m

= System Type: Ethernet
= TCP Port: 502
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= UnitID: 2
* 16-bit unsigned int to: m

10. After settings are verified and the instrument is aligned, you can place the instrument in run
mode.

5. Equipment and Supplies

1. Field notebook

2. Tool kit, especially including: 7/64 hex driver, complete set of combination wrenches,
adjustable wrenches, screwdrivers, etc.

3. Cleaning supplies designated to be safe for use on P66 OP UV-DOAS analyzers — especially
lens paper

4. All relevant PPE, hardware, and procedural guidance per the SOP, Safety Plan, and Safe Work
Permit

Local or remote network link device (as required)

External laptop computer with network interface device to the analyzer (as required)
P66 OP UV-DOAS analyzer

Isopropyl alcohol (>80%)

© © N o U

Distilled water
10. Pressurized sprayers
11. UV-source bulb

12. Powder-free nitrile or latex gloves

6. Maintenance Activities

The following section outline the routine performance indicator checks and maintenance activities to
be carried out for each analyzer. Maintenance forms used to indicate when the checks are completed
and document any corrective actions taken are in Section 7. These activities are also expected, based
upon the project plan, to be logged in a site logbook in hard copy or electronic form, and can
reference this SOP and associated forms.
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The following maintenance activities and performance checks are recommended by the
manufacturer:

e Visually inspect the system.
e Inspect optics on detector and retroreflector and clean if necessary.

e Confirm the alignment to verify there has not been significant physical movement. Note: this
is automatically monitored as well.

¢ Download data from the detector hard drive and delete old files to free up space, if needed.
Ensure data are backed up on two external drives before deleting.

e Ensure there are no obstructions between the detector and the retroreflector (such as
equipment, vegetation, vehicles).

e Change out the xenon UV source.
e Clean optics on detector and retroreflector.
e Realign system after service.

e Perform bump test (simulates system-observed gas content at the required path average
concentration) to verify the system can detect at or below a lower alarm limit.

e Review and test light and signal levels.

e Verify system software settings.

6.1 Visual Inspections

1. Ensure the instrument is running and the data look reasonable.

2. Clean and correct any obvious problems with the system (cobwebs, rodent nests, broken
optics, etc.).

3. Inspect all electrical cables for wear and replace as needed.

4. Indicate that these visual checks are complete on the form included at the end of this
document.

5. Document any changes to the system in the course of these checks in the site logbook.

6. Power up the instrument, make sure CMS software has started, and realign the instrument.

6.2 Light Level Check

For good visibility conditions, signal strength is normally >20% and integration time is normally
between 300 and 1,000 ms. Signal intensity <17% indicates realignment may be necessary. Signal
intensity <10% results in invalid data and warrants immediate corrective action.
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Check and record signal strength at 250 nm. Minimum signal intensity at 250 nm should be greater
than 5%.

6.3 System Settings

Check the system settings against those documented in Section 4. If any settings do not match,
provide any explanation for the changes. If you change any settings, document how the settings
were changed in a site logbook. Note all instrument settings are saved daily by the analyzer.

6.4 Data Management

6.4.1 Archiving and Deleting Older Data

Note: Data older than twelve months should be deleted from the instrument (frequency as described
in the QAPP) to prevent the instrument from filling its internal hard drive.

Raw instrument data are stored on the analyzer computer. Data consist of spectral data containing
two columns: one for wavelength, and the other for intensity. There are also two types of “summary”
files that contain data resulting from the classical least squares analysis of the spectral data as a
function of time. These file formats are described in the CMS Software User Manual.’ Spectral data
and summary files are automatically written to the site computer and moved to the external hard
drive after a regular interval. Deliver the external hard drive to the client with the frequency indicated
in the QAPP.

Details on the proper procedure for deleting data files from the instrument are as follows.

1. Confirm the data files have been successfully written to two external hard drives.

2. Make a note of the amount of available space on the instrument'’s internal drive on the
maintenance form.

3. Locate files older than 12 months on the instrument file directory: C:\Users\CMS-
USER\Documents\Cerex\Data\.

Note: This procedure excludes the bump test folder, which should always remain on the
instrument computer.

4. Log into the auxiliary (brick) PC located in the instrument shelter and locate the data files
written from the instrument onto the external hard drive.

5. Confirm all complete data summary files and simple data summary files for the desired
period have been transferred over completely to the two external hard drives.

6. Once you have confirmed that those files have transferred over to the external hard drives,

T CMS Software User Manual Rev 4. CMS Version 4.0.298.1, CEREX Monitoring Solutions, December 5, 2017.
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delete those exact complete data summary and simple data summary files from the
instrument data folders on the analyzer computer.

For each individual day of single beam folders, ensure the amount of single beam files are
the same on the internal hard drive of the instrument and the two external hard drives.

If all folder locations match and you have ensured proper file download, you may
permanently delete the single beam folders from the instrument computer.

After all data older than 12 months have been deleted, note how much free space is available
on the instrument’s internal drive. If removal of the files does not result in enough disk space
(based on previous data transfers), the disk drive may need to be reindexed (Section 6.4.2).

6.4.2 Rebuilding the Instruments Indexing Preferences

If deleting data from the instrument does not seem to increase free instrument disk space, re-index
the files. To rebuild the index preferences, follow these steps.

1.

Under the Control Panel Menu, use the search function in the lower left-hand corner of the
task bar to search for “Indexing Options.”

Click the Advanced tab with the shield logo.
Click Rebuild.

Note: Once "Rebuild” has been selected, a message saying that it might slow user activity will
appear. This will not affect the instrument'’s ability to perform data collection. On the original
indexing option screen, the magnifying glass in the upper right-hand corner will move and
the number of items indexed will slowly increase. Take note of the available space on the
instrument's internal drive once indexing has been completed.

6.5 Cleaning Optics

Cleaning external windows on the receiver and emitter is an important part of the maintenance plan.
Caution should be taken as there are electrical fan heaters that are used to keep moisture and
particulates from collecting on the retroreflectors.

If light levels are low or visual inspection reveals soiled optics, cleaning can improve light
throughput. In general, if the optic is not dirty, do not clean it, as excessive cleaning of optics can
result in scratches and wear over time. If the optic is obviously soiled and is affecting performance,
take the following steps. Mirrors with metallic coatings should be treated with extra care because
these surfaces are easily damaged on contact.

1.

Wear powder-free gloves to avoid transferring skin oils onto the optics.

2. Power the component off as compressed canned air is flammable. Use compressed

air/canned air to gently blow particles from the optic surface. For reflective optics, Stop here.
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3. External quartz windows may receive further cleaning using solvent and lens paper. Use a
solvent (isopropyl alcohol) and lens tissue to wipe the optic clean, wiping slowly from the
edges first with an alcohol-soaked lens tissue. One technique is to drop solvent on the
unfolded lens tissue and drag from one end to the other.

4. Allow all alcohol to evaporate before powering component on.

6.6 Xenon UV Source Replacement

NOTICE

e Never power on the P66 OP UV-DOAS emitter without a properly installed xenon UV source.

e Powering on the emitter without a xenon UV source may cause an electrical short, which will
permanently damage the instrument.

e Always remove the xenon UV source from the emitter prior to transporting or shipping.

e Failure to remove the xenon UV source from the emitter prior to transporting or shipping
may cause destruction of the source.

e Always check the polarity of the xenon UV source for proper installation prior to powering
the emitter on.

¢ Installing the xenon UV source with reverse polarity will permanently damage the xenon UV
source and cause immediate failure.

6.6.1 Xenon UV Source Handling

The xenon UV source is stored in a protective plastic enclosure (Figure 3). The (+) Anode end of the
UV source is labeled “+." The UV source must be installed with the (+) side up.

Always wear clean powder-free nitrile gloves when handling the UV source. Qils from hands
deposited on the UV source glass bulb will cause damage. If the glass bulb is touched with bare
hands, clean the glass bulb with isopropyl alcohol or acetone prior to installation.
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Figure 3. The Anode end of the UV source is marked (+). The Cathode end of the UV source is
marked (-).

6.6.2 Xenon UV Source Removal

1.

Power off the emitter component of the analyzer and disconnect from power. Allow it to cool
completely.

Wearing clean powder-free nitrile gloves, loosen the retaining hex screws on the bulb collar
clamps at the top and bottom of the UV source.

Note the orientation of the source bulb as it must be reinstalled in the same orientation, with
+ at the top collar clamp.

Remove the xenon UV source from the collar clamps.

6.6.3 Xenon UV Source Installation

1.

Insert the Cathode (-) end of the Xenon UV source into the lower collar clamp and gently
tighten the hex screw to secure the bulb.

Slide the upper collar clamp over the top of the UV source Anode (+). Gently tighten the
collar clamp hex screw to secure.

Confirm signal strength and realign the emitter as necessary before leaving the path.
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6.7 Perform Bump Test

The purpose of QA audits, or bump testing, is to collect concentration measurement data required to
assess analyzer performance. To facilitate a QA audit, the analyzer receiver component is equipped
with an internal assembly consisting of a sealed calibration gas cell of SOz coupled to a linear
actuator. During bump testing, the actuator is used to insert the cell into the analyzer UV beam so
the gas and UV light interact. The concentration of the gas in the sealed cells is not traceable to a
known standard, therefore accuracy cannot be calculated. Accuracy statistics are to be determined.
Concentration measurements obtained are used to calculate measurement precision.

NOTICE

Always verify the analyzer is in maintenance mode in FTT and confirm the data are invalidated on the
public website before proceeding with maintenance. The concentration of gas in the QA cell is high
enough to trigger a public alert in one measurement.

O When maintenance is complete, check the public site for at least 15 min to ensure proper

reporting (no missing data, no high values, etc.) before taking the instrument out of
maintenance mode.

O |If a process upset resulting in a release is suspected during the bump test, or a linear
actuator failure occurs and results in a stuck QA cell in the UV beam path after the bump test,
contact the project manager.

O Due to the UV-DOAS operational method, at least four sequential measurement acquisitions
will be required for concentration stabilization after moving the cell into the beam. This is
independent of acquisition time.

Bump Test Quality Assurance Audit Procedure

1. Document quality assurance activity and associated times, file numbers, general
observations, and variance from expectations in an electronic notebook. If eSIMS is not
readily available, record the activity, visit summary, and your initials in a Notepad .txt file and
save the file in the QA folder for the particular test.

2. Log the date and status of the bump test in the shared Bump Test Checklist.xlsx spreadsheet.
Contact the project manager for access to the checklist.

3. Use FTT to place the analyzer in planned maintenance mode and disable missing data alerts.
a. When saving, enter your initials in the FTT note space and record that the unit is

offline for bump testing.

4. Press STOP (if CMS is running) and configure CMS.
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a. Set Path Length to 100 meters: On the UV Tab press the Align button. In the align
window change the path length to 100 meters. Exit the align window and press Yes
to save changes.

b. Change Data Directory:
o Click Settings on the left panel. If not visible, click Advance first.
e On the window that pops up, expand the Runtime options and click File.

e Modify the primary data file and the secondary summary file paths from
“C:\Users\user1\Documents\Cerex\Data" to
“C:\Users\user1\Documents\Cerex\Data\Bumptest"

e Click File on the top left and select Save. Confirm if prompted.
e C(lick Save or Ok on the bottom right to close the window.
Verify Planned Maintenance Mode is active in the Data Management System (DMS).

a. Verify that at least two consecutive data are invalid on the public website for the
analyzer of interest. Do not proceed until at least two consecutive measurements of
each are reported as Invalid.

Open the Align window (Stop > UV Tab > Align) and check maximum signal intensity. If
maximum signal intensity reported in the CMS align window is <30%, align the analyzer to
maximize intensity.

a. See the alignment procedure for details.
b. If aligning the unit fails to increase signal strength >17.6%, continue the QA audit.

If open, exit PTCR-96. With the ALIGN window open, start the Actuonix LAC software and
reposition the device to 80%. As the cell moves into the beam path, observe the align
window and verify a corresponding decrease in signal intensity is observed.

a. Ifitis, continue. If no decrease in signal intensity is observed, troubleshoot the
actuator serial connection and operability of the actuator before proceeding.

Set the device to 0%, verify signal intensity increase and then dismiss the align window.

Press Run and allow the analyzer to obtain five consecutive acquisitions. When file count
displayed in the status area of the UV Tab reaches at least five, press Stop.

. In Actuonix LAC, set the device to 80%.

. Press Run and allow the analyzer to acquire at least 16 consecutive measurements at a stable
concertation of the QA gas. This will generally require at least 24 consecutive acquisitions.
Press Stop.

. In Actuonix LAC, reposition the Device to 0% and observe the align window to verify the cell
has moved out of the beam path.
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13. Press Run and allow the analyzer to obtain five consecutive acquisitions. Press Stop.
14. Configure CMS for normal operation:
a. Restore original file directories
e Click Settings on the left panel. If not visible click the Advance first.
e On the window that pops up, expand the Runtime options and click File.

e Modify the primary data file and the secondary summary file paths from
"C:\Users\userT\Documents\Cerex\Data\Bumptest” to
"C:\Users\userT\Documents\Cerex\Data.”

e Click File on the top left and select Save. Confirm if prompted.
e C(lick Save or Ok on the bottom right to close the window.

b. In the align window, set the path length to 1 meter, dismiss the align window and
press Yes to save the new settings on exit.

15. Press Run to resume normal analyzer operation. Leave the analyzer in Maintenance Mode.

16. Verify in the DMS that the concentrations of QA gas have returned to baseline. You should
see a clear drop of gas concentrations to baseline levels.

a. InFTT, place the analyzer in Normal Operation mode and enable missing data alerts
only after the concentrations of QA gas flowing into the DMS have returned to
baseline.

b. If the concentrations of QA gas fail to return to baseline, then a QA cell is still in the
beam path or a release event is occurring. Leave the analyzer in maintenance mode
and contact the project manager.

17. Transfer a copy of the entire QA folder “Facility Path QA YYYYMMDD" to the maintenance
directory for documentation and record keeping.

18. Open a blank site-specific UV Field QA Audit Workbook.xlsx spreadsheet (Section 7) and
record the bump test results.

a. Copy 16 consecutive span measurements of SOz from the QA Complete Data
Summary.csv file into the appropriate column.

b. Copy the corresponding signal strength or intensity into the appropriate column.

c. The workbook will automatically calculate average, standard deviation, and precision
of the measurements. Precision should be +25% or less. If not, notify the project
manager.

d. Document the date, initials, testing gas, and any comments regarding the test or
instrument on the bump test maintenance form (or electronic notebook entry).
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7. Maintenance Forms

Path:

Technician:

Date:

Instructions: complete checks described below and enter data or initial next to each one once
completed. Make note of any corrective action.

O Notify the client and project manager of maintenance tasks.

[ Using the FTT at , place the equipment
into planned or unplanned maintenance mode.

O Confirm that the data are invalidated on the public website before
proceeding with maintenance.

O When maintenance is complete, check the public site for at least 15

min to ensure proper reporting (no missing data, no high values, etc.).
[ Take equipment out of maintenance mode.
O Notify the project manager and client when maintenance is complete.

Upon completion, sign and date:
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Table 1. Maintenance activities and performance indicator checks for the UV-DOAS.

Activity / Check Completed (Y/N)

Visually inspect the system.

Inspect optics on detector and retroreflector; clean if
necessary.

Inspect system filters on the optics and retroreflectors.

Confirm the alignment to verify there has not been
significant physical movement. Note: this is
automatically monitored as well.

Download data from detector hard drive and delete
old files to free space, if needed. Ensure data are
backed up on external drives.

Ensure there are no obstructions between the detector
and the retroreflector (such as equipment, vegetation,
vehicles).

Change out the xenon UV source.?

Replace ventilation exit and intake filters.
Clean optics on detector and retroreflector.
Realign system after service.

Perform bump test (simulates system-observed gas
content at the required path average concentration)
to verify the system can detect at or below a lower
alarm limit.

Review and test light and signal levels. Check average
light intensity to establish baseline for bulb change
frequency.

Verify system software settings.

Deliver previous years data to client and remove from
brick and analyzer

@UV bulbs will be changed as needed.
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UV FIELD QA AUDIT WORKBOOK.xIsx
Span Concentration PPM*M

Date
Operator
Test Gas S02

Index s02 Intensity @ SO2

1

2

3

a

5

6

7

8

9

10

11

12

13

14

15

16
Average #DIV/0! d #DIV/0!
STD DEV #DIV/0! d #DIV/0!
Precision (CV) (%) 4 #DIV/0! d #DIV/0!

Comment:

Version: 07312024
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1. Scope and Application

This Standard Operating Procedure (SOP) covers the use of the Kassay Remote Air Monitor-2000
(RAM 2000) Open-Path Fourier Transform Infrared (FTIR) analyzer in a fenceline monitoring
application. This document addresses routine maintenance activities, including visual inspections,
instrument checks, data management, quality assurance (QA) audit testing, and data validation.

2. Introduction and Overview

The RAM 2000 FTIR is an open-path air monitor designed to detect a wide range of compounds in
real time. The system works by first generating infrared (IR) radiation from an extremely hot Globar
source. The light from the source is directed down the open path using a Newtonian long-path
telescope. When the light reaches the opposite end of the path, it is reflected using a retroreflector
array back to the telescope, which then receives the light and sends it to the detector. The infrared
detection system is a spectrometer with a cooled Mercury Cadmium Telluride (MCT) detector. A
block diagram of the RAM 2000 FTIR monitoring system is shown in Figure 1.

Sensor
Retroreflector Telescope
J Sighting Scope
Y Return Signal
' '] Sensor

| TN . - Cable Source
= e ]

) ;

Ethernet/

Work
Station
Infrared
Seams Work Station
Power Cable

Figure 1. Block diagram of the RAM 2000 monitoring system.
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3. Safe Work and Hazard Identification

The following information should be noted when preparing work plans and permits for safe work
practices.

Safe Operating Precautions
1. Ensure that a clear escape path is identified.

2. Standard site PPE is appropriate. If gloves are required, powder free nitrile or latex should be
used.

Operator Qualifications

Kassay RAM 2000 FTIR analyzer Installation, operation, and servicing should only be performed by
personnel trained in the operation of the system components. This includes troubleshooting,
cleaning, replacing parts, IR light source installation, etc. Operators should also be fully trained and
experienced in handling gas delivery and testing equipment, including the use of compressed gas
cylinders, 1- and 2- stage regulators, flow controllers, and tubing connections. Operators should be
experienced with the parameters of flow and pressure and how these relate to compressed gas and
its use with calibrating gas analysis equipment.

Safe Work and Hazardous Environment Operation
Work should conform with manufacturer guidance and site health and safety practices.

The Kassay RAM 2000 FTIR analyzers are not rated for safe operation in hazardous or explosive
environments. Any use in an area that may contain flammable mixtures or highly corrosive vapors
requires special preparation to ensure operator safety and safe operation of the equipment.

CAUTION - Laser Radiation. There is a risk of eye injury with prolonged
direct exposure. Kassay FTIR analyzers contain a Class 3B invisible laser
radiation when the interferometer cover is removed. Do not remove the

interferometer cover. Eye protection is recommended when working
near the IR source.

Procedure Warnings

The QA test procedure requires handling a sealed cell containing sulfur hexafluoride (SF6). Improper
handling of materials or hardware may result in serious injury, destruction of property, or damage to
the Kassay FTIR analyzer. Only qualified individuals should attempt or perform analyzer QA test
activities. Kassay assumes no liability for the use or misuse of this guidance document, or for
operator-performed QA tests, calibration, or gas handling activities. No claims are made by Kassay as
to the compliance of this procedure with any regulations or engineering best practices. The operator
is solely responsible for the safety of personnel and property.
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NOTICE

Please check off the following steps before conducting maintenance.
Doing so reduces the chance of false notifications to the public and
clients.

O Notify the client and project manager of maintenance tasks.

O Using the field tech tool at , place the
equipment into planned or unplanned maintenance mode.

[ Confirm that the data are invalidated on the public website before
proceeding with maintenance.

[ When maintenance is complete, check the public site for at least 15

min to ensure proper reporting (no missing data, no high values, etc.).
O Take instrument out of maintenance mode.

Notify the project manager and client when maintenance is complete.
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4. Routine Operations

To set the FTIR instrument to acquire data for normal operations, the instrument and software
RMMSoft must be operating and the instrument must be aligned (Steps 1 -4 below).

1. Start the RMMSoft software (if not already initiated). You should see a window similar to the
one shown in Figure 2.

B ITT Corp. - RMMSoft = X
New View Run Tools Options Help

Dis|e| S| » o[+ [rle]m] »

Ready Al operations stopped
i = L (=)

£ Type here to search

Figure 2. RMMSoft software opening screen.

2. To perform an alignment, use the peak amplitude search function under Run > Find FTIR
Peak Amplitude Position. This feature provides an automated capability to find the best
coordinate to point the FTIR at a retroreflector.

a. Enter the search parameters and press OK. The program will display the Peak
Amplitude Search View. Press OK to start the process as shown in Figure 3.
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= ES

File Edit View Setup Control Tools Analysis Options Window Help

olsE 3] »[ol+[=[wlal=] W

[= (&)= | B untitled23: Signal Intesferogram
X| 5| I &[] 4|¥] <] M| I

B8 Untitled32 : Status
SIGNAL STATUS

| Alarm: NONE

Interferogram: 0

Frame: 0 of 0

| Time: 07/31/24 10:08:35 -0700

File:

Data: [N
2PD Position: 1
ZPD P.P: NIA
% Full Scale: NIA
Gas Cell: None
NEA noise: NIA
Gain: NIA
Scans CoAdded: 0
Scans 0
FTIR SETUP.
Scans to CoAdd: 0
Coll Interval: 0 Sec
Resolution: 0.5 cm-1

EEE]

FTIR Peak Amplitude Search

I><

- Iniial Center Pastion oK
paimuth: [3895  degiess o
Elevation: [204 degrees e

Round Trip Path: 0 m —

Stop:wa Seachestent:  [002  degiess
SITE

Name: ea|  Searchstepsize: [001  degies
Site:

City:
State:
Sensor Dir: 0 deg
LN2 Controller: Disabled
WEATHER
Temp: NIA
: NIA

Humidity: NIA
Wind Speed: NA
Wind Dir: NIA

No Signal Interferogram Data Available

Ready [Find FTIR peak amplitude position

R Type here to search NASDAQ

Figure 3. FTIR peak amplitude search view.

b. Once the process is complete, the program automatically displays the azimuth and
elevation coordinates of the square that contains the highest returned signal (Figure
4).

B3 (1T Corp. - RMMSoft
File Edit View Setup Control Tools Analysis Options Window Help

DSl S| b @[+ —||ds| K2
= | @ | = | | & untitied33 (Retro) : FTIR Peak Amplitude Search

& Untitled33 (Retro) : Sta...
SIGNAL STATUS

Alarm:NONE | f e e e e

Interferogram: 31

Fameistar FTIR peak amplitude position: Azimuth: -39.950 .
Fie: Elevation: 2.050

Data: [
ZPD Position: 2075
ZPD P-P: 0.977 voits
ZPD % Full Scale: 6.61
Gas Cell: None
NEA noise: NIA
(Gain: Manual, B0X (HW: 696.6)
Scans CoAdded: 1
Scans
FTIR SETUP
Scans to CoAdd: 1
Coll. Interval: 0 Sec
Resolution: 4 cm-1
Round Trip Path: 1 m
Stop: via Stop button
SITE
Name: Op
Site: TestSite
City: Ci

State: NY

Sensor azimuth: -39.930 deg
Sensor elevation: 2.060 deg
LN2 Controller: Disabled
WEATHER

Precip: None

[Temp: 300 deg. K
Pressure: 0 mbar

Humidity: 0 %

Wind Speed: 0 misec

Wind Dir: N (0 deg)

Elevation (degrees)

Ready

L Type here to search

Figure 4. FTIR peak amplitude search view in progress.
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c. Use these azimuth and elevation coordinates in the site setup file (Macro, Step 3).

d. Close the peak amplitude search view window.

Under the Run tab, select Macro. In the pop-up window, select the desired Macro for the
monitoring site. Click Run.

Observe the scan via the RMMSoft graphical user interface (GUI) to ensure the instrument
and software are operating properly ( Figure 5).

B8 ITT Corp. - RMMSoft
File Edit View Setup Control Tools Analysis Options Window Help

DIE(E] S| rlel+l=pl«lm] ¥ coons B

=

SIGNAL STATUS ~
Alarm: NONE
Interferogram: 5
Ammonia
Acrolein
Methanol

27%

Sorted by: Selected Chemicals

Frame: 5 of 5

Time: 07/31/24 10:04:12 0700
File: 0731165i.dat

Change: 08/01/24 00:00:00 -0700

Data: [
ZPD Position: 257
ZPD P-P: 1.02 volts
ZPD % Full Scale: 6.67
Gas Cell: None
NEA noise: 4.34 mAU
Gain: Manual, 128X
Scans CoAdded: 125
Scans Discarded: 0
FTIR SETUP
Scans to CoAdd: 125
Coll. Interval: 500 Sec v

57 36

<t <3 5 156" <3+ <F2———<586"

Formaldehyde

ppm meters

1,3-Butadiene
Carbonyl Sulfide
Hydrogen Cyanide

Nitric Oxide
Nitrogen Dioxide
Acetaldehyde

Alkanes
Styrene

Hydrogen Fluoride

B

[ =] ]
100e-9

o

8 8009

£ 6000

°E 40e9

H

BT T —

1 T Sorted by: Se\(?cled Chemicals
]
% ‘

SIGNAL STATUS A
Alarm: NONE
Interferogram: 5

386———<516———<47——

Alkanes

37 .8 15

Frame: 5 of 4 <84 s ey ”
Time: 07/31/24 09:59:09 -0700

File: 0731.J66i.dat

Change: 08/01/24 00:00:00 -0700
Data: [N

ZPD Position: 257

ZPD P-P: 1.88 volts

ZPD % Full Scale: 12.3

Gas Cell: None

NEA noise: 2.12 mAU

Gain: Manual, 128X (Hw: 1112.3)
Scans CoAdded: 34

Scans Discarded: 0

FTIR SETUP

Scans to CoAdd: 125

16 576

Ammonia
Acrolein
Methanol

Formaldehyde
Styrene
Hydrogen Fluoride

1,3-Butadiene

ppm*meters <]

Nitric Oxide
Nitrogen Dioxide
Acetaldehyde

Carbonyl Sulfide
Hydrogen Cyanide

5 0731)86.11t (Retro J) : Concentration History

1

100e-9
o

© 8089

£ 60e9

.
Coll. Interval: 600 Sec v || § =2

Ready Data collection started
10:05 AM
£ Type here to search

T/31/2024

A DY)

Figure 5. Operating RMMSoft with two FTIR paths.

5. Equipment and Supplies

1.
2.

© N o wu

Field notebook or access to e-logbook management systems, such as eSIMS

Tool kit, especially including: 7/64 hex driver, complete set of combination wrenches,
adjustable wrenches, screwdrivers, etc.

Cleaning supplies designated to be safe for use on a Kassay FTIR

All relevant personal protective equipment (PPE), hardware, and procedural guidance per
SOP, Safety Plan, and Safe Work Permit

Local or remote network link device (as required)

External laptop computer with network interface device to the analyzer (as required)
Kassay FTIR analyzer equipped with RMMSoft software

Isopropyl alcohol (>80%)
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9. Distilled water
10. Pressurized sprayers

11. Powder-free nitrile or latex gloves

6. Maintenance Activities

The following sections outline the routine checks to be carried out for each analyzer and sensor,
followed by maintenance forms (Section 8) used to indicate when checks are completed and
document any corrective actions taken. These activities are also expected, based on the project plan,
to be logged in a site logbook either in hard or electronic form and can reference this SOP and
associated forms.

The following FTIR maintenance activities and performance checks are recommended by the
manufacturer:
e Visually inspect the system.

e Confirm alignment to verify there has been no significant physical movement. Note: this is
automatically monitored as well.

e Ensure there are no obstructions between the detector and the retro-reflector.
e Realign the system after service.

e Check system response (bump test) and take corrective action if % Error exceeds the level
specified in the QAPP.

e Review and verify signal levels.
e Verify system settings.

e Replace the cryocooler assembly if necessary.

6.1 Monthly Visual Inspections
1. Ensure that the instrument is running and the data look reasonable.

2. Clean and correct any obvious problems with the system (cobwebs, rodent nests, broken
optics, etc.).

3. Inspect all electrical cables for wear and replace as needed.
4. Indicate these visual checks are complete on the form included at the end of this document.

5. Document any changes to the system in the course of these checks in the site logbook.
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6.2 Perform a Bump Test

The procedure is intended to verify that the equipment detects a known concentration of calibration
gas contained within a sealed cell located within the instrument. Note that this procedure is written
for FTIR analyzers installed on auto-positioners that rotate between adjacent paths to allow one
analyzer to cover two separate sampling paths.

Prepare for the Bump Test

1. Use the public website to evaluate site conditions and make sure there are no active,
elevated concentrations of compounds detected at the site of interest before proceeding.

2. Login to FTT and place both paths of the FTIR in planned maintenance mode.

3. When prompted to provide a reason for your changes in FTT, enter your initials followed by
"bump testing.”

Bump Test Procedure

1. Record the auto-positioner coordinates displayed for each path in the RMMSoft GUI, as
shown in Figure 6.

B o2anse “arzont): § = I
SIGNAL STATUS ~

Alarm: NONE

Interferogram: 124

Frame: 80 of 79

Time: 04/23/24 13:05:23 -0700

File: 0423A69i.dat

Change: 0:4/24/24 00:00:00 -0700

Data: [
ZPD Position: 257
ZPD P-P: 0.107 volts
ZPD % Full Scale: 0.545
Gas Cell: None
NEA noise: 19.8 mAU
Gain: Manual, 128x
Scans CoAdded: 45
Scans Discarded: 0
FTIR SETUP
Scans to CoAdd: 125
Coll. Interval: 600 Sec
Resolution: 0.5 cm-1
Round Trip Path: 1188 m
Stop: via Stop button

SITE
Name: RC
Site: p66
City: Carson
State: CA
Sensor azimuth: 92.190 deg
Sensor elevation: -0.200 deg
LN2 Controller: Disabled

Figure 6. Location of the coordinates

2. End monitoring and save data for each path:
a) In RMMSoft, click the red Stop button at the top of the window.
b) Click File > Close.

c) If prompted to save, click Yes or OK to save all files.
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Repeat steps b-c again to close all paths.

3. Perform a Find FTIR Peak Amplitude Position operation to maximize the signal strength,
referred to as zero path distance peak-to-peak voltage (ZPD Voltage). Perform if ZPD PP-
Voltage is lower than expected based on routine operations.

a)
b)
@)
d)
e)
f)
4,
a)
b)
5.
a)
b)
Q)
6.
7.
8.

Click Run > Find FTIR Peak Amplitude Position

The FTIR Peak Amplitude Search dialog box will open and default to the last used
auto-positioner coordinates.

Update the coordinates for the path of the QA audit if necessary. Use the coordinates
recorded in Step 1.

Record the new peak amplitude coordinate values for use in a later step.
Press Stop, then click File > Close

Repeat Steps a-e for the other path.

Create or confirm the existence of QA data subfolders for each path.

Create/confirm subfolders in "C\RAM2000-Data\QA_Notes\QAQC YYYY\Path#" for
each path. Be mindful of the year. Create a new folder for the current year if one does
not already exist.

Run the UpdateQAmacro.py script, located in C:\RAM2000-Data\macro, and follow
the prompts.

Run the QA Macro for the desired path:

In RMMSoft click Run > Macro
Select the QA Macro for the path and click Open.

Data from the QA Audit will be written to the file directory specified in step 4:
C\RAM2000-Data\QA_Notes\QAQC YYYY\Path#\dd-mmm.

RMMSoft will automatically reposition the analyzer and begin collecting data.
Allow RMMSoft to acquire two frames then press Stop.

Open the Actuonix Linear Actuator Controller (LAC) Configuration Utility (Figure 7) and set

the position to 100%. If inoperative, manually push the cell fully into the beam path.
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w5 Actuonix LAC Configuration Utility = O X

File  Help
Direct Control  Advanced Configuration

0% Feedback Postion 100%

1. Ensure an actuaior is connected to the appropriate port of the LAC

2. Connect power to the LAC

3. Connect the USB cable to the computer and the LAC

4. Incrementing the Device number will switch control to anather connested LAC

5. Change the Posttion value below to control the actustor, or proceed to another pane

Erter Posifion (%) (0.00 =
Speed (%) 100.00 = Accuracy (%) 99.60 =
Extend Limi (%)  |[100.00 = Retract Limit (%) 0.00 =

Device Mumber |0 |5 Device Stalug |Device Found; AftachedState = TRUE |

Figure 7. Actuonix LAC Configuration Utility

Press Run in RMMSoft and allow the analyzer to run continuously to acquire at least 16
frames with stable concentrations, then press Stop.

In the Actuonix LAC Configuration Utility, set the position to 0%. If inoperative, manually
retract the QA cell and make sure the cell is fully out of the beam path.

In RMMSoft, press Run and allow the analyzer to acquire two more frames. Press Stop, then
File > Close.

If prompted, select OK or Yes to save all files.

Open the new QA folder (C\RAM2000-Data\QA_Notes\QAQC YYYY\Path#\dd-mmm), copy
the Results*.txt file to your local computer, and change the file extension of the copy to .csv.

Open the copy in Excel.

Copy 16 consecutive SF6 measurements into the field QA audit workbook as shown in
Figure 8. The workbook will calculate as shown in steps a — ¢ below.
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FTIR FIELD QA AUDIT WORKBOOK.xIsx
Span Concentration PPM*M

Date X/XX/2024 Version: 04232024
Operator EJH
Test Gas SF6
Index Concentration (PPM*M)
1 29.78
2 29.598
3 29.115
4 29.947
5 29.698
6 29.977
7 29.42
8 29.223
9 28.57
10 29.59
11 29.266
12 29.468
13 29.055
14 30.116
15 29.741
16 30.989
Average 29.597
STD DEV 0.543
Precision (CV) (%) 1.833| within *25% TO PASS
Comment:

Figure 8. Example of field QA audit workbook

a) =AVERAGE(Nonzero measurements, omitting the first and last nonzero values) — This
is the average of the measurements.

b) =STDDEV.S(Same Cell Range as Above) — This is the sample standard deviation of the
measurements.

c¢) =(AVERAGE above/STDDEV.S above)*100 — This is the relative standard deviation
(precision) of the measurements.

d) Precision should be 25% or less. Refer to the acceptance levels specified in the
project QAPP.

e) Document the date, initials, testing gas, and any comments regarding the test or
instrument on the bump test maintenance form (or electronic notebook entry).

f) Transfer a copy of the entire folder to the secured cloud-base drive under the most
current project folder for documentation and record keeping.

16. Record all activities and a brief summary of the test results in a site logbook either in hard or
electronic form. If using an eSIMS logbook entry, select Tasks > Site Visit.

17. Repeat Steps 5-16 for the other path.
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18. When bump testing is complete on both paths, press Run > Macro, select the Site Macro for
both paths and click Open to run.

19. Observe the scans to make sure data are again collecting between the two FTIR paths
successfully in RMMSoft. Make sure the data acquisition script is running as shown in
Figure 9. If it is not, run the following batch file to start it:

C:\Users\user1\Desktop\[Site_#_FTIR] \startTASFTIRWare.bat

G CAWINDOWS\py.exe - [m} X

Figure 9. Data acquisition script.

20. In FTT, place both analyzers in Normal Operation mode and enable missing data alerts.

6.3 Data Management

Raw instrument data are stored on the analyzer and site computers. Data archiving should be
performed on a monthly basis to the portable hard drives connected to the site computer. The
spectral data consist of information regarding the absorbance and transmittance spectrum,
interferogram, and a summary result file. These file formats are described in the Kassay RAM 2000
System Operator Manual.” Details on the proper procedure for archiving data files from the
instrument are as follows.

" Kassay RAM 2000 System Operator Manual, Document Number 0752-467392 Rev: C2, December 2011.
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1. If the folder structure has not been established, follow this recommended structure to create
the sub-folders on the hard drive. Certain folder layers may not be applicable or necessary
for the monitoring project of interest.

o Site

e Monitor Type

e Path#

e Year

e Quarter or Month

2. Begin copying and pasting the files to the appropriate folders on the hard drive. It is
recommended to work with a small batch of folders or files at a time. Verify the total size by
selecting and right clicking the items to view Properties.

3. On the hard drive where the files are backed up, create a digital logbook using Notepad or
Microsoft Word. Use a name for the file that is easily identifiable, e.g. ReadMe.txt or
Logbook.docx.

4. In the logbook, document the action, date, your initials, and any other notes that may help
other technicians understand the status.

5. Once archiving is complete, make sure all critical software and applications needed for
normal data collection remain operational before logging out of the onsite computer.

6.4 Clean Optics on the Detector and Retroreflector

Cleaning the retroreflector is an important part of the maintenance plan. Over time the retroreflector
will collect debris that can alter the performance of the instrument. Caution should be taken, as there
are electrical fan heaters that are used to keep moisture and particulates from collecting on the
retroreflectors.

6.4.1 Retroreflector Cleaning
1. Power down any equipment to prevent electrical shock or damage to the system.

2. Use a gentle stream of distilled water, usually from a weed sprayer or other type of gentle
delivery method, to remove any salt or dust build-up on the retroreflector.

3. Use a gentle stream of 80% isopropyl alcohol, usually from a weed sprayer or other type of
gentle delivery method, to finish removing any salt or dust build-up on the retroreflector.

4. Once the retroreflector has been cleaned and dried, repower the any electrical equipment
you powered down, and clean any spills you created while cleaning.
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6.4.2 Window and Scope Cleaning

If ZPD voltages are low or visual inspection reveals soiled optics, cleaning optical surfaces can
improve light throughput. Before cleaning any mirror, check the latest service report or notes from
the manufacturer, as excessive cleaning of optics can result in scratches and wear over time. If the
optic is obviously soiled and this is affecting performance, take the following steps. Mirrors with
metallic coatings should be treated with extra care because these surfaces are easily damaged on
contact.

Scope Cleaning
1. Log in to FTT and place both paths of the FTIR in planned maintenance mode.
2. Remove the scope from the instrument.
3. Place the scope on the ground at a slight angle to allow the cleaning solution to drain out.
4

Use a pressurized sprayer with distilled water to lightly rinse any heavy dust or dirt off the
primary and secondary mirrors of the scope.

5. Use a pressurized sprayer with 80% or higher isopropyl alcohol to lightly rinse any remaining
contaminants from the primary and secondary mirrors of the scope.

6. Let the scope dry for 20-30 minutes before placing it back on the instrument.

7. Return the unit to normal operations via the FTT.
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FTIR FIELD QA AUDIT WORKBOOK.xlsx

within £25% TO PASS

Span Concentration PPM*M
Date
Operator
Test Gas
Index Concentration (PPM*M)
1
2
3
a4
5
5]
7
8
9
10
11
12
13
14
15
16
Average d #DIV/0!
STD DEV f #DIV/0!
Precision (CV) (%) #DIV/0!
Comment:

Version: 04232024
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1. Scope and Application

This document is the standard operating procedure (SOP) for the maintenance and calibration of the
Teledyne T101 analyzer, which measures concentrations of ambient hydrogen sulfide (HzS). The
calibration system described herein presumes the use of a Teledyne T700 gas dilution calibrator, an
external zero air generator, and a National Institute of Standards and Technology (NIST)-traceable
HzS gas cylinder. However, other suitable calibration equipment may be used for the purpose of
performing maintenance and verification on the T101 analyzer.

2. Safety

This procedure requires the handling of hazardous compounds (Hz2S and SOz2) in the forms of
compressed gas cylinders, permeation tubes, and exhaust gas from the analyzer. H2S and SOz must
be discharged outdoors and away from all personnel after passing through a scrubber or filtration
system. Improper handling may result in acute, long-term health impacts. Personnel must be
properly trained and qualified prior to performing any procedure in this SOP.

3. Method Overview

The Teledyne T101 determines the concentration of HzS by converting it to sulfur dioxide (SO2),
which is then measured by ultraviolet (UV)-induced fluorescence. Ambient air is drawn by an internal
pump through a sample particulate filter to remove particles, a hydrocarbon scrubber to remove
hydrocarbons, and finally an SOz scrubber to remove ambient SOz prior to introducing it into the
converter. The sampling flow rate is 700 standard cubic centimeters per minute (sccm). HzS in the
ambient air is converted to SOz through high-temperature catalytic oxidation, and the converter is
most efficient at 315°C. The resulting SOz is exposed to 214 nm of UV light to create an excited state
molecule (SO2*). The SO2* molecule quickly returns to a lower energy ground state by releasing
excess energy in the form a photon (at 330 nm). The amount of emitted light at 330 nm is directly
related to the SOz concentration, which is used to quantify H2S concentration. The system can also
measure the SOz concentration present in the ambient air by bypassing the sampling flow from the
SO: scrubber and the catalytic converter, if desired.

4. Equipment and Supplies

Before beginning the quality control (QC) check and maintenance, ensure you have the following:

e NIST-certified H2S gas cylinder with regulator or HzS permeation tube

e NIST-certified SOz gas cylinder with regulator or SOz permeation tube (for converter
efficiency check)

e Gas calibrator



H,S Point Monitor SOP; STI-8094
Page 5 of 24

Version 2

July 31, 2024

e Zero air generator

e Certified, NIST-traceable flow meter

e Technician’s tool bag, including screwdrivers, pliers, wrenches, etc.
e Inlet filter opening wrenches

e Replacement particulate filters

e Replacement converter catalyst

e Pump rebuild kit

5. Maintenance Schedule

A list of regular maintenance activities, and the corresponding sections of the T101 user manual
where they are described in detail, is shown in Table 1. Additional information regarding frequency of
service is presented in the facility’s Quality Assurance Project Plan (QAPP).

Table 1. QC and maintenance schedule for the T101 series H2S analyzer.

Activit SOP User Manual
. Section Reference

Perform Zero and Span (Z/S) check 6.1 5.2
Review and verify test functions 6.2 6.72
Review and verify test functions 6.2 6.7.2
Inspect sample lines 6.3 --
Change inlet particulate filter 6.4 6.6.1
Perform flow check 6.5 6.6.9.3
Perform multi-point check 6.1 --
Replace SO2 scrubber material and sintered filters. 6.6 6.6.3
e oy O O rge s
Service the critical flow orifice assembly, replace as needed 6.9 6.6.7
:zrefg;r: pump check, and rebuild pump diaphragm as 6.10 6.6.9.1
Perform leak check 6.10 6.6.9.1
UV lamp adjustment 6.11 6.7.10.3
PMT sensor hardware calibration 6.12 6.7.10.4

Calibrate offset and slope 6.13 5.2
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6. Field Operation and Maintenance

Common maintenance and QC activities are described below. Additional information about
maintenance activities, troubleshooting, and fault codes can be found in the T101 user manual.’

For regulatory projects, the analyzer should never be taken offline or put into Maintenance Mode
if ambient H2S concentrations are elevated (>10 ppb), especially if they are approaching a public
notification level. Report any observations of concern to the Project Manager immediately before
performing maintenance.

6.1.  Perform Zero/Span or Multi-Point Check

A zero/span check evaluates analyzer performance without altering the response curve (slope and
offset values), and is a recommended regular maintenance item. A multi-point check similarly
evaluates performance across the analyzer's measurement range and shall be conducted only after
the analyzer is calibrated. The multi-point check can be used to confirm linearity of analyzer
response.

6.1.1. Manual Verification

1. Verify that the ambient conditions are acceptable (e.g. H2S concentration is < 10 ppb) to
proceed with gas verification. Put the H2S channel into Maintenance Mode from the Field
Tech Tool.

2. Connect the sources of zero and span gas as shown in Figure 1, depending on the instrument
configuration. The zero air generator can be replaced by a zero air cylinder. If using the T700
dilution calibrator, make sure the calibrator contains the accurate gas standard concentration
under cylinder setup.

3. Generate the instrument Zero using the zero air source.

4. From the T101 analyzer with NumaView software, view the concentration and stability
responses by clicking the Home Tab and the blue HzS icon. Verify the T101 mode remains in
SAMPLE at the lower right corner of the display. This ensures the verification is conducted
through the inlet probe.

5. Wait at least 15 minutes until the analyzer stability (STAB) is below 0.5 ppb (wait longer than
15 minutes if more time is needed for STAB to be < 0.5 ppb). Record the reading. If the
stability threshold cannot be achieved, contact the Project Manager and proceed to
additional troubleshooting steps.
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6. From the dilution calibrator, select one of the following options:

a. Span Check: Set the target HzS span gas on. The target value should be at least
80% of the full measurement range.

b. Multi-Point Check: Set the target HzS concentrations appropriate for the
monitoring project. An example of multi-point check concentrations is shown in
Table 2.

Table 2. Example of multi-point check concentrations.

Multi-point check

concentration (ppb)
450
225
120

7. Wait at least 45 minutes until the analyzer stability (STAB) is below 0.5 ppb for each
concentration level (wait longer than 15 minutes if more time is needed for STAB to be < 0.5
ppb at each level). Record the readings. If the stability threshold cannot be achieved, contact
the Project Manager and proceed to additional troubleshooting steps.

8. Refer to the facility's QAPP for the test acceptance criteria.

9. Purge the sampling line and the analyzer by generating a high flow of zero air for at least 5
minutes. This step helps the analyzer return to sampling ambient conditions.

10. At the conclusion of the check, put the calibrator into STANDBY Mode.

IMPORTANT: Failing to change the calibrator to STANDBY Mode means the analyzer will
continue to detect zero air or span gas fed to the inlet, resulting in INVALID ambient data.

11. Verify the T101 status remains in SAMPLE Mode at the lower right corner of the display.

12. Observe and make sure the HzS reading has returned to ambient concentrations before
putting the channel back to Normal Operations from the Field Tech Tool.
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Calibrated
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Sample
VENT (Vent Exhaust line out of area.
<—[ Exhaust
——[ Span
MODEL 701 Zero Air
Zero Air
Generator

VENT if input is pressurized

- ———————

Model
T101

Figure 1. Connection setup for verification and calibration with basic configuration (top) or

zero/span valves option (bottom).

Automated Verification

For some monitoring sites, automated verification may be configured and initiated manually. Note

the following procedure is only applicable when the Teledyne T101 analyzer and T700 dilution

calibrator are used together.

The preset sequences are set up such that an abundance of time (at least 15 minutes for zero and 45

minutes for any non-zero concentration level) is built in to achieve stabilized readings from a

properly functioning, calibrated analyzer.

1.

Verify the ambient conditions are acceptable (Hz2S < 10 ppb) to proceed with gas verification.
Put the Hz2S channel into Maintenance Mode from the Field Tech Tool.
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Connect the zero and span gas sources as shown in Figure 1, depending on instrument
configuration. The zero air generator can be replaced by a zero air cylinder. Make sure the
T700 dilution calibrator contains the accurate gas standard concentration under cylinder
setup menu.

If the verification is to be initiated remotely via the NumaView Remote Software, open the
software, and launch the analyzer and calibrator of interest.

From the T700 dilution calibrator, go to Generate > Sequence to view a selection of preset
sequences, as shown in Figures 2 and 3.

Select the sequence to be initiated and click Generate.

Verify the calibrator begins the steps by observing the Instant Mode in the Generate menu or
Mode at the lower right corner of the display.

Generate =] i 7: 9:03:34 AM

Inst Mode: STANDBY

Home

Dashboard

Alerts

Generate

Utilities

Setup

Mode: STANDBY

Figure 2. Screenshot of the Generate menu on T700 calibrator.

Generate -] ‘i 9:09:22 AM

R Inst Mode: STANDBY
Dashboard

EXECSEQ
Alerts

CALIBRATION

Generate
ZEROAND SPAN CHECK

Utilities >

Setup >

Stany 'ancel Generate

ﬁ > Home Mode: STANDBY -

Figure 3. Screenshot of preset automated sequences on T700 calibrator.
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From the T101 analyzer with NumaView software, view the concentration and stability
responses by clicking the Home Tab and the blue HzS icon. Verify the analyzer remains in
SAMPLE Mode during Zero/Span check and multi-point check at the lower right corner of
the display. This ensures the verification is conducted through the inlet probe.

Review the entire check results to confirm the completion of a Zero/Span check or multi-
point check using Sonoma Technology's Insight data management system (DMS).

When the check is finished, verify the calibrator has been switched back to STANDBY Mode
and the analyzer has been switched back to SAMPLE Mode.

IMPORTANT: Failing to change the calibrator to STANDBY Mode means the analyzer will
continue to detect zero air or span gas that is fed to the inlet, resulting in INVALID
ambient data.

Observe and make sure the HzS value has returned to ambient concentrations before putting
the channel back to Normal Operations from the Field Tech Tool.

Review and Verify Test Functions

Test functions on the Dashboard should be carefully reviewed and verified during each scheduled
site visit. Minimally, operators should check and verify that major test functions remain within the
nominal range shown in Table 3 (also included in the maintenance checklist). Operators should also
review active warning alerts to determine if troubleshooting or corrective actions are required.

Table 3. Major Diagnostics for Teledyne API T101 HzS analyzer.

m Acceptable Value Range

H>S Slope 1+£03

H.S Offset (mV) < 250 mV
Converter Temp (°C) 315+ 1°C

Sample Flow (ccm) 585-715 ccm (650 ccm = 10%)
Pressure (inHQg) ~ 5inHg < ambient pressure
UV Lamp Signal (mV) 2,000-4,000 mV

UV Lamp Ratio (%) 30-120%

Refer to the T101 user manual for a detailed list of test functions, nominal values, and possible
causes for out-of-range values. Additionally, the acceptable ranges for these functions of a specific
analyzer can be found in the Final Test and Validation Data Sheet shipped with the instrument.
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Inspect Sample Lines

Contaminated or kinked sample line can adversely impact sampling data over time. Check for any

sample line flow restriction, and visible dirt or condensation accumulation along the sampling path

between the sample inlet and the analyzer sampling port, as well as the calibration lines. Replace the
sample and calibration lines as needed.

6.4.

Change Sample Particulate Filter

The sample particulate filter inside this instrument needs to be changed monthly even without
obvious signs of dirt, as filters with 1 and 5 pm pore size can clog even when they look clean. A
schematic of the particulate filter is shown in Figure 4.

1.
2.

Turn OFF the analyzer to prevent drawing debris into the sample line.

Open the T101's hinged front panel and unscrew the knurled retaining ring of the filter
assembly.

Carefully remove the retaining ring, glass window, PTFE O-ring, and filter element.

Use a tweezer to carefully replace the filter element, centering it at the bottom of the holder.
Alternatively, wear latex gloves if handling the filter to avoid contamination.

Re-install the PTFE O-ring with the notches facing up, replace the glass cover, screw on the
hold-down ring, and hand-tighten the assembly. Inspect the (visible) seal between the edge
of the glass window and the O-ring to assure proper gas tightness. This is critical for
ensuring that the sample flow does not drop.

Restart the analyzer and perform a leak check.
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Figure 4. Particulate filter assembly.

Perform Flow Check

Use an external, calibrated NIST-traceable flow meter capable of measuring the instrument’s flow
specifications for this check. Do not use the built-in flow measurement viewable in the Dashboard as
this value is only calculated, not measured. A decreasing, actual sample flow may point to slowly

clogging pneumatic paths, most likely critical flow orifices or sintered filters.

1.

2
3.
4

6.6.

Disconnect the sample inlet tubing from the rear panel SAMPLE port.
Attach the outlet port of a suitable flow meter to the rear panel SAMPLE port.
The sample flow measured with the external flow meter should be within 650 cc/min = 10%.

Record the sample flow reading from the external flow meter.

Change the SO» Scrubber (Activated Charcoal)

Input zero air for 5 minutes.
Turn off the analyzer.

Remove the instrument cover.
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Locate the SOz scrubber cartridge in the front of the analyzer (looks like a big white cylinder).
Undo the two 1/8" fittings on the top of the scrubber.

Remove the two screws holding the scrubber to the instrument chassis, and remove the
scrubber.

Take the two Teflon fittings off the instrument.
Empty the SOz scrubbing material and discard the sintered filters into a hazmat bin.

If any SO2 scrubber residual is visible in the line, disconnect the line and clear the line of
powder with compressed air.

Fill each side of the scrubber with new SOz scrubber material until it is 2" from the bottom
of the thread lines (about 2" from the top of the scrubber); do not fill it too high or the
fitting will crush the material.

Install a new set of sintered filters. The filters should be leveled at the bottom of the fittings.

Remove the Teflon tape from both of the removed fittings, and retape them with new Teflon
tape.

Install both fittings back onto the scrubber.
Put the scrubber back into the analyzer and replace the two screws on the bottom.
Screw the two 1/8" fittings back onto the top of the scrubber.

Return analyzer to normal operation.

Check for HaS -> SO, Converter Efficiency
Set the analyzer to SO2 measurement mode.
Supply a gas with a known concentration of SO2 to the sample gas inlet of the analyzer.

Wait until the analyzer’s SOz concentration measurement stabilizes. This can be determined
by setting the analyzer’s display to show the SOz STB test function. SO2 STB should be
0.5 ppb or lower before proceeding.

Record the stable SO2 concentration.
Set the analyzer to H2S measurement mode.

Supply a gas with a known concentration of HzS, equal to that of the SOz gas used in steps
2-4 above, to the sample gas inlet of the analyzer.

Wait until the analyzer’s H2S concentration measurement stabilizes. This can be determined
by setting the analyzer's display to show the HzS STB test function. HzS STB should be
0.5 ppb or lower before proceeding.

Record the stable H2S concentration.

Divide the HzS concentration by the SOz concentration.
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EXAMPLE: If the SOz and H2S reference concentration of the two test gases used is 500 ppb:
Measured SOz Concentration = 499.1 ppb
Measured HzS Concentration = 490.3 ppb
Converter Efficiency = 490.3 + 499.1
Converter Efficiency = 0.982 (98.2%)

10. It is recommended that the H2S -> SOz converter catalyst material be replaced if the

6.8.

converter efficiency falls below 96%. Proceed to the next section to change the converter
catalyst material.

Change H:S -> SO; Converter Catalyst Material

The HzS -> SOz converter is located at the center of the instrument. The converter is designed for

replacement of the cartridge only; the heater with built-in thermocouple can be reused. A schematic
of the HzS to SOz converter assembly is shown in Figure 5.

1.
2.

0.

Turn off the analyzer power, remove the cover, and allow the converter to cool down.

Remove the top lid of the converter and the top layers of insulation until the converter
cartridge is visible.

Remove the tube fittings from the converter.

Disconnect the power and the thermocouple of the converter. Unscrew the grounding clamp
of the power leads with a Phillips-head screw driver.

Remove the converter assembly (cartridge and band heater) from the can. Make a note of
the orientation of the tubes relative to the heater cartridge.

Unscrew the band heater and loosen it. Take out the old converter cartridge.

Wrap the band heater around the new replacement cartridge and tighten the screws using a
high-temperature anti-seize agent such as copper paste. Make sure to use proper alignment
of the heater with respect to the converter tubes.

Replace the converter assembly, route the cables through the holes in the housing, and
reconnect them properly. Reconnect the grounding clamp around the heater leads for safe
operation.

Re-attach the tube fittings to the converter and replace the insulation.

10. Replace the instrument cover and power up the analyzer.
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Service the Critical Flow Orifice Assembly
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Assembly Housing

The critical flow orifice assembly shown in Figure 6 can clog despite protection by sintered stainless

steel filters, particularly if the instrument operates without a sample filter or in an environment with

very fine, sub-micron particle-size dust.

1.

2
3
4.
5

Turn off power to the instrument and vacuum pump.

Locate the critical flow orifice on the pressure sensor assembly.

Disconnect the pneumatic line.

Unscrew the NPT fitting.

Remove the assembly components: 1 spring, 1 sintered filter, 2 O-rings, and 1 critical flow
orifice. You may need to use a scribe or pressure from the vacuum port to remove parts from

the manifold.

Discard the sintered filter. Inspect the two O-rings and replace as needed.

Inspect the critical flow orifice. Replace as needed.

Re-assemble the parts using a new filter and O-rings.
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9. Reinstall the NPT fitting and connect all tubing.
10. Power up the analyzer and allow it to warm up for 60 minutes.

11. Perform a leak check.

-«f}— Gas Line fitting

=4 <——Spring

@ <— Sintered Filter

@& <—O-Ring

(£) <¢——— Critical Flow Orifice
& ¢——O-Ring

~f}— Vacuum Manifold

Figure 6. Critical flow orifice assembly.

6.10. Perform Leak Check/Pump Check

Leaks are the most common cause of analyzer malfunction. A leak check should be carried out
whenever the pneumatic flow path is disrupted. Examples can include, but are not limited to,
changing the sample inlet filter, changing the SOz scrubber materials, or opening the critical flow
orifice assembly. The method described here is easy, fast, and detects (but does not locate) most
leaks. It also verifies the sample pump condition, thus acting as a pump check. An in-depth pressure
leak check may also be performed with additional tools and can be found in the T101 user manual.

1. If not already running, turn the analyzer on and allow at least 30 minutes for flows to
stabilize.

2. Cap the sample inlet port (cap must be wrench-tight).

3. After several minutes when the pressures have stabilized, go to Dashboard to view the
readings.
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e If Sample Flow < 10 ccm, the instrument is free of large leaks. If not, the leak point
should be identified and rectified.

e If Sample Pressure is < 10 in-Hg-A, the pump is in good condition. If not, the pump
diaphragm needs to be replaced.

4. When finished, switch off the pump and SLOWLY open the cap to the sample inlet port to
minimize in-rush flow.

6.11. UV Lamp Adjustment and Calibration

The UV lamp output can be affected by line voltage change, aging lamp, or lamp position. Two
metrics need to be considered when assessing the lamp life: UV lamp intensity and lamp ratio. Lamp
intensity should be 2,000-4,000 mV and the lamp ratio should be 30-120%. These values will
decrease over time. To optimize signal intensity, perform the following steps. Note that a UV Lamp
adjustment and calibration must be followed by a PMT sensor hardware calibration (Section 6.12).

IMPORTANT: DO NOT grasp the UV lamp by the cap when changing the lamp’s position — always
grasp the main body of the lamp. Inattention to this detail could twist and potentially disconnect the
lamp’s power supply wires, which COULD DAMAGE THE INSTRUMENT AND VOID WARRANTY.

1. Let the instrument run for one hour to stabilize the UV lamp.
2. Set the Dashboard to show the UV lamp function.

3. Slightly loosen the large brass thumbscrew located on the shutter housing so that the lamp
can be moved.

4. While watching the UV LAMP reading, slowly rotate the lamp clockwise and counter-
clockwise, and move lamp up and down vertically until the UV LAMP reading is at its
maximum.

5. Finger-tighten the thumbscrew.
6. Assess whether the lamp signal is within optimal intensity (3,500 + 200 mV).

7. If the signal intensity is too high or too low, locate the UV reference detector adjustment
potentiometer screw and turn the screw clockwise to increase the signal or counter-clockwise
to decrease the signal until signal intensity is optimal.

IMPORTANT: Increasing UV reference detector adjustment potentiometer to its maximum introduces
measurement noise and results become unstable. If the potentiometer has to be maxed out to
achieve optimal signal, the lamp should be replaced.

Visual instructions of the lamp adjustment process performed by the manufacturer can be found at:


https://www.youtube.com/watch?v=PF6MGK1FftQ
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Now the optimal lamp signal is achieved, the lamp must be calibrated to reset the lamp ratio. Based
on the lamp ratio, the Model T101 compensates for variations in the intensity of the available UV
light by adjusting the HzS concentration calculation. The lamp ratio results from dividing the current
UV lamp intensity by a value stored in the CPU’s memory from the last lamp calibration. Once the
lamp ratio is < 30% or > 120%, the CPU can no longer compensate for the difference in the current
signal from the last saved signal. Calibrate the lamp by doing the following:

1.
2.
3.

6.12.

From the Home page, navigate to Utilities > Diagnostics > Lamp Cal.
Press Calibrate, and the CPU will save the current lamp signal intensity automatically.

Confirm the lamp calibration is complete by checking if the lamp ratio is close to 100% (+ the
average fluctuation of lamp intensity).

If the lamp ratio is not close to 100%, power the T101 off and then on again. The lamp ratio
should be close to 100% and the lamp calibration is complete. If not, repeat the lamp
calibration steps.

PMT Sensor Hardware Calibration

At times when the instrument’s slope and offset values exceed the acceptable range (see Table 3 in
Section 6.2) and all other more obvious causes for this problem have been eliminated, the PMT
sensor may be calibrated to reset the PMT output.

1.
2.
3.

Set the instrument reporting range to SINGLE.
Perform a zero calibration using zero air.

Run a UV lamp calibration (Section 6.11). This is required to ensure proper scaling of the
NORM PMT value.

Locate the pre-amplifier board installed on top of the PMT assembly.

Locate the following components on the pre-amplifier board (Figure 7):
a. High voltage power supply (HVPS) coarse adjustment switch (range 0-9, then A-F)
b. HVPS fine adjustment switch (range 0-9, then A-F)

c. Gain adjustment potentiometer (full scale is 10 turns).
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11.

12.
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Turn the gain adjustment potentiometer 12 times counterclockwise to its minimum setting,

then 4 turns clockwise to have some voltage to work with.

While feeding at least 80% of measurement range value to the analyzer and waiting until the

STAB value is below 0.5 ppb, calculate the target concentration by multiplying the span

concentration by the analyzer slope. For example, target concentration = 400 ppb H2
= 500 ppb H:S.

Note the position of the two HVPS adjustment switches. Carefully use a flathead or sl
screwdriver to adjust the HVPS coarse and fine adjustments until the instrument
concentration reads close to the target concentration calculated in the previous step.

Sx 125

otted

IMPORTANT: DO NOT overload the PMT by accidentally setting both adjustment switches to
their maximum setting (mark F). Start at the lowest setting and increase by increment slowly.

Perform a span calibration. The slope should now be close to 1.0 and the concentration

should be close to the span gas concentration.

Use the Dashboard or Home page to review the NORM PMT value. This value should

be

double the span gas concentration in ppb. With 400 ppb H:zS, the NORM PMT should show

800 mV on a properly calibrated analyzer.

Review and record the new slope and offset as part of the calibration procedure.
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6.13. Calibrate Offset and Slope

Generally, a calibration is required when Zero/Span or multi-point check results fail or are marginal,
and after major part repairs. Care should be taken to troubleshoot and eliminate all other more
obvious causes for the check failures before proceeding with calibration.

Navigate to the Calibration menu as shown in Figure 8 to perform calibration. On the units with a
zero/span valve option installed, select the calibration gas source (Zero or Span) accordingly.
Detailed screenshots can be found in the T101 user manual.

3:04:21 PM

Calibration

Home

Stab 17.01 PPB

]
MJ
=

Dashboard _; -
5003 E15
Alerts ] C
400 3 C 10
Calibration 200 —fM s
Utilitiﬁ > 2:'0 :I LI | I TIir I T 7T | T 17T | TrT | LI I TTT I 1T | 1T | L |: D

3:00 3:01 3:.02 3:03 3:04 3:05 3:06 3:07 3:.08 3:.09

-E“

> Home Mode: M-P CAL

Setup >

Figure 8. Calibration page.

6.13.1. Manual Calibration

IMPORTANT: Before any calibration, record the as-found Slope and Offset in the maintenance form.
You will NOT be able to retrieve the values once the analyzer is calibrated.

NOTE: If the ZERO or SPAN buttons are not displayed during the zero and span calibration, the
measured concentration value is too different from the expected value and the analyzer does not
allow zeroing or spanning the instrument.

Zero calibration:
1. From the calibrator, generate the zero air.
2. From the analyzer, select Calibration > Start.
3. Wait until the analyzer stability (STAB) is below 0.5 ppb.
4

Click Zero to calibrate.
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5. Click Stop and verify the reading.
Span calibration:
6. From the calibrator, generate the desired span gas concentration.
7. From the analyzer, select Calibration > Start.
8. Wait until the analyzer stability (STAB) is below 0.5 ppb.
9

Click Set Span Target > Enter the actual reading from the calibrator > Done. Use the target
concentration if the actual reading is not available.

10. To perform calibration (i.e. adjust the slope and offset) click Span.
11. Click Stop and verify the reading.

12. At the conclusion of Zero and Span calibration, verify the new slope and offset are within the
acceptable range shown in Table 3. If they are outside of the acceptable range, some parts
may be causing the slope and offset to over-compensate and corrective action is needed.

13. Record the new slope and offset in the maintenance form.
14. Proceed to Section 6.1 to perform a post-calibration multi-point check.

IMPORTANT: On the units with a zero/span valve option installed, DO NOT rely on the
Sample dropdown option in the Calibration page to return to the sampling mode. Instead,
navigate to Home page to ensure the analyzer is back in SAMPLE mode.

6.13.2. Automated Calibration

For some monitoring sites, automated calibration may be configured and initiated manually. Note
the following procedure is only applicable when the Teledyne T101 analyzer and T700 dilution
calibrator are used together.

The preset calibration sequence is set up such that an abundance of time (at least 15 minutes for
zero and 45 minutes for any non-zero concentration) is built in to achieve stabilized readings before
the analyzer is automatically calibrated.

Due to the close similarity between the automated verification and automated calibration feature,
this section describes only the major highlights when initiating an automated calibration sequence.
Read this section thoroughly before proceeding to Section 6.1.2 to perform an automated
calibration.

e Before any calibration, record the as-found slope and offset in the maintenance form. You
will NOT be able to retrieve the values once the analyzer is calibrated.

e Make sure the T700 dilution calibrator contains the accurate gas standard concentration
information in the cylinder setup menu.
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e Once the calibration sequence is initiated, verify the calibrator begins the steps by observing
the Instant Mode in the Generate Menu or Mode at the lower right corner of the display.

e At the conclusion of Zero and Span calibration, verify the new slope and offset are within the
acceptable range shown in Table 3. If not, some parts may be causing the slope and offset to
over-compensate and corrective action is needed.

e Record the new slope and offset in the maintenance form.

e Proceed to Section 6.1 to perform a post-calibration multi-point check.

7. Maintenance Form Template

Examples of the maintenance checklist and response summary are shown in Figures 9 and 10. This
may be used as a template to be customized to meet the specific monitoring project goals.



H>S Point Monitor SOP; STI-8094
Page 23 of 24

Version 2

July 31, 2024

H25 Monitor - Teledyne - T101

H3zE Teledyne T101 =
Calibratar (Teledyne T700) i
Gazs Cylinder o

Gas Cylinder Expiration Date >
ZAG (Teledyne 701) -

Notify field operations O
Enable missing data alerts

Dizable mzintenance mode O

Verification Type

BOTH Analyzer and Calibrator cleared of all active alerts?
Perform Zero/Span gas test for analyzer response. If the test fails, investigate the root cause. and calibrate as needed.
Inspect sample line tubing and inlet.
Inspect and empty out water trap.
Replace inlet particulate sample filter.
Perform multi-point gas test for analyzer response. If the test fails, investigate the root cause, and calibrate as needed.
Ferform a flow check.

Replace 502 scrubber media.

i I Y o Y 5 O

Perform zero air generator and dilution calibrator maintenance.

Figure 9. Example of T101 Hz2S analyzer checklist.
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As Found H35 Slope As Left ™

As Found H35 Offset As Left .
{mV)

Concentration {pph) ™~

H25 5TE (pRb} %

Sample Flow (sccm) . -

Ssmple Pressurs (in Hg) -

UV Lamp (mV} -

Lamp Ratio (%) =

HVPS [V} e

Box Temperature {*C) .

Converter Temperature (C) ™

Measured Zero
(ppb)

H25 5T
(peb)

Expected Concentration
LCED]

Measured Concentration
{peb)

H25STB
(ppB)

% Error

Pa=z/Fail

Figure 10. Example of T101 H2S diagnostics and span test summary.
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1. Purpose and Method

This Standard Operating Procedure (SOP) describes the general maintenance of the Magee Scientific
Aethalometer Model AE33 black carbon analyzer.

This manual is adapted from Magee Scientific's User Manual, version 1.54, which is available at

The Magee Scientific Aethalometer Model AE33 is used to quantify black carbon (BC) in the air. The
Aethalometer draws air through a spot on filter tape and then analyzes the aerosol present in the
sampled air by measuring the transmission of light through the tape. The sample spot transmission is
compared to an unloaded portion of the filter tape which acts as a reference. This analysis is
performed at seven optical wavelengths, from the near-infrared to the near-ultraviolet. The
Aethalometer calculates the instantaneous concentration of optically absorbing aerosols from the
rate of change of the attenuation of light transmitted through the particle-laden filter. Two
measurements are obtained simultaneously from two sample spots with different rates of
accumulation of the sample. Both spots derive their samples from the same input air stream. The two
results are combined mathematically to eliminate nonlinearities common in previous instrument
measurements to provide the compensated particle light absorption and BC mass concentration.

The instrument will be operated with 1-min time resolution.

2. Equipment and Supplies

Maintenance for the Magee AE33 is carried out with the following equipment:

e Instruments for flow checks

e New roll of filter tape

e Adhesive tape

e Screwdriver

e Flow calibration pad (black rubber)
e Flow meter

3. Personnel Qualifications

Installation, operation, maintenance, repair, or calibration of the instrument and all support
equipment should be performed by properly trained personnel. Personnel should meet all minimum
STl requirements and qualifications for an Air Quality Field Technician.
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4. User Interface and Operation

4.1. User Interface

The four top-level tabs in the touch screen user interface are: HOME, OPERATION, DATA, and
ABOUT. They are described as follows:

HOME has the following parameters:

e BC - the measured values for Black Carbon (measured at 880 nm)

e UVPM - UV particulate matter (calculated at 370 nm)

e REPORTED FLOW - Measured flow (in LPM)

o TIMEBASE - Timebase setting (in seconds)

e TAPE ADV. LEFT — The amount of remaining tape (in)

e STATUS - Instrument status: green (all OK), yellow (check status), and red (stopped) with a
Status Condition (see Section 4.2, Instrument Status)

e Bottom of HOME screen shows date and time

Note: The BC and UVPM values are typically similar, but not exactly the same. When aromatic
compounds are present in the sampled air (such as when sampling fresh wood smoke, for
example), the UVPM concentration can exceed the BC mass concentration value significantly,
depending upon the amount and type of organic material present.

OPERATION has four sub-tabs: GENERAL, ADVANCED, LOG, and MANUAL.

e GENERAL - with the following settings:

Flow (LPM) (see Note below on flow-reporting standard)
TimeBase (seconds)

o Select one of three radio buttons:

o O

= TA ATNmax — maximum attenuation at which the Aethalometer advances tape
» TAINT - the time interval at which the Aethalometer advances tape (hours)

= TATime - the time at which the Aethalometer advances tape
Start, Stop, Stability, Clean Air, and Change Tape buttons

(¢]

e ADVANCED - All parameters which can be set in the Aethalometer
¢ LOG - The last operational reports of status, parameter changes, data download

¢ MANUAL - Basic commands to operate hardware (solenoids, pump, chamber, TA)

DATA has two sub-tabs: TABLE and EXPORT.

e TABLE — Raw measurement values, BC concentration calculated from each individual spot
(BC1, BC2), and the compensated BC concentration. All three concentrations have the unit
ng/m?.

e EXPORT - Selection data to be copied to USB

ABOUT - Features and contact information.
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The instrument’s current status condition is displayed in decimal format on the front panel HOME
screen and in the Status column of the data download. The status condition relates to various
subcomponents of the instrument (Detector, Flow, LED, etc.). The decimal number represents a sum
of all of the status conditions occurring at any given time. Multiple status conditions are interpreted
using subtraction of the largest possible Status Condition value using the table below.

Detector

Flow

LED

Tape Advance

Tests

Table 1. Status Conditions and Descriptions

> t SElE Description
arameter 1 condition

0
1

16

32

48

128
256
384

1024
2048
3072

Measuring
Not measuring (due to tape advance, fast calibration in

progress)

Calibrating (LED, Flow, Tape Sensors)

Stopped
Flow OK

Flow low/high by more than 0.25 LPM

Flow check status history

Flow low/high and check status history
LEDs OK
Calibrating

Calibration error in one or more channels (at least one
channel OK)

LED error (all channels calibration error, COM error)
Tape advance OK

Tape warning (less than 10 spots left)

Tape last warning (card box visible, less than 5 spots left)
Tape error (tape not advancing, end of tape)

No test

Stability test

Clean air test

Change tape
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When Status Condition 3 is encountered, the Aethalometer stops. In all other statuses, it continues to
operate with a warning, and the data is flagged accordingly. The status is represented by one value,
which can point to one parameter or a combination of parameters.

4.2.1. Single Status Condition

If the value displayed matches a value in the Status Condition column, it indicates only one
parameter and its description. Examples:

e Status = 0, all OK; front panel LEDs GREEN
e Status = 1, all OK, tape advancing; blinking GREEN LED

e Status = 128, machine is running, tape advance warning flag is set; YELLOW
4.2.2. Multiple Status Conditions

If the Status displayed does not match a value in the table, it means that there are multiple
parameters whose Status Conditions are added together, forming a sum that must be broken down
by subtraction. First, find the largest value in the Status Condition column that does not exceed the
Status value, and subtract it from the sum. Then find the next largest value in the Status Condition
column that does not exceed the remainder, and subtract again. Continue finding the next largest
number and subtracting it until the remainder matches a value in the Status Condition column.
Examples:

e Status = 289, which breaks down as follows: 289 — 256 = 33; 33 — 32 = 1; therefore, the

Status Conditions are 256, 32, and 1. This means the machine is not measuring (1), the LED
calibration had errors in 1 or more (but not all) channels (32), and less than 5 tape advances
are left (256).

e Status = 145, which breaks down as follows: 145 — 128 = 17; 17 — 16 = 1; therefore, the

Status Conditions are 128, 17, and 1. This means the machine is not measuring (1), the LED
calibration is in process (16), and less than 10 tape advances are left (128).

4.3. Downloading or Viewing Data

To download data, insert the USB stick in either of the front USB ports. Do not use the rear ports, as
they are intended for the mouse and keyboard only and not for data transfer (surge protection).

Go to the “DATA/EXPORT" menu and press Export to USB. The data will be stored in a text file with a
header. The file name is:

AE33_Sss- nnnnn_yyyymmdd.dat

where ss is the production series number, nnnnn is the serial number, and yyyymmdd is the date (for
example, 20120901 means 1 Sept 2012). Please make sure that the transfer is finished before



Magee Scientific Aethalometer Model AE33 SOP; STI-7538
July 24, 2024

Version 2

Page 7 of 19

removing the USB stick from the USB port on the Aethalometer. The data file can now be transferred
to a personal computer like any other file and processed with any preferred data processing
application.

5. Field Maintenance

Table 2 describes maintenance actions, including cleaning and inspections and their required
frequencies for routine system management.

Table 2. Regular maintenance schedule.

Maintenance Action

Inspect sample line tubing Monthly, or during a site visit
Visually inspect the tape Monthly, or during a site visit
Inspect and clean the size selective inlet Monthly, or during a site visit

Inspect and clean the insect screen assembly  Monthly, or during a site visit
Perform leak test Monthly, or after maintenance or repair
Flow verification test Monthly, or after maintenance or repair

Monthly, or if any flow from the flow

Flow calibration . .
verification summary is >10%

Check/set the instrument date and time Monthly
Install new filter tape roll As needed upon instrument warning

Biannual to Annual Actions

Inspect optical chamber, clean if necessary Every six months (or as needed)
Clean air test Every six months

Stability test Every six months

Inlet leakage test Annually

Neutral Density (ND) filter test Annually

Lubricate optical chamber sliders Annually

Change bypass cartridge filter Annually

5.1. Inspect Sample Line Tubing

Visually inspect the sample line tubing for condensation, cracks, kinks, or other structural damage.
Replace if needed.
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5.2. Inspect and Clean the Insect Screen Assembly

The insect and water trap is installed in the sample inlet line, at a point
close to the instrument and clearly visible. This trap prevents the entry of

contamination (which will compromise the data); or entry of water (either
rain or condensation), which can lead to serious damage of the flow
sensors. Visually inspect the trap and remove and clean as necessary.

5.3. Install New Filter Tape Roll

Supplies for this procedure: new roll of filter tape, adhesive tape. See Section 9.2 of the user's manual
for reference.

When you observe an instrument warning of tape change needed, follow these instructions to
change the tape. This should occur roughly every 6 weeks or so.

1. If the instrument is running, press Stop on the front panel.

2. Open the front door of the instrument.

3. Loosen the thumb screws and remove the transparent plastic covers from both the "supply"
spool (on the left hand side), and the "collection" spool (on the right-hand side).

4. Using thumb and fingers on both sides of the optical chamber, lift the chamber upwards
against its springs.

5. When the chamber is fully raised, lock it in place by pushing the metal latch.

6. Remove the used tape from both spools. Place used tape in a Ziploc bag.

7. Take the new filter tape and place it on the supply spool. Take note of the metal spring leaf,
which stabilizes the top surface of the roll.

8. Make sure the roll is correctly oriented—the tape must unroll from the left-hand side.

9. Take the other cardboard spool center and attach the end of the filter to it using adhesive
tape.

10. Place the empty center on the "take-up" spool axis (the right-hand side of the collection
spool).
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11. Make sure that the tape is fed beneath both the left and the right guide posts, and passes
under the optical chamber.

12. Release the optical chamber by lifting up with thumbs and fingers on both sides. The
spring-loaded latch will automatically release.

13. Replace both transparent plastic covers. Tighten the thumb screws by hand only.

14. Check that the left-hand supply spool can turn freely.

15. Make sure that the right-hand collection spool is firmly clamped to its axis: test by gently
pulling the tape, and make sure the spool center does not move.

16. The filter tape replacement procedure is now completed. Press Start to resume operation.
5.4. Perform Leak Test

Supplies for this procedure: flow calibration pad, flow meter.

1. If the instrument is running, press Stop on the Operation/General screen.

2. On the Operation/General screen, press Leakage test to start the test.

3. A new screen appears. Choose Manual.

4. The instrument will measure the flow through the filter tape. Confirm by pressing OK.

5. Connect your external mass flow meter to the inlet port.

6. Connect the flow meter using well-sealed tubing and fittings. Make sure the connections are
tight.

7. Press OK.

8. Choose the flow at which you want to perform the test. Normally this test is conducted at

5 LPM. Press OK.

9. Observe the flow measured by your flow meter.
IMPORTANT! Make sure that your flow readings are reported at the same “Standard”
reporting conditions of Temperature (25°C) and Pressure (101325 Pa) that you are using in
the Aethalometer. Many flow meters display flow at “actual” conditions (i.e. local T and P);
and also display the same result corrected to “standard” conditions.
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Press the input box field and enter the flow from the external flow meter.

IMPORTANT! Units are milliliters per minute (mLPM), not liters per minute (LPM).
Confirm by pressing OK.

Now measure the flow once again, but through the rubber flow calibration pad rather than
the filter tape.

When prompted, remove the filter tape and install the rubber flow calibration pad with the
notch facing toward you.

When ready, press OK.

Repeat the procedure as before when measuring the flow through the filter tape (Steps 4-11).
When finished, remove the flow calibration pad and replace the filter tape. Press OK.

The test is now complete. The report shows:

— Instrument serial number

— Date and time of the test

— Results of the test: selected flow and flows through the filter tape and calibration pad
This report is also saved on the CF card and is available for download with data files.

The leakage should be less than 10%. If the reported leakage is larger than 10%, contact
Magee Scientific or your authorized distributor.

5.5. Perform Flow Verification Test

Supplies for this procedure: flow calibration pad, flow meter. See Section 9.3 in the user's manual for

reference.
1. If the instrument is running, press Stop on the Operation/General screen.
2. Press the Verify flow button to start the test.
3. A new screen will appear. Choose Manual.
4. Measure the flow through the flow calibration pad.
5. Wait for the chamber to lift. When prompted, remove the filter tape and install the rubber

o

10.

11.

flow calibration pad with the notch facing toward you.

When the pad is installed, press OK.

Connect the external flow meter to the inlet port using well-sealed tubing and fittings. Make
sure that the connections are tight.

Press OK. The Flow Verification routine will measure the flow at three different values
(approximately 1 LPM, 3 LPM, and 5 LPM), and compare the “internal” value (from the
instrument'’s flow sensors) with the “external” value measured by the external flow meter.
Note the flow on your external mass flow meter.

IMPORTANT! Make sure that your flow readings are reported at the same reporting
conditions of T and P as the instrument’s setting.

Press the empty box marked Flow and enter the flow from the external flow meter.
IMPORTANT! Units are milliliters per minute (mLPM).

Confirm by pressing OK. The process will repeat at the three flow values.
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13.

14.
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After entering the last value (@5LPM) and pressing OK, the instrument will show the flow
verification report. This report is also saved on the CF card and is available for download with
data files.

The test is satisfactory if the difference of flow readings is less than £10%. If the difference is
larger, re-calibration of the flow sensors is needed (see section 9.3 of the user’'s manual).
Confirm by pressing OK.

When prompted, remove the rubber flow calibration pad and re-install the filter tape. Press
OK when done.

5.6. Perform Flow Calibration

Supplies for this procedure: Flow calibration pad (black rubber), flow meter.

1

2.
3.
4

10.
11.
12.
13.
14.

If the instrument is running, press Stop on the Operation/General screen.

Press the FlowCal button to start the test.

A new screen will appear. Choose Manual.

The instrument will run through several procedures. The first is to measure the flow through

the flow calibration pad.

— If the rubber pad is already in place, you can press Skip.

— If not, please wait for the chamber to lift. When prompted, remove the filter tape and
install the rubber flow calibration pad with the notch facing toward you.

—  When the pad is installed, press OK.

Connect the external flow meter to the inlet port.

Connect the flow meter using well-sealed tubing and fittings. Make sure that the connections

are tight. Press OK.

The instrument will measure the flow at three different points: close to 1 LPM, 3 LPM, and

5LPM.

Observe the flow measured by your flow meter.

IMPORTANT! Make sure that your flow readings are reported at the same “Standard”

reporting conditions of Temperature and Pressure that you are using in the Aethalometer.

Press the input box field and enter the flow from the external flow meter.

IMPORTANT! Units are milliliters per minute (mLPM), not LPM.

Confirm by pressing Enter.

After entering the last value (@ 5LPM) and pressing OK, the procedure is completed.

Remove the flow calibration pad and replace the filter tape. Press OK when done.

Press Start to resume sampling.

Repeat flow verification test.
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6. Biannual Maintenance

Table 3. Biannual maintenance schedule.

Maintenance Action

Inspect optical chamber; clean if ~ Every six months (or more

necessary frequently if needed)
Clean air test Every six months
Stability test Every six months
Inlet leakage test Annually

Neutral Density (ND) filter test Annually
Lubricate optical chamber sliders ~ Annually

Change bypass cartridge filter Annually

6.1. Clean Optical Chamber

The optical chamber should be inspected if the data are uncharacteristically noisy. This procedure will
ensure that there is no dust or contamination in the optical path. See Section 9.1 in the user’'s manual

for reference.

Supplies: Can of compress air such as Dust-Off or similar, technical-grade ethanol, cotton swabs.

1.

If the measurements are running, press Stop. This procedure can also be done when the
instrument is powered off.

Open the front door to access the optical chamber.

Using thumb and fingers on both sides of the optical chamber, lift the chamber upward
against its springs. When the chamber is fully raised, lock it in place by pushing the metal
latch. The chamber is now locked.

Find the release button on the front of the chamber.

While pressing the release button upward, grasp the lower portion of the optical head and
turn it clockwise so the front of the chamber moves to the left. The lower portion will loosen
from its bayonet fitting and can be removed.

The lower portion of the optical head consists of a translucent block. Clean all surfaces with
ethanol. Put a few drops of ethanol in the openings and remove any dust or debris by using
soft cotton swabs.

Repeat this procedure from both sides.

Use compressed air to remove any debris from the openings.

To re-install the optical head, first align the notched marker to the left of center; push the
optical head upwards to engage the three bayonet fittings; and turn counter-clockwise (so
the front of the chamber moves to the right).
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10. When the chamber is fully installed, the marker line will be at the front, and the locking pin
will click back into place.

11. Using thumb and fingers on both sides of the optical chamber, lift the chamber upward. The
locking latch will automatically release. Allow the chamber to return down to the tape.

12. Restart the instrument and resume measurements.

6.2. Perform Clean Air Test

The Clean Air test is conducted using the built-in filter to determine the stability and performance of
the Aethalometer under the air flow conditions. The Clean Air test lasts for 20 minutes, during which
time a Status Code of 2048 is shown. At the end of the test, a report is generated and saved to the
CF card.

1. If the measurements are running, press Stop. If the Aethalometer is off, turn it on and wait a
minimum of one hour for average BC values to stabilize.

2. Go to the Operation/General screen, and press the Clean Air button to start the test.
IMPORTANT: if you want the instrument to automatically proceed with BC measurements
after the Clean Air test, please be sure to check the box "continue after test" before
starting.

3. A new screen lists all relevant information about the test settings (test duration, flow, and
timebase). When ready, press OK.

4. The instrument begins the test. The Clean Air test uses a built-in filter to determine the
stability and performance of the Aethalometer under dynamic conditions of air flow. Air is
drawn through a cartridge filter (mounted on the top of the optical chamber), and this
particle-free air then flows through the analytical system.

5. After 20 minutes, the test stops automatically.

6. The Clean Air test procedure report is generated and appears on the screen. A separate
report is generated and saved on the CF card for later download.

7. The test result is acceptable if the value of PPBC on Spot1 is lower than 550 ng/m? for
Channel 6. If the measurements do not meet the data quality objectives listed in the QAPP,
repeat the procedure. If repeated measurements appear nonconforming, initiate corrective
action investigation.

8. Confirm completion of the test by pressing OK. The Average BC values should be close to
zero (less than £100) if the Aethalometer is warmed up and stabilized for at least one hour.
Occasionally, a short transient may be seen at first, due to a filter compression artifact.

6.3. Perform Stability Test

The stability test determines the performance of the light source and detector, without air flowing
through the system. The Stability Test lasts for 20 minutes, during which time a Status Code of 1024
is shown. At the end of the test, a report is generated and saved to the CF card.



Magee Scientific Aethalometer Model AE33 SOP; STI-7538
July 24, 2024

Version 2

Page 14 of 19

If the measurements are running, press Stop. If the Aethalometer is off, turn it on and wait a
minimum of one hour for average BC values to stabilize.

Go to the Operation/General screen, and press the Stability Test button to start the test.
IMPORTANT: if you want the instrument to automatically proceed with BC measurements
after the Stability Test, please be sure to check the box "continue after test” before
starting.

A new screen lists all relevant information about the test settings (test duration, flow, and
timebase). When ready, press OK.

The instrument begins the test.

The test stops automatically after 20 minutes.

The Stability Test procedure report is generated and appears on the screen. A separate report
is generated and saved on the CF card for later download.

The test result is acceptable if the value of PPBC on Spot1 is lower than 450 ng/m?3 for
Channel 6. If the reported value of PPBC on Spot 1 is larger than this value, please contact
Magee Scientific or your authorized distributor. If the measurements do not meet the data
quality objectives listed in the QAPP, repeat the procedure. If repeated measurements appear
nonconforming, initiate corrective action investigation.

Confirm completion of the test by pressing OK. The Average BC values should be close to
zero (less than £100) if the Aethalometer is warmed up and stabilized for at least one hour.

6.4. Perform Inlet Leakage Test

Supplies: External flow meter.

The Inlet Leakage test is used to test the integrity of the inlet system, from the point of sample entry
to the instrument’s analytical area. In many cases, the sample entry point is outdoors, while the

instrument is indoors. This test detects any leakage throughout the system.

The test routine compares two measurement values from an external flow meter: one taken at the
rear port of the instrument, and the other taken at the sample point of entry (which may be
outdoors). The routine requires the use of the black rubber Flow Calibration Pad. During this test,
data will be flagged by status code 6144,

1

2.
3.
4

From the Operation/General screen, press Inlet Leakage Test.

Follow the instructions on the screen to insert the Flow Calibration Pad.

Measure the flows with an external flow meter at the two points.

When the test is finished, a report is generated. The leakage should be less than 10%. If the
reported leakage is larger than 10%, please contact Magee Scientific or your authorized
distributor. If the measurements do not meet the data quality objectives listed in the QAPP,
repeat the procedure. If repeated measurements appear nonconforming, initiate corrective
action investigation.
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6.5. Perform Neutral Density (ND) Filter Test

Supplies: ND filter test kit.

1.

Go to the Operation/General screen on the Aethalometer. If the measurements are running,
press Stop.

Press the ND test button to start the test.

A new screen prompts you to enter the ND Kit Serial Number, which is marked on the test kit
box.

After entering the Serial Number of the ND Kit, confirm by pressing Enter and OK.

If this is the first time the ND Test has been performed on this instrument, you will be
prompted for calibration parameters. These must be uploaded from the USB memory stick
that is included in the ND kit box. Insert the USB stick into the USB port on the front panel,
and press Yes.

The instrument will copy the calibration parameters file and then begin the test procedure.
Always keep the filter tape in position across the analytical area. When prompted, insert ND
element No. 0 (zero) on top of the filter tape, with the “V" notch facing forward (see below).
Do not touch the glass—hold the element by the metal studs.

12.

13.

Press OK when inserted. Watch the screen, and remove the filter disk when prompted.
Repeat the same procedure when prompted for ND elements Nos. 1, 2, and 3.

. The test is complete after ND element No. 3 is removed.
. The instrument will generate a report that shows the instrument serial number, the date and

time of the test, and the results of the test. This report is also saved internally and is available
for future download.

Report values on both Spot1 and Spot2 should be within £10% of 1.000: i.e., between 0.9 and
1.1, for all seven wavelengths (Ch1 to Ch7). See below.

If the results fall outside this range, repeat the test. If the results still fall outside the range,
contact Magee Scientific. If the measurements do not meet the data quality objectives listed
in the QAPP, repeat the procedure. If repeated measurements appear nonconforming, initiate
corrective action investigation
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New test: NDtest AE33-504-00409 20160107 121957.dat  AE33-ND-
0042
Ref test: NDtest AE33-504-00409 20151124 164453 dat AE33-ND-
0042

+/- 10%
0.900 - 1.100

6.6. Lubricate Optical Chamber Sliders

Supplies: silicon grease, a cotton swab.

1. If the measurements are running, press Stop. This procedure can also be done when the
instrument power is switched off.

2. Open the front door of the Aethalometer.

Put a small amount of grease on the cotton swab.

4. Apply the grease on all three sliders (vertical shafts) of the optical chamber (see below). Try to
apply the grease uniformly over the whole length of the sliders.

w

4 DANGER |
MOVING PARTS! ‘
WATCH YOUR
g = FINGERS.
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5. Grasp the optical chamber with thumb and fingers on both sides, and move it up and down
against its springs several times. This will distribute the grease over the full range of the
sliders.

7. Troubleshooting

If there is an error code on the startup screen, refer to Section 13 of the manual for an extensive list
of codes. Identify the code and problem from the list. Then, call STI.
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8. Maintenance Forms

8.1. Magee Aethalometer Checklist

Schedule of maintenance activities for Magee AE33 Aethalometer.

Monthly

Inspect sample line tubing.
Visually inspect the tape, replace if necessary.
Inspect and clean the size selective inlet.

Inspect and clean the water trap/insect screen assembly.

Perform leak test.

Flow verification test.

Inspect optical chamber, clean if necessary.
Perform clean air test.

Perform stability test.

Perform neutral density (ND) filter test.
Lubricate optical chamber sliders.

Change bypass cartridge filter.

Corrective Actions for Aethalometer:
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8.2. Magee Scientific Aethalometer Response Summary
DATE: Location:
Clean Air Test
Start Time End Time
Spot 1 PPBC ng/m3
Value less than 550 ng/m3 (Yes/No)
Neutral Density Filter Test
Start Time End Time
Test Results
Channel1 Spot1 Spot 2
Channel2 Spot1 Spot 2
Channel 3 Spot1 Spot 2
Channel4 Spot1 Spot 2
Channel 5 Spot1 Spot 2
Channel 6 Spot 1 Spot 2
Channel 7 Spot1 Spot 2
Values between 0.9 and 1.1 (Yes/No)

NOTES:
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1. Summary of Method

The Teledyne APl Model T640x is a real-time, continuous particulate matter (PM) mass monitor that
uses scattered light spectrometry; specifically, it employs broadband spectroscopy using 90° white-
light scattering with a polychromatic light-emitting diode (LED).

There are two designated methods using the T640 instrumentation. The model T640 with the 640x
option (i.e., the T640x) is an approved Federal Equivalent Method (FEM) for PM1o [EQPM-0516-239],
PMzs [EQPM-0516-238], and PM1o-25 [EQPM-0516-240] measurements. The T640x operates at a total
flow rate of 16.7 liters per minute (Ipm), and this Standard Operating Procedure (SOP) document
focuses on this method. The model T640 is an approved FEM for PM2s [EQPM-0516-236]. The 7640
also measures PM10 and PM1o-25, but only the PMzs fraction meets FEM requirements. The T640
operates at a total flow rate of 5.0 I[pm. This SOP is based on the Environmental Protection Agency's
(EPA) SOP for the Teledyne T640x.

1.1 Principles of Operation

The Model T640x PM mass monitor is an optical aerosol spectrometer that converts optical
measurements to mass measurements by determining sampled particle size via scattered light at the
single particle level according to Lorenz-Mie theory. Briefly, the sampling head draws in ambient air,
which is dried (i.e., brought below 35% relative humidity [RH]) with the Aerosol Sample Conditioner
(ASC) and moved into the optical particle sensor. There, the scattered light intensity is measured to
determine particle diameter. The particles next move separately into the T-aperture through an
optically differentiated measurement volume that is homogeneously illuminated with polychromatic
light. The polychromatic light source, an LED, combined with a 90° scattered light detection, yields a
precise and unambiguous calibration curve in the Mie range that allows particle sizes to be
determined to a high level of precision.

Each particle generates a scattered light impulse that is detected at an 85° to 95° angle where
amplitude (height) and signal length are measured; the amplitude of the scattered light impulse is
directly related to the particle diameter. The T-aperture and simultaneous signal length
measurements eliminate border zone error, which is characterized by the partial illumination of
particles at the border of the measurement range.

1.2 Method Requirements

The method requirements for the T640x were published in the Federal Register in Volume 81, page
45285 on July 13, 2016, as part of the FEM designation. These requirements were published as:
"“Teledyne Advanced Pollution Instrumentation Model T640 PM mass monitor with 640X option,”
continuous ambient particulate monitor operated at a volumetric flow rate of 16.67 Lpm equipped with
the louvered PM10 inlet specified in 40 CFR 50 Appendix L, Figs. L-2 thru L—19, TAPI aerosol sample
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conditioner (P/N: 081040000), configured for operation with firmware version 1.0.2.126 or later, in
accordance with the Teledyne Model T640 Operations Manual.

Additional requirements of operating the method may not be explicitly included as part of the
method designation; however, they would apply for consistency with standard monitoring practices
and use of the data for comparison with the National Ambient Air Quality Standards (NAAQS). For
example, the sample volume for the method is reported in actual conditions (local conditions; LC) for
PMzsand in Standard Temperature and Pressure (STP) for PM1o. Each of these quantities (i.e., LC and
STP) is calculated using the instrument’s ambient temperature and barometric sensor data.

2. Definitions

PMzs is particulate matter with an aerodynamic diameter less than or equal to 2.5 pm. PMuo is
particulate matter with an aerodynamic diameter less than or equal to 10 pm. PM1o-2:5 is coarse
particulate matter with aerodynamic diameter in the range of 2.5-10 um. Technical terms in this SOP
are defined as they are introduced, and important definitions are provided in Table 1.

Table 1. Terms and definitions.

The degree of agreement between an observed value and an accepted reference
Accuracy value; includes a combination of random error (precision) and systematic error
(bias) components due to sampling and analytical operations.

Actual The actual ambient temperature and pressure of a gas at the time its volume (or
conditions  volumetric flow rate) is measured.

The systematic or persistent distortion of a measurement process that causes

Bias . . .
errors in one direction.

Calibration  The act of adjusting an instrument after comparison with a standard.

Chain-of- The unbroken trail of accountability that verifies the physical security of
custody environmental samples and documented information.

Coefficient A standardized measure of dispersion of a probability distribution or frequency
of variation distribution; defined as the ratio of the standard deviation to the mean.

The vertically oriented tube that connects the PM; s sampler inlet to sampler
components inside the sampler case. To check the sample flow rate, the sampler
inlet is removed from the downtube and a flow rate standard is connected in its
place.

Downtube
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A tight-fitting connecting device, with an isolating valve, that is inserted in place
of the PMzs sampler inlet on the upper end of a sampler's downtube and used to

Zldoz::)ter connect a flow rate calibration or audit device to check the sample flow rate. In
some cases, the device may also be used for leak checks. Sometimes referred to
as the flow shut-off valve.

Flow A Natio.ngl Institute of Standards and Technology (NIST)-tracgabIe flow

calibration determining appératus (also called a flgw rate sta.mdard) that.ls attached to th.e

device flow adapter device and used to assist in measuring and setting the volumetric

flow rate of air into the sampler.

An inertial particle-size separator. A PM; s reference method sampler uses a
Impactor specially shaped inlet followed by an impactor that allows only PM of well-
defined size ranges to penetrate to the filter collection portion of the collector.

Leak check A test to determine if any post-inlet air is passing through the instrument.

When the data stream from the monitor is disabled from logging to the data
Off scan system. This process is typically conducted during periods of maintenance,
verifications, or calibrations.

One type of flow rate calibration or check device (transfer standard), based on an
Orifice flow established relationship between flow rate and pressure drop across the orifice
rate check  plate. Orifice flow rate check devices generally make the needed temperature and
device pressure corrections for the user. The orifice flow rate check device most
commonly used on PM;s samplers may also be called a venturi.

A measure of mutual agreement among individual measurements of the same

Precision property, usually under prescribed similar conditions, expressed as standard
deviation.
A The act of checking or verifying an instrument against a standard; it does not
Verification . . .
involve adjustment of the instrument.
A way to check for leaks that does not involve pulling a vacuum on the
Zero Test

system.

3. Health and Safety Warnings

To avoid damage to the monitor, ensure that the AC power voltage matches the voltage indicated on
the monitor’'s model/specifications label located on the rear panel before plugging the T640x into
line power. High voltages are present inside the instrument. Ensure that the power cord being used
is capable of carrying the power rating of the instrument (see the rear panel label). Note:

e The power connection must have a functioning ground connection.
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¢ Do not defeat the ground wire on the power plug.
e Turn off instrument power before disconnecting or connecting electrical subassembilies.

e Do not operate the monitor without its cover.

Some repair and troubleshooting operations need to be carried out with the monitor open and
running. Use common sense when working with a running monitor. Exercise caution to avoid
electrical shocks and electrostatic or mechanical damage to the monitor. Do not drop tools into the
monitor or leave them behind after your procedures. Do not short or touch electric connections with
metallic tools while operating inside the monitor. For monitors installed in small shelters, beware of
external elements (e.g., weather conditions) when performing maintenance exposing the monitor.

4. Interferences

There are no known interferences to the collection of PMzs and PM1o using this method; however,
surface roughness and other variables do affect sizing algorithms in all light scattering instruments.
Since the PM concentration output is based on a calculation using the last 10 min of data, the
operator should wait a minimum of 10 min after reassembly of the instrument before turning the
data system to “On Scan.”

5. Equipment and Supplies

5.1 For Installation

Installation requires hand tools (flat blade screw driver, and adjustable wrench) and silicone sealant.
Most shelters have the necessary roof perforation needed. If not, it may be necessary to work with
the shelter manufacturer on the appropriate method for making the perforation. Most of the routine
equipment and supplies listed in Section 5.2 will be needed for the initial installation to ensure the
instrument is operating properly.

5.2  For Routine Operations
The following equipment, supplies, and expendables are required for sensor checks, adjustments,
and operation:

e High-efficiency particulate air (HEPA) filters (x2) configured with an adapter to connect to the
downtube for Zero Testing.
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e Auditing device (NIST-traceable pressure and temperature standard and flow standard) used
for pressure, temperature, and flow verifications and calibrations. The auditing device is
required to have been certified within the last 12 months.

e SpanDust™ used for verifying the photomultiplier tube (PMT)

e O-ring grease packets or tube of vacuum grease.

e Canned air for electronic use (e.g., DustOff™, BlowOff™ electronics dusters)
e Lint-free washable microfiber rags or lint-free disposable wipes

¢ Distilled water in a spray bottle

e Mild detergent

e Swagelok® Cap for 4" tubing

e Allen wrench

e Philips screwdriver

¢ C(Cleaning brushes

e Cotton-tipped applicators

e Pull rope assembly (used for pulling cleaning rags or a tube brush through the inlet tube)
e Disposable Filter Units (DFUs)

e USB flash memory drive (for firmware updates [when necessary] and manual data
downloads)

6. Procedures

6.1 Operation

Sampling begins upon startup. Allow a minimum of a 10-min warming period for reliable readings.
Doing so allows the temperature of the LED to stabilize.

6.2 Maintenance and Service

6.2.1  Maintenance Schedule

As a part of routine system management, preventive maintenance includes inspections, cleaning,
verifications, and calibrations. Table 2 provides a list of actions and their frequencies. Section 5.2 of
the instrument manual describes the procedures.
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Table 2. T640x maintenance and quality control (QC) check schedule.

Maintenance or Check Action

Check pump performance

Check for leaks with zero filter

Clean inlet

Clean PM1o well

Check/adjust PMT with SpanDust™
1.28 (measured peak, limit value
displayed on bottle + 0.5)

Ambient pressure

Ambient temperature

Total flow: 16.67 Ipm

Sample flow: 5.0 Ipm

Bypass flow: 11.67 Ipm

Inspect and clean optical chamber
and relative humidity/temperature
(RH/T) sensors

Change DFU for 5.0-Ipm sample
flow and 11.67-Ipm bypass flow (if
installed)

Inspect inner and outer sample

PWM' value < 80%
PID" value < 85%

Acceptance criterion is 0.0-0.3
Hg/m?
Action level is 0.1-0.3 pg/m?

NA
NA

Stated value on SpanDust™
bottle + 0.5 (e.g., 11.3 with a
tolerance of 10.8-11.8)

+ 10 mmHg
+2°C

Flow rate verifications

+ 5% of standard compared to
current reading on T640x.
(e.g., 15.87-17.54 Ipm if T640x
reads 16.7).

+ 5% of standard compared
to current reading on T640x;
(e.g., 4.75-5.25 Ipm if T640x
reads 5.00).

+ 5% of standard compared to

reading on T640x; (e.g., 11.12-
12.29 Ipm if T640x reads 11.7).

NA

NA

NA

" Pulse width modulation (PWM); proportional, integral, differential (PID) loop

Tolerance Frequency

Monthly

Monthly

Quarterly
Monthly

Monthly at + 0.5. Avoid over
performing this procedure. If
problems persist, wait 10 min
and retry.

Monthly
Monthly

Monthly

Monthly

As needed if total or sample
flow does not meet the
criterion. Use same tolerance
as total and sample flow.

Every six months or as needed
(e.g., high dust load).

Annually or when pump PWM
value approaches 80%.

Monthly or as needed.
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6.3 Maintenance Procedures

This section outlines cleaning and maintenance information for the inlets and filters. Always allow at
least 10 min of operation after a procedure to ensure reliable operation.

6.3.1  Cleaning the T640x Inlet

When cleaning the T640x inlet (shown in Figure 1), ensure data are "Off Scan.”

1. Power off the pumps from the Setup>Vars>Pump Control menu. Pump choices are auto, off,
and cleaning cycle. Press ‘edit’ and then ‘off' to turn off the pumps.

2. Remove the sampling inlet from the downtube.

3. Place flow audit adapter or HEPA filter on downtube to minimize dust entering the monitor.

4. Disassemble the sampling inlet (four screws on the underside of inlet base plate).

5. Carefully and thoroughly remove any dust from inside the inlet.

6. Remove any insects or other debris from the filtering screen.

7. Clean all the components using water and a mild detergent, if necessary.

8. Dry all components thoroughly with a clean cloth and blow canned air through the nozzles.

9. Check and, if needed, replace the O-rings located on the outside and the inside of the base
plate and grease them with vacuum grease.

10. Re-assemble the sampling inlet, sliding the baseplate back into the base of the inlet body,

making sure to line it up with the screw holes. The screws should be put back in to hand-
tight pressure.

11. Reconnect the sampling line.

12. Power up the pumps from the Setup>Vars>Pump Control menu. Press ‘edit’ and then ‘auto’
to turn the pumps back on. Allow 10 min for the system to return to reliable operation.
Ensure the data acquisition system is reengaged.

This procedure should be repeated per the schedule outlined in Table 2.



SOP for Teledyne Model 640x; STI-8184
July 31, 2024

Version 1

Page 11 of 50

Figure 1. PMyo inlet.

6.3.2 Cleaning the PM1o Well

For this procedure, ensure data are “"Off Scan.”

1. Power off the pumps from the Setup>Vars>Pump Control menu. Pump choices are auto, off,
and cleaning cycle. Press ‘edit’ and then ‘off’ to turn off the pumps.

Remove the sampling inlet from the downtube.
Unscrew the top of sampling inlet from the base of the inlet to expose the PM1o well.

Using a moist, lint-free towel or wipe, clean the inside base of the PM1o well.

ok~ wonN

Using cotton-tipped applicator (or similar), saturate the tip of the applicator with deionized
water and clean out each of the three nozzles in the PM1o well.

6. Carefully inspect and remove any insects or spider webs. If there is a spider web present,
make note of it on the “Monthly QC and Maintenance Checklist” sheet.

7. If needed, dry all components thoroughly with a clean cloth.
8. Blow canned air through the three nozzles.

9. Inspect and clean, as necessary, the bottom connection of the downtube with a lint-free
towel or wipe.

10. Inspect and clean the water collector if any debris or water are present.

11. Check and, if needed, replace the O-rings located on the outside and the inside of the base
plate, and grease them with vacuum grease.
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12. Carefully re-assemble the top and base of the sampling inlet, but do not overtighten them.

13. Reconnect the sampling line.

14. Power up the pumps from the Setup>Vars>Pump Control menu. Press ‘edit’ and then ‘auto’

to turn the pumps back on. Allow 10 min for the system to return to reliable operation.
Ensure the data acquisition system is reengaged.

This procedure should be repeated per the schedule outlined in Table 2.

6.3.3

Changing the Disposable Filter Units (DFUs)

There are two DFUs on the T640x, one internal filter for the 5.0-lpm pump and one external filter for
the 11.67-lpm pump. If changing one filter, it is recommended that the other filter also be changed.
For this procedure, ensure data are “Off Scan.”

Internal Pump Filter:

1.

2
3.
4

Power off the internal pump from the control menu: Setup>Vars>Pump>Edit>Off>Done.
Remove screws at sides of front panel, if installed.
Pull open the instrument’s front panel using the front panel finger grips (Figure 3).

Write “New” and today’s date on the filter with a sharpie (recommended).

Figure 2. Disposable filter unit.
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front panel finger grips

Figure 3. Opening the front panel.

5. Noting its orientation, remove the old DFU by detaching it from the pneumatic quick-
connect fittings, and replace it with a new DFU in the same orientation (Figure 4).

Figure 4. Internal DFU.

6. Power on the internal pump from the control menu: Setup>Vars>Pump>Edit>Auto>Done.
7. Review the internal pump flow in the Dashboard (>Main Menu>Home>Dashboard) or home
screen to ensure the 5.00-Ipm flow is reading as expected.
External Pump Filter:
8. Unplug or turn off electrical switch, if available, to the external pump (operates at 11.67 lpm).
9. Write "New"” and today's date on the filter with a sharpie (recommended).

10. Noting its orientation at the back of instrument, detach the filter from the quick-connect
fittings and replace it with new filter (Figure 5).
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11. Ensure the filter is seated snugly with no gaps.
12. Plug the bypass pump electrical cord back in or otherwise turn on the pump.

13. Review the internal pump flow in the Dashboard (>Main Menu > Home >Dashboard) or
home screen to ensure the 11.67-Ipm flow is reading as expected.

14. Allow 10 min for the system to return to reliable operation. Ensure the data acquisition
system is reengaged.

: Top of DFU

Figure 5. External DFU.

6.34  Checking Pump Performance

There are two pumps associated with the T640x. One pump is internal (operating at 5.0 Ipm). The
second pump is external (operating at 11.67 lpm). The 5.00-Ilpm pump must maintain proper flow for
measurement accuracy; the combined flow of the internal and external pumps (i.e., 16.67 lpm)
ensures that the PM1o inlet is operating at its designed flow for a PM1o cut-point. Check performance
levels in the Dashboard (If these parameters are not found in the Dashboard, configure the
Dashboard to add them; see Section 3.1.9 of the T640 User Manual).

*  Pump PWM should be running between 35% and 80%.
* Valve PWM should be running between 35% and 85%.
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If the performance levels are out of range, refer to Table 3 in Section 6.6 for troubleshooting
guidance.

6.3.5 Checking the Flows

Check the Sample Flow levels in the Dashboard. If not found in the Dashboard, add it through the
Dashboard configuration page; see Section 3.1.9 of the T640 User Manual. If out of range (outside of
16.67 + 0.83 Ipm for total flow and 5.00 + 0.25 Ipm for sample flow), refer to Table 3 in Section 6.6
for troubleshooting guidance.

For the T640x, also check the Bypass Flow levels in the Dashboard. (If not found in the Dashboard,
add it through the Dashboard configuration page; see Section 3.1.9 of the T640 User Manual). If out
of range (outside of 11.67 + 0.58 lpm), refer to Table 3 in Section 6.6 for troubleshooting guidance.

6.3.6  Cleaning the Optical Chamber and the RH/T Sensor

The optical chamber and sample lines connecting to the chamber should be
cleaned at least every 6 months, and more often if issues are suspected;
however, cleaning can be a somewhat tedious procedure, especially for
installations in small shelters located outside. Before starting, carefully
consider and plan for an appropriate amount of time to perform this
procedure, including disassembly and reassembly, as well as all associated
verifications and calibrations. For outdoor shelters, additionally consider if
any precipitation or extreme weather is forecasted. Up to 4 hr may be
necessary to fully complete the procedure for outside installations; up to 2
hr may be required for indoor installations when using a slip coupler. It is
highly recommended to take a few photos with a smart phone or similar
device prior to disconnecting any of the sample lines inside the monitor.

For this procedure, ensure data are "Off Scan.”
1. Power down the monitor and unplug it.
Power down the bypass pump.

2
3. Disconnect the ASC power line from the back of the instrument.
4

Disconnect the bypass flow line from top of ASC using a 9/16"
wrench (Figure 6).

5. Adjust the slip coupler and move the monitor to the side so that Figure 6. Bypass
there is enough room for ASC to be removed (see procedure 6.4.2). connection to top

6. Remove and clean both the extension tube and upper inlet tube that of ASC.

sit directly above the ASC (Figure 24 in Section 9).
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Remove the ASC by carefully lifting up the monitor chassis.

Remove and clean the aluminum adapter (Figure 22 in Section 9) that fits over the black inlet
nozzle. Check the O-ring that sits on the adapter for cracks or breaks; clean and/or replace as
necessary.

Remove and clean the black inlet nozzle (Figure 21 in Section 9) sample tube that fits on top
of the optical cell.

Unscrew the monitor lid (it may have four screws, two on each side) and lift the lid off of the
monitor chassis.

Take photos of the sample line connections with a smart phone or similar device. Then
disconnect the sample lines leading to the components on the ASC support.

Remove the ASC support, which straddles the sensors. Four screws secure that support to the
floor of the instrument, two on each footing (Figure 7). Note: it is possible to clean the optics
without removing the ASC support; however, removing the ASC support will allow more
room to access the tubing lines and optical chamber.

Optical Sensor ASC support

two screws per footing

Figure 7. Maintenance of the optical chamber and RH/T sensor access.

13. Locate the optical cell, the cup at the bottom of optics chamber and its tubing, and the RH/T

sensor (Figure 8).
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optical cell

RH/T sensor

hex screws

tubing between cup
at optics chamber
bottom and RH/T sensor

RH/T sensor tubing

Figure 8. Maintenance: location of the optics chamber and RH/T sensor.

14. Remove the optical cell from the optics chamber and remove the cup, including its tubing,
from the bottom of the optics chamber; detach the RH/T sensor tubing from the DFU filter
(Figure 9). It is very important that all components are disassembled before blowing air into

the chamber.



SOP for Teledyne Model 640x; STI-8184

Pull T-cell from optics chamber. Fit is very
Remove hex screws. tight, but DO NOT USE TOOL TO PRY OUT.

Remove collection
cup from bottom of
optics chamber.

Detach RH/T sensor
tubing from DFU filter.

Figure 9. Maintenance: Optical Chamber Disassembly
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15. Clean the optics chamber interior surfaces, including the windows, with a lint-free cloth

(Figure 10).

Optics Chamber Interior

windows

Figure 10. Maintenance: optics chamber windows.
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16. Use canned air made specifically for dusting electronics to blow dust and other debris from
the optics chamber, the cup, the bottom of the optics chamber, and the tubing (Figure 11).

Figure 11. Maintenance: final dusting.

17. Reassemble the optics chamber components; reinsert the cup on the bottom of the optics
chamber; reconnect the tubing from the cup in the bottom of the chamber to the RH/T
sensor and from the RH/T sensor to the DFU filter, reinstall the ASC support, re-connect all
power and flow lines, and move monitor back in line so that the slip coupler can be
reconnected.

18. Close the instrument and power on both the bypass pump and monitor.
19. Perform a Zero Test (Section 6.4.1).

20. Perform a PMT sensor check with SpanDust™ (Section 6.4.5).

6.3.7 Inspecting the Sample Tubes

Look inside the sample tubes for debris or dust on the walls. If needed, push a rag or a paper towel
through the tubes; then use canned air made specifically for electronics to blow through the line for
a final cleaning. However, do not completely block a sample tube still under vacuum; the sample
flows should never be blocked while the unit is still operating.

0.4 Instrument Verifications

Five basic verification checks are listed below. All verifications should be conducted first before any
calibrations, and then calibrations can be conducted when necessary (Section 6.5). Verifications are
conducted before calibrations; it is necessary to document the "as-found” conditions of the
instrument. Three of the verifications can be calibrated, if necessary. There is no adjustment for either
the Zero Test or ambient temperature and as such failure of one or both of these checks results in
the need to troubleshoot rather than adjust a setting. Also, the procedure calls to verify the total flow
(16.67 lpm) and then the sample flow (5.0 Ipm); however, the total flow cannot by itself be calibrated.
If the total flow does not meet its required tolerance, the sample flow and bypass flow can be
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calibrated, if necessary. The five checks should always be performed in the specific order listed
below:

1. Zero Test;

2. Pressure sensor verification;

3. Temperature sensor verification;

4. Flow sensor verifications;

5. PMT verification using SpanDust™.
Once all verifications are completed, calibrations may be conducted (Section 6.5) for pressure, flow,
and the PMT. For the Pressure Cal and the two Flow Cal menus, note that the “Measured” parameter

provides the value measured by the T640x and the “Actual” parameter is the value that is to be input
from the reading measured by the external auditing device.

6.4.1 Zero Test

The internal components of the T640x are not meant to be under strict vacuum (i.e., what would
normally be done in a leak test). To avoid damaging internal components, the inlet should never be
capped (air tight) while the instrument pumps are running.

The Zero Test is a way to check for leaks that do not involve pulling a vacuum on the system. Note:
no adjustment is made if the Zero Test is not acceptable; instead, troubleshoot the instrument until
the issue is resolved. For this procedure, ensure data are “Off Scan.”

1. Remove the inlet and fit a HEPA filter to the sample port. Ensure the tubing is not kinked.

2. Observe the PM values on the front panel display. Press either "Home" or the n key.

3. Within approximately 10 min, the PM values should be at zero (0.0) for each PM metric. If the
data reach 0.0, accept the zero test and move to Step 5. If the data are in the range of 0.1-0.3,
accept the data and troubleshoot. If after 10 min the data are still at 0.4 or greater, identify
the data as suspect on the Monthly QC and Maintenance Sheet and troubleshoot. If the PM
values are not reading zero, then one of two issues is likely:

a. There may be a leak in the system above the optical sensor (i.e., from the optical
sensor nozzle up to where the HEPA filter was fitted). Troubleshoot by checking each
connection between the monitor and HEPA filter and ensuring there is a good seal.

b. Itis possible the HEPA filter is either bad or leaking. It is recommended having a
second filter handy to check.

4. If values do not reach zero (0.0) within 10 min of an adjustment, troubleshoot and repeat the
steps above.



SOP for Teledyne Model 640x; STI-8184
July 31, 2024

Version 1

Page 21 of 50

5. Once PM values reach zero (0.0) for each PM metric, disconnect the HEPA filter.

6. Record all actions and readings on the Monthly QC and Maintenance Sheet.

6.4.2 Alternative Procedure for Walk-In Shelters

For walk-in shelter installations, a single operator will be challenged to review the data on the front
panel of the monitor while performing QC verifications and calibrations on a roof. Two operators
could be used; however, in most cases having two people on hand is not practical. To enable
verifications and calibrations for walk-in shelter applications, Teledyne has a slip coupler that can be
employed to allow audit devices and SpanDust™ to be used from inside the shelter. The procedure
for use of the slip coupler does not apply to Zero Tests; the HEPA filter should be installed on the
downtube where the PM1o inlet is normally connected to the downtube on the roof. Also, the
procedure for verifying ambient temperature needs to be conducted on the roof so that the routine
ambient temperature probe can be checked. For all other verifications and calibrations, where
necessary, the following applies to using a slip coupler. For this procedure, ensure data are "Off
Scan.”

1. Holding the downtube above the slip coupler with one hand, lift the slip coupler with your
other hand from its current position to a height just high enough so that the slip coupler is
no longer touching the aluminum downtube below (Figure 12). The downtube above the slip
coupler should be held in a consistent vertical position so that the seal between the
downtube and roof flange is maintained.

Figure 12. Slip coupler in the normal position and lifted vertically.
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2. Carefully move the T640x monitor chassis and ASC away from the downtube so that there is

6.4.3

enough clearance for the audit device to be attached. Doing so requires moving the base of
the monitor (Figure 13).

Figure 13. Slip coupler moved to the side to allow monitor use with audit devices.

Detach the ambient temperature probe on the back of the monitor and temporarily attach
the short cable temperature probe so that the temperature inside the shelter is being used
for flow calculations.

Perform remaining verifications and, where applicable, calibrations. A verification of the short
temperature probe is also recommended.

With all verifications and calibrations complete, detach the short cable temperature probe
and re-attach the ambient temperature probe from the roof.

Align the T640x monitor chassis so that the ASC is directly below the slip coupler.

Holding the downtube above the slip coupler with one hand, re-engage the slip coupler back
to its original position with your other hand. The downtube above the slip coupler should be
held in a consistent vertical position so that the seal between the downtube and roof flange
is maintained.

Pressure Verification

The pressure measurement of the T640x is for the ambient pressure at which the instrument is
operated. No direct pneumatic connection to the instrument needs to be made to perform this
check, and the data are not affected. To change pressure units to mmHg, go to Setup>Vars>Pressure
Units>mmHg.
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1. With the Pressure Standard operating and measuring the ambient pressure in the same room
as the T640x monitor, navigate to the Pressure Cal menu: >Calibration>Pressure Cal.
Alternatively, pressure can be obtained through the Dashboard on the main screen.

2. Compare the "Measured Pressure” on this screen the the Audit Pressure Standard (Figure 14).

3. If the two values differ by more than 10 mmHg, note this fact on the Monthly QC and
Maintenance Sheet and continue with the remaining verifications.

Pressure Cal —H 'i 11 4 AM

Sample Flow Cal To adjiest the Actual Pressure setting, ciick the value.
Press the Calbrate button to proceed.

Pressure Cal

PMT Adjust Measured Pressure: 759.7 mmHg

ﬂ ‘ > Home > Calibration Mode: SAMPLE

Figure 14. Pressure calibration screen.

6.4.4 Ambient Temperature Verification

The ambient temperature probe can be verified; however, there is no available way to calibrate this
sensor. Temperature probes that do not meet the expected tolerance of + 2°C from a temperature
standard should be inspected and cleaned. Cleaning the gill screen may also help to ensure air can
pass freely to the probe. A spare temperature probe should be available in case the verification
continues to fail the acceptable tolerance. The following procedure applies to a temperature
verification:

Temperature verifications can be conducted either with the instrument in normal operation or with
the unit operating. However, ensure data are “Off Scan.”

1. Obtain the ambient temperature reading from the front panel of the T640x monitor.
Alternatively, ambient temperature can be obtained through the Dashboard on the main
screen.

2. Hold the temperature probe of the audit device in close proximity to the gill screen holding
the ambient temperature probe of the T640x. If the monitor is in direct sun, ensure the audit
probe is held behind the gill screen relative to the sun so that the gill screen casts a shadow
on the audit device temperature probe.

3. Wait at least 1 min for the audit device temperature to stabilize.
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4. Record the audit device ambient temperature and the T640x ambient temperature on the
Monthly QC and Maintenance Sheet.

5. Compare audit temperature to the T640x ambient temperature; if the measurements are off
by more than + 2°C, troubleshoot and repeat.

6. If verification cannot meet tolerance, replace the temperature probe.

6.4.5 Total Flow (16.67 Ipm) and Sample Flow (5.0 Ipm) Verification

Flow verifications for total flow (16.7 Ipm) and sample flow (5.0 [pm) can be conducted with the
instrument operating normally so long as the data are “Off Scan.” Although this section pertains to
verifications, the information available in the flow calibration screen may also be useful for
verifications. The flow calibration screens can be accessed at: >Calibration>Sample Flow Cal and
>Calibration>Bypass Flow Cal. The flow calibrations procedures are detailed in Section 6.5.2.

The flow verifications and calibrations should be conducted in the following order:

1. Verify the total flow: 16.67 Ipm.

2. Verify the sample flow: 5.00 Ipm. If both the total and sample flow meet acceptable
tolerances, the flow verifications and calibrations are complete.

3. If the sample flow is not acceptable, calibrate the sample flow and repeat verification of the
total flow.

4. If the total flow is not acceptable and the sample flow is acceptable, calibrate the bypass
flow.

5. Repeat verification of the total flow.

Verification of Total Flow (16.67 Ipm). For the verification procedure, ensure data are “Off Scan.”

1. Set up a NIST-traceable Flow Standard transfer device with the appropriate inlet for the flow
to be calibrated.

2. Remove the inlet from Upper Inlet Tube.

3. Connect the Flow Standard to the top of the Upper Inlet Tube. Ensure the tubing connecting
the inlet to the Flow Standard is not kinked.

4. With the T640x running, go to the main menu or Dashboard to review the total flow (i.e.,
16.67 lpm).

5. Wait at least 1 min for the flow to restabilize.

6. Record the audit device flow and T640x total flow on the Monthly QC and Maintenance
Sheet.
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Compare the T640x total flow with the audit device flow and determine if the values differ by
more than 5%, (e.g., beyond the range 15.87-17.54 Ipm for the total flow if the sampler reads
16.67 lpm). Make any relevant notes on the Monthly QC and Maintenance Sheet.

Move on to verifying the sample flow (i.e., 5.0 Ipm).

Verification of Sample Flow (5.0 Ipm). For this procedure, ensure data are “Off Scan.”

1.

10.
11.

Disconnect the auxiliary flow line from the side of the ASC. Ensure the auxiliary flow line is
not blocked and only pulling in ambient air.

Cap the Swagelok fitting on the side of the ASC.

Set up a NIST-traceable flow standard transfer device with the appropriate inlet for the flow
to be calibrated. Ensure the audit device is appropriately sized for 5.0-Ipm flow.

Remove the inlet from the Upper Inlet Tube.

Connect the Flow Standard to the top of the Upper Inlet Tube. Ensure the tubing connecting
the inlet to the Flow Standard is not kinked.

With the T640x running, go to the Calibration>Sample Flow Cal menu. Alternatively, the
sample flow can be viewed from the Dashboard.

Wait at least 1 min for the flow to restabilize.

Compare the “Measured Flow" on this screen with the Flow Standard (Figure 15) and
determine if these values differ by more than 5% (e.g., beyond the range of 4.75-5.25 lpm for
sample flow if the sampler reads 5.00 Ipm).

If the sample flow meets the expected tolerance, the sample flow verification is complete. If
the sample flow is outside of the acceptable tolerance, it is necessary to perform a sample
flow calibration (Section 6.5.2).

Record actions and readings on the Monthly QC and Maintenance Sheet.

Disconnect the Swagelok cap from the ASC. Re-attach the bypass line, unless a bypass flow

calibration is to be performed (descibed below).
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Flow 5 Calibration | 1 3:24:34 PM

Sample Flow Cal To adjust the Actual Flow sething, ciick the value.
Precs the Calibrate button to proceed,

Pressure Cal
Measured Flow: 4.80 LPM

. (D

PMT Adjust

@ ( > Home > Calibration Mode: SAMPLE »

Figure 15. Sample flow calibration screen.

Bypass flow verification and calibration (11.67 Ipm), if necessary. A calibration of the bypass
flow is only necessary if the total flow verification does not meet the acceptable tolerance and the
sample flow has already been verified and/or calibrated. For this procedure, ensure data are “"Off
Scan.”

1. Connect the NIST-traceable flow transfer standard device to the bypass line that was
disconnected in the sample flow verification procedure outlined above. Ensure the fitting(s)
connecting flow transfer standard and bypass line are secure and not leaking.

2. With the T640x running, go to the flow calibration menu: >Calibration>Bypass Flow Cal.
3. Wait a least 1 min for the flow to stabilize.

4. Compare the “Measured Flow" on this screen with the Flow Transfer Standard and determine
whether the values differ by more than 5% (e.g., beyond the range of 11.12-12.29 Ipm for
bypass flow if sampler reads 11.67 lpm). However, values approaching the 5% tolerance level
should also prompt a calibration since the bypass flow check is expected to be performed
infrequently.

5. Record readings on the Monthly QC and Maintenance Sheet. If the bypass flow meets the
expected tolerance, then proceed to Step 8. If sample flow is beyond the acceptable
tolerance, or close to not meeting the tolerance, then proceed with Step 6 to perform a
calibration of the bypass flow.

6. To calibrate the bypass flow, press the value button in the Actual Flow field, enter the value
measured by the Flow Standard, and press the “Calibrate” button on this screen. The Bypass
Measured Flow value should change to closely match the Actual Flow within a few seconds.
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7. Record readings on the Monthly QC and Maintenance Sheet.
8. Re-attach the bypass line to the ASC.

6.4.6 PMT Verification

The Particle Sensor PMT verification uses SpanDust™, a monodisperse dust with a specific refractive
index. All T640 instrument PMTs have a very specific response to this SpanDust, which allows for the
sensor to be checked and adjusted in the field for drift caused by contamination of the optics. This
process is not a calibration of the optical sensor based on the mass of dust being used but simply a
mechanism to check and adjust the PMT response to particles with a specific and known refractive
index.

Note: Although the PMT verification is a useful check to verify whether the performance of the
monitor spectrometer is as expected, multiple checks of the PMT or individual verifications that lead
to too must SpanDust™ entering the monitor optics can itself lead to poor performance of the
spectrometer and/or RH sensor. Ensure that a minimum amount of SpanDust™ enters the sample
tube during a verification and that repeats of verifications are kept to a minimum.

For a step-by-step demonstration of the PMT adjustment, use the QR code below to view a video by
Teledyne API. Also available at:

For this procedure, ensure data are “"Off Scan.”

1. Navigate to the PMT Adjust screen: >Home>Calibration>PMT Adjust. PMT
2. Press the Start button on this screen to suspend normal data Adjustment
acquisition and start this adjustment process. Video

00
4. Prepare the SpanDust™ bottle by uncapping the “air intake” tubing on

the cap of the bottle. .E
O

5. Place the tube from the SpanDust™ bottle into the top of the Upper
Inlet Tube for the instrument.

3. Remove the T640x sample inlet.

6. Ensure that the silicone tube fits snugly inside the aluminum inlet tube; do not allow the
bottle to hang. Doing so could dislodge the silicone tube from the inlet tube.

7. Gently tap the SpanDust™ bottle to barely agitate the contents just enough to allow the dust
to be pulled into the sensor, and allow 30 sec for the Peak Channel reading in this screen to
respond (Figure 16).

8. Record the maximum Peak Channel, PMT Setting, and Peak Channel Counts on the Monthly
QC and Maintenance Sheet.


https://www.youtube.com/watch?v=pZYnXwYwtIs
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If the Peak Channel reading is acceptable (i.e., = 0.5 of the SpanDust™ value stated on
bottle), proceed to step 11.

10. If the Peak Channel is not acceptable, then retry one more time by pressing the Stop button,

6.5

PMT Adjust -] 2 9:39:41 AM
Sample Flow Cal

Bypass Flow Cal

Pressure Cal

PMT Adjust 30 -25-20-15-10 -5 0 5 10 15 20 25 30

Peak Channel: 11.1
PMT Setting: 1450 V

Peak Channel Counts: 240

ﬁ ( > Home > Calibration Mode: SAMPLE A

Figure 16. PMT adjust screen.

Instrument Calibrations

then the Start button on the T640x, then proceed with Step 7 above. If after two tries the
Peak Channel is still not acceptable, move to the instrument calibration procedures described
in Section 6.5.

Re-attach the sample inlet and press the Stop button to stop the adjustment process and
resume normal data acquisition.

Wait 10 min, review the data on the home screen, and then power the unit back “On Scan” in
the data system.

There are three checks of the monitor that can be calibrated. These calibrations are performed after
all verifications (see Section 6.4) are conducted. Calibrations only need to be performed for the
checks that do not meet their expected performance criteria. The checks that can be calibrated are
conducted in the following order, as necessary:

1.
2.
3.

Pressure sensor calibration;
Flow sensor calibration and reverification; and

PMT calibration using SpanDust™.
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6.5.1  Pressure Calibration

The pressure measurement of the T640x is for the ambient pressure at which the instrument is
operated. No direct pneumatic connection to the instrument needs to be made to perform this
calibration, and the data are not affected.

For this procedure, ensure data are “Off Scan.”

1. With the Pressure Standard operating and measuring the ambient pressure in the same room
as the T640x monitor, navigate to the Pressure Cal menu: >Calibration>Pressure Cal.

2. Compare the "“Measured Pressure” on this screen with the Audit Pressure Standard
(Figure 17).

3. If the two values differ by more than 10 mmHg, then press the value button in the “Actual
Pressure” field, enter the value measured by the Pressure Standard and press “enter.” Then
press the “Calibrate” button on the screen.

4. Record pressure readings on the Monthly QC and Maintenance Sheet.

The Measured Pressure value should change to closely match the Actual Pressure within a few
seconds.

Pressure Cal —] 17 11:29:24 AM

To adjust the Actual Pressure setting, click the value.
Press the Calibrate button to proceed.

Sample Flow Cal
Pressure Cal

PMT Adjust

Measured Pressure: 759.7 mmHg

. (D

Status: Success

-ﬁ ( >~ Home > Calibration Mode: SAMPLE

Figure 17. Pressure calibration screen. IMPORTANT: Perform this calibration prior to any flow
calibration.

6.5.2 Sample Flow (5.00 lpm) and Bypass Flow (11.67 Ipm) Calibrations

Flow calibrations are conducted on the sample flow (5.00 Ilpm) and the bypass flow (11.67 lpm) by
going to the sample flow calibration menu at: >Calibration>Sample Flow Cal. Note: a calibration of
total flow (16.67 Ipm) is not available; instead, the sample and bypass flows are individually
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calibrated. Once a flow is calibrated, it should be reverified to be within a tolerance of + 2%. Total
flow verification of a monitor is acceptable if within + 4% of the reading of an audit device.

Flow calibrations should be conducted after all verifications and a pressure calibration have been
performed, as necessary. Conduct the flow calibrations and reverification of the flows in the following

order:
1.
2.

Calibrate the sample flow (5.00 Ipm);

Conduct sample flow (5.00 Ipm) verification to ensure the monitor reading is within 2% of the
audit device reading. Note: a 2% tolerance is to ensure that the flow sensor of the instrument
is reading reasonably close to expected immediately following a flow calibration;

Calibrate bypass flow (11.67 Ipm);

Conduct bypass flow verification to ensure the monitor reading is within 2% of the audit
device reading;

Perform verification of total flow (16.67 Ipm); see Section 6.4.5.

Calibration of Sample Flow (5.00 Ipm). For this procedure, ensure data are “Off Scan.”

1.

10.

Disconnect the auxiliary flow line from the side of the ASC. Ensure the auxiliary flow line is
not blocked and only pulling in ambient air.

Cap the Swagelok fitting at the side of the ASC.

Set up the NIST-traceable flow standard transfer device with the appropriate inlet for the
flow to be calibrated. Ensure the audit device is appropriately sized for 5.00-Ipm flow.

Remove the inlet from the Upper Inlet Tube.

Connect the Flow Standard to the top of the Upper Inlet Tube. Ensure the tubing connecting
the inlet to the Flow Standard is not kinked.

With the T640x running, go to the Calibration>Sample Flow Cal menu.
Wait at least 1 min for the flow to restabilize.

Compare the “Measured Flow" on this with to the Flow Standard (Figure 18) and determine
whether these values differ by more than 5%, (e.g., beyond the range of 4.75-5.25 Ipm for
sample flow if the sampler reads 5.00 Ipm).

Record XXX on the Monthly QC and Maintenance Sheet. If the sample flow meets the
expected tolerance, then proceed to step 13 as the sample flow calibration is finished. If the
sample flow is beyond the acceptable tolerance, continue with step 10 to perform a
calibration of the sample flow.

If the sample flow is off by more than 5%, press the Start button (doing so disables the
internal data logging) and then Actual Flow.
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11. Enter the value measured by the Flow Standard and press “Enter” and then press the
“Calibrate” button on this screen. The Measured Flow value should change to closely match
the Actual Flow within a few seconds.

12. Record all flow values on the Monthly QC and Maintenance Sheet.

13. Continue reading the flow standard and ensure the standard is within 2% of the measured
flow (i.e., 4.90-5.10 Ipm). Record readings on the Monthly QC and Maintenance Sheet.

14. Disconnect the Swagelok cap from the ASC. Re-attach the bypass line unless a bypass flow
calibration is to be performed; see below.

15. Press Stop on the sample flow calibration menu to end the sample flow calibration procedure
and return to normal operation.

Flow S Calibration -] 1 3:24:34 PM |

Sample Flow Cal To adjust the Actual Flow setbing, ciick the value.
Pracs the Calibrate button to proceed,

Pressure Cal
Measured Flow: 4.80 LPM

- (D

PMT Adjust

Mode: SAMPLE

Figure 18. Sample flow calibration screen.

Bypass flow calibration (11.67 Ipm), if necessary. A calibration of the bypass flow is only
necessary if the total flow verification does not meet the acceptable tolerance and the sample flow
has already been verified and/or calibrated. For this procedure, ensure data are “Off Scan.”

1. Connect the NIST-traceable flow transfer standard device to the Bypass line that was
disconnected in the sample flow verification procedure outlined above. Ensure the fitting(s)
connecting flow transfer standard and bypass line are secure and not leaking.

2. With the T640x running, go to the flow calibration menu: >Calibration>Bypass Flow Cal.

3. Wait a least 1 min for the flow to stabilize.
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4. Compare the "Measured Flow" on this screen with the Flow Transfer Standard (Figure 19) and
determine whether these values differ by more than 5% (e.g., beyond the range of 11.12-
12.29 Ipm for bypass flow if sampler the reads 11.67 Ipm). However, values approaching the
5% tolerance level should also prompt a calibration since the bypass flow check is expected
to be performed infrequently.

5. Record flow values on the Monthly QC and Maintenance Sheet. If the bypass flow meets the
expected tolerance, then proceed to Step 9. If sample flow is beyond the acceptable
tolerance or close to not meeting the tolerance, then proceed with Step 6 to perform a
calibration of the bypass flow.

6. If the bypass flow is off by more than 5%, press the Start button (doing so disables the
internal data logging) and then Actual Flow.

7. Enter the bypass value measured by the Flow Standard and press Enter, then press the
Calibrate button on this screen. The Measured Flow value should change to closely match the
Actual Flow within a few seconds.

8. Record flow values on the Monthly QC and Maintenance Sheet.

9. Continue reading the flow standard and ensure the standard is within 2% of the measured
flow (i.e,, 11.47-11.93 lpm). Record flow values on the Monthly QC and Maintenance Sheet.

10. Re-attach the bypass line to the ASC.

Flow 11 Calibration -] ‘i 7:08:01 PM

Sample Flow Cal Te adjust the Actual Flow seiting, click the value,
Press the Calibrate button to proceed.

Bypass Flow Cal

Measured Flow: 11.64 LFM

el

Status:

Pressure Cal

PMT Adjust

Mever Run

ﬁ < = Home > Calibration Mode: SAMPLE

Figure 19. Bypass Flow calibration screen.
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PMT Calibration

Once all verifications and any necessary calibrations to the pressure and flow systems are complete,
an adjustment of the Particle Sensor PMT may be performed using SpanDust™. A calibration of the
PMT is an adjustment in the field for drift caused by contamination of the optics. Note: Ensure that a
minimum amount of SpanDust™ enters the sample tube during an adjustment of the PMT and that
repeats of this calibration are kept to a minimum.

For a step-by-step demonstration of the PMT adjustment, use the QR code below to view a video by
Teledyne API. Also available at:

For this procedure, ensure data are “Off Scan.”

1.
2.

10.

11.

Navigate to the PMT Adjust screen: >Home>Calibration>PMT Adjust. PMT
Press the Start button on this screen to suspend normal data Adjustment
acquisition and start this adjustment process. Video
Remove the T640x sample inlet. eee

. ST [=] 5 %n ]

Prepare the SpanDust™ bottle by uncapping the “air intake” tubing on ﬁ
the cap of the bottle.

O g

Place the tube from the SpanDust™ bottle into the top of the Upper
Inlet Tube of the instrument.

Ensure that the silicone tube fits snugly inside the aluminum inlet tube and do not allow the
bottle to hang. Doing so could dislodge the silicone tube from the inlet tube.

Gently tap the SpanDust™ bottle to barely agitate the contents just enough to allow the dust
to be pulled into the sensor; allow 30 sec for the Peak Channel reading in this screen to
respond.

Record the maximum Peak Channel, PMT Setting, and Peak Channel Counts on the Monthly
QC and Maintenance Sheet.

If the Peak Channel reading is acceptable (i.e., + 0.5 of the SpanDust™ value stated on
bottle), then proceed to step 13.

If the Peak Channel is not acceptable, then retry one more time by pressing the Stop button,
then the Start button, and then proceed with step 7 above.

If after two tries the Peak Channel reading is not within + 0.5 of the SpanDust™ value stated
on bottle, then adjust the PMT Setting by pressing the Peak Adjust left (decrement) or right
(increment) buttons to center the Peak voltage (Figure 20). Each press of the button
corresponds to one volt.
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PMT Adjust ] 9:39:41 AM

Sample Flow Cal

Bypass Flow Cal
Pressure Cal

PMT Adjust 30 -25 -20 -15 -10 -5 0

5 10 15 20 25 30

Peak Channel: 11.1

PMT Setting: 1450 V

Peak Channel Counts: 240

> Home > Calibration Mode: SAMPLE

Figure 20. PMT adjust screen.

Allow 30 sec for the Peak Channel reading on this screen to respond. If the value is not + 0.5
of the SpanDust™ value stated on bottle, repeat the process. This procedure can take several
tries over a long period when conducted in a humid environment.

Once the Peak Channel reading is + 0.5 of the SpanDust™ value stated on bottle, record
readings on the Monthly QC and Maintenance Sheet.

Re-attach the sample inlet and press the Stop button to stop the adjustment process and
resume normal data acquisition.

Wait 10 min, review the data on the home screen of the T640x, and then bring the unit back
“On Scan” in the data system.

6.6  Troubleshooting and Service
This section provides guidance for resolving fault conditions and possible flow and calibration
problems.
1. To review Alerts, select >Alerts.
2. Document any alerts, including date and time, on the Monthly QC and Maintenance Sheet.
3. To clear alerts, select the following: >Alerts>Select>Clear Selected. Then select the home
button.
4. If alerts reappear, then there is something wrong that needs to be diagnosed.
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6.6.1  Fault Diagnoses

The alerts log may be useful for diagnosing faults. Table 3 lists some of the alerts that are triggered
by faults, their likely causes, and possible solutions.

Table 3. Alerts and recommendations.

Warning raised when Normal power cycle occurred? If not, check external power

System Reset

the system is reset

source.

Sample Flow The Sample Flow is Check pneumatic fittings.
High greater than 5.25 [pm  Re-calibrate flow.
Sample Flow The Sample Flow is less Check pneumatics. Check for blockages. Re-calibrate flow.
Low than 4.75 Ipm
Bypass Flow The Bypass Flow is Check pneumatic fittings.
High greater than 12.25 Ipm  Re-calibrate flow.
Bypass Flow The Bypass Flow is less  Check pneumatics.
Low than 11.08 lpm Check for blockages. Re-calibrate flow.
Check if the ASC is plugged in.
Sample RH The Sample RH is Check whether the ASC control LED is illuminated on the
High above the set point control board.
Check if water is in the sensor.
If the LED temperature
i Cycl :
Check LED is equal to the box ycle power
temperature, the LED Call Tech Support.
may be OFF
The PMT HV settingis ~ Check sensor with SpanDust™.
Check PMT out of range (800- Clean the optical chamber.
2200) Call Tech Support.
The Sample Flow Check pneumatics for leaks.
Sample Flow L . I
Slope OOR Calibration Slope is Rerun flow calibration.
Out of Range (OOR) Call Tech Support.
Check pneumatics for leaks.
BYPS Flow -(rZZTibBr?t)izsr? ;lzwe is Rerun :I)ow calibration
Slope OOR P ‘

Out of Range

Call Tech Support.
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Check Int Pump

Check Ext Pump

Sample Temp
Warning

Box Temp
Warning

AMB Press
Slope OOR

6.6.2

Check the internal
pump if the PWM is
> 80%

Check the external
pump and/or bypass
flow control valve if
valve PID > 85%

Sample Temperature
Warning (>60)

Box Temperature
Warning (>60)

Ambient Pressure
Calibration Slope is
Out of Range

Flow Problems

Check pneumatics for blockages.
Check pneumatics for leaks.
Check flow calibration.

Replace pump.

Check pneumatics for blockages.
Check pneumatics for leaks.
Check external pump.

Check flow calibration.

External pump or bypass flow control valve may need
replacing.

Check the ASC (is it latched ON?)
Ensure proper climate and ventilation for instrument.

Ensure proper climate and ventilation for instrument.

Check calibration (make sure units match calibration device).
Replace pressure sensor.
Call Tech Support.

If a flow auditing device indicates any problems with flow, check to ensure the following:

» All connections are seated tightly and evenly (no gaps);

» Theinlet is not clogged or blocked;

» The pumps are running and are within their PWM range (i.e., 35% - 80%);

» The DFUs appear reasonably clean and have been changed within the last 12 months;

« The flow audit device is operating properly (e.g., the unit has been appropriately charged).

After making any adjustments, run a flow calibration and recheck the flow rate. If problems persist,
contact Teledyne-API Technical Support for assistance.
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7. Data Management and Records Management Parameters

7.1 Data Management

Data collected by the T640x at the monitoring site will be stored on a data acquisition system (DAS).
The data can be remotely polled for upload into a centralized database. Ensure data backups are
conducted on a regular basis.

The in situ DAS will be a commercially available computer-based unit capable of retrieving digital
records from the station instruments via an Ethernet connection. It will store 1-minute averages from
the instruments. The instrument will store approximately 1 yr of data internally, and the data can be
retrieved at any time to fill in any missing data in the database due to transfer issues.

Table 4 lists the EPA's parameter, method, and unit codes for T640x and T640 data.

Table 4. Parameter, method, and unit codes.

Method Code | Method Code

Parar.neFer Parameter for T640 for T640x Units Unit
Description Code Code
at 5.00 [pm at 16.67 Ipm
PM2s 88101 236 238 Micrograms/cubic meter (LC) 105
PMjo - LC 85101 236 239 Micrograms/cubic meter (LC) 105
PM10-25 LC 86101 236 240 Micrograms/cubic meter (LC) 105
PM1o STP 81102 not available 239 Micrograms/cubic meter (25C) 001

7.2 Records Management

Field site visits will be stored in site log books documenting access to the monitoring sites and the
key activities performed. Details on routine QC and maintenance will be recorded on the Monthly QC
and Maintenance Sheet.

8.  Quality Control/Quality Assurance

The instrument will be operated in accordance with the manufacturer’'s recommendation. The
maintenance recommendations presented above, including the recommended verifications and
adjustments, will be followed. Alerts (diagnostic codes) issued by the instrument will be reviewed and
appropriate corrections will be initiated when indicated. The alerts will be retained as part of the
instrument data. Daily review of instrument output is made to ensure operability. Data
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reasonableness will also be assessed to ensure instrument output is consistent with expectations for
the instrument location, time of day, typical concentrations, and season.

9. Installation Instructions

9.1 Indoor/QOutdoor Installation

This section presents the various connections for setup and information about preparing the
instrument for operation. The T640x can be installed in an indoor or outdoor shelter with roof
penetration or in an outdoor enclosure. Section 9.2 provides step-by-step instructions for ASC
connections and installation. If the instrument is being installed in a shelter with roof penetration, see
Section 9.6 for installation instructions. If the instrument is being installed in an outdoor enclosure
installation, see Section 9.7 for installation instructions.

Ensure that the rack installation provides proper ventilation clearance (minimum of 2.5 cm from the
sides and top of the instrument and 10 cm from the back of the instrument) and inlet height (2 m
above ground level).

9.2 Aerosol Sample Conditioner (ASC) Connections and Installation

The ASC requires an inlet nozzle and an adapter for installation. The black inlet nozzle to the optical
sensor is specific to the instrument and not interchangeable with other T640x instruments. Note that
the final assembly differs slightly between the T640x ASC and the T640 ASC.

1. Insert the black inlet nozzle through the center of the support collar into the top of the
optical sensor, seating it tightly so that the nozzle's upper O-ring flange is flush with the
upper surface of the sensor body (Figure 21).
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Figure 21. ASC Setup: inlet nozzle.

2. Slide the aluminum adapter over the black inlet nozzle, ensuring its base is flush with the top
of the optical sensor (Figure 22).

Figure 22. ASC setup: aluminum adapter.

3. Attach the water collector to the inlet (Figure 23).



SOP for Teledyne Model 640x; STI-8184
July 31, 2024

Version 1

Page 40 of 50

Figure 23. Water collector attached to inlet.

4. Assemble the inlet and the ASC as shown in Figure 24, ensuring the parts fit snugly with no
gaps. Note that if the instrument is to be installed in a shelter with roof penetration the inlet
with the water collector should be left off for the time being.
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—— 640x Option Inle®
(requires total
flow 16.67 LPMX

Water Collector—

Extension Tube—

Upper Inlet Tube

o (inlet line to
(ASC, 5 LPM)
Bypass Line Fitting-@ — ASC Bypass/
for Bypass Pump Downtube Coupler

(split flow connection
to pump, 11.67 LPMJ™™ |

— ASC Sample Tube

Figure 24. 640x inlet and ASC assembly.

5. Lower the ASC into the support collar, ensuring it fits straight with no gaps.
6. Plug the ASC wiring into the rear panel connector.
9.3  Temperature Probe Connection

1. Plug the ambient temperature probe connector into its respective rear panel electrical port
(Figure 25).
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Figure 25. Ambient temperature probe and ASC connections.

2. Route the probe outside and insert it into the solar shield, ensuring that the solar shield
remains vertical (Figure 26).

Figure 26. Ambient temperature probe installed in the solar shield.
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94 Power Connection

Adhering to any warning messages, insert the power cord between the instrument’s AC power
connector and a properly rated power outlet.

9.5 Communications Interface Connections

For network or Internet communication with the instrument, connect an Ethernet cable from the
analyzer's rear panel Ethernet interface connector to an Ethernet port. The address settings default to
automatic configuration by Dynamic Host Configuration Protocol (DHCP). Most users will want to
configure the instrument with a static IP address; however, consult your network administrator to
discuss other potential options. For firmware updates and data downloads, use a flash drive inserted
into the front panel USB port. See Sections 3.2 and 3.1.7.3 of the T640x User Manual.

9.6 Shelter Installation with Roof Penetration

For rooftop installation instructions recommended by Teledyne API, see the video linked in the QR
code below. Alternatively, you can view this video at:

1. Determine the location where the T640x will operate in the shelter.

a. The instrument should be in a location where the top of the T640x
ASC will be no fewer than about 60 cm from the top of the Rooftop
ceiling/roof line or, Installation

Video

b. The instrument should be placed at a height within the shelter
so that after the ASC and a 2.4-m extension sample line are
installed, the inlet (on top of the 2.4-m extension sample line)
is 2.0 m above the roof and equal in height with any other PM
instrument inlets.

c. Align all pieces before making any cuts in the roof.

d. Ensure the monitor downtube is capped so that no debris
enters the downtube during drilling and installation.

2. Drill a hole in the roof to accommodate the diameter of the 2.4-m extension sample line
(5/8" outside diameter).

3. Install the provided roof flange over the hole.

a. Make sure to use good-quality roof sealant for the base of the roof flange to ensure
weather tightness and to prevent any leaks.


https://www.youtube.com/watch?v=8H5NmNgBg1M

10.

11.

12.

13.
14.
15.
16.
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Without locking it down, set up the sample line tripod so that its sample line hole aligns with
the hole in the roof.

a. The tripod should be set up at such a height to properly support the sample line with
the inlet on top.

Without the inlet installed on the top of the ASC, line up the instrument so that the opening
at the top of the ASC is in line with the sample line hole/roof flange on the shelter roof.

Install a slip coupler on top of the ASC.

Slide the 2.4-m sample line extension down through the tripod and the roof penetration until
it meets the opening of the slip coupler.

a. The sample line should be plumb to prevent any strain on the instrument and to
prevent pneumatic leaks.

b. The sample line should slide into the top of the slip coupler and bottom out when in
completely. Ensure that the sample line is not pushing down on the connection inside
the slip coupler such that the monitor can be moved to the side, as needed, for
verifications and audits.

Lightly tighten the tripod cord grip and the roof flange cord grip around the sample line to
hold it in place.

Test the slip coupler and ensure the monitor can be moved. Move back and re-connect the
slip coupler.

At the top of the sample line (on the roof), place the provided inlet collar so that its top is
roughly 7 cm from the top of the sample line. Doing so ensures proper clearance from the
base of the inlet and prevents instrument flooding if the inlet were to ever get water inside of
it.
Lock down the collar once it is determined to be at the proper spot roughly 7 cm from the
top of the sample line.
Place the inlet on top of the sample line.

a. Make sure the inlet is secure (i.e., that the collar holding it is not sliding).

b. Proper installation should have the inlet 2 m above the roof.
Plug the ASC connector into the proper fitting on the rear panel of the T640x.
Connect the power cable and ambient temperature sensor at the back of the instrument.

Before sealing the cord grips, power up the instrument and make sure it is running properly.

Once the T640x instrument is determined to be installed and working properly, tighten the
roof flange cord grip around the sample line.
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Apply clear silicone caulk generously around the top end of where the cord grip rubber
grommet meets the sample line to ensure a complete seal.

a. Silicone caulk seals well and can easily be removed and reapplied if the instrument
needs to be removed for servicing.

Additionally, tighten the tripod cord grip and lock down the feet of the tripod to fully secure
the sample line.

Inspect the PM1o well to ensure it is clean.

Outdoor Enclosure Installation
Place the enclosure in the location where the instrument is to run.

Measure the distances and clearances for the location of the T640x monitor and inlet. The
T640x instrument should be installed in the enclosure at a height where the inlet will be at
least 2 m above ground (from ground level to the inlet height). Adjust the shelf as needed;
however, do not actually locate the monitor on the shelf yet.

Slide the ASC up through the port of the enclosure by several centimeters above where the
monitor will sit and tighten the collar over the ASC such that it is held in place. However, do
not over-tighten it. The ASC must be installed from the inside of the enclosure due to the
power connector on the ASC.

Locate the 640x monitor chassis on the shelf of the enclosure.

a. Make sure the black inlet nozzle (Figure 21) and aluminum adapter (Figure 22) are
installed on the optical sensor.

Once the T640x is in the enclosure and lined up with the opening on the top of the
enclosure, carefully untighten the collar holding the ASC and slide it down gently until it
inserts into the opening of the T640x.

a. The ASC should go into the T640x level and be plumb. It is in completely when it i
bottoms out onto the top of the optical sensor. This process can be checked by
lowering the front panel of the T640x and making sure the base of the ASC is
touching the top of the optical sensor flush.

Plug the ASC connector into the proper fitting on the rear panel of the T640x.
Connect the power cable and ambient temperature sensor at the back of the instrument.
Before sealing the collar, power up the instrument and make sure it is running properly.

Once the T640x instrument is determined to be installed and working properly, tighten the
collar around the ASC.

Inspect the PM1o well to ensure it is clean.
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11. Apply clear silicone caulk generously around the top end of where the collar rubber grommet

meets the ASC to ensure a complete seal.

a. Silicone caulk seals well and can easily be removed and reapplied if the instrument

needs to be removed for servicing.

9.8 Pneumatics

Instrument pneumatics are shown in Figures 27 and 28.
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Figure 27. T640 pneumatics.
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Figure 28. T640 with 640x option pneumatics.
9.9 Instrument Start-Up

With all hardware and electrical in place, power up the T640x. The monitor will take a few minutes to
work through its start-up routine. Ensure the data system is not logging data at this point, except as
necessary to ensure data transfer is appropriately bringing in information from the T640x. The
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following activities should be performed after the unit is brought on line. Note: references to the
operational manual are provided, where applicable.

1. Check the firmware; upgrade firmware to the latest version, if necessary. (See Section 3.2 of
the T640x User Manual).

2. Adjust the clock on the T640x to local standard time (LST). (See Section 3.1.12.2 of the T640x
User Manual).

3. Select parameters to display on front panel home screen. (See Section 3.1.1 of the T640x User
Manual).

a. To select parameters, press the configuration button:

b. Users can select whichever parameters are most important to them. Our strong
recommendation is to include:

i. Sample Flow (5.0 lpm)
ii. Ambient Temp
iii. Sample RH

4. Select parameters to include in the Dashboard. See the Monthly QC and Maintenance Sheet
in Section 10.0 below for recommended parameters to include. (See Section 3.1.9 of the T640
User Manual to configure the Dashboard).

5. We recommend using units of mmHg for pressure. To change pressure units to mmHg, go to
Setup>Vars>Pressure Units>mmHg.

Conduct Instrument Verifications and Calibrations (Section 6.4).
Inspect the DFUs to ensure that they appear new.

Close the instrument front panel and inspect all connections.

© © N o

Wait 10 min, which allows concentration data to be updated to ambient conditions.

10. Review concentration data on front panel display and ensure that all parameters appear
reasonable compared with current conditions. Compare T640x data with other available data
at the current site or a nearby site, if available.

11. Enable data recording to “On Scan.”

12. Document startup in the Field log book.
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10. Monthly QC and Maintenance Sheet

Order of Monthly Checks:

Station: 1. Document any alarms and then clear.
o . 2. Record parameters as found in the Dashboard.
perator: . . Y
3. Take instrument "Off Scan” from data system.
Analyzer S/N: 4.  Perform a Zero Test.
5. Clean the PMio well.
Date: 6. Perform verifications of:
Time monitor out of a.  Barometric Pressure (BP)
service (LST): b.  Ambient Temperature (Ta)
Time monitor back in c. Total flow (16.67 Ipm)
e (LST: d. Sample flow (5.00 Ipm)
service (LST). e. SpanDust
7. Perform, if needed, calibrations of pressure, flow, and PMT.
8.  Put the instrument back together.
Any alarms enabled? . 9
. o 9.  Clear any remaining alarms.
List alarm/date/time if 10. Wait a minimum of 10 min to ensure PM concentrations are
applicable representative of ambient air.
11. Bring the instrument back on line to the data system.
Parameters from Dashboard:
Amb P. (°C) Amb T. (°C) ASC Heater Duty
Box T. (°C) Current PMT HV LED Temp. (°C)

Package Version

PM;o Conc. (pug/m3)

PMo STP (ug/m?3)

PM_;s Conc. (ug/m?)

PMT Setting

Pump PWM (%)

Sample Flow (Ipm)

Sample RH (%)

Sample Temp. (°C)

Sensor Firmware

Total Flow (Ipm)

Valve PWM (%)

QC Checks:

Audit Device:

S/N:

| Last Cert. Date:

Verifications: Calibrations:
QC Check Audit Actual T640x Audit Actual | T640x Tolerance
Zero Test NA Re-zero if any issues found and corrected: 0.0 on each PM metric
BP + 10 mmHg
Ta + 2°C
Total Flow + 5% of T640 (e.g.,
16.67 Ipm 15.87-17.54 Ipm)
Sample Flow + 5% of 7640 (e.g.,
5.00 lpm 4.75-5.25 Ipm)
Bypass Flow 11.67 Ipm + 5% of T640 (e.g.,
(only as needed) 11.12-12.29 Ipm)
Peak Ch. =
) + 0.5 value displayed
SpanDust™ PMT Setting = on SpanDust™ bottle,
Peak Ch. Counts = (e.g., 11.10or 11.3)
Additional Checks and Maintenance (less frequently than monthly): Date Completed

Quarterly

1. Clean PMy inlet (above the PM1o well)

Every 6 Months

g

1. Clean Optical Chamber
Clean RH Sensor
3. Clean Ta Sensor
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Every 12 months . L
1. New internal (5.00 Ipm) DFU [inside front panel]

or if valve or pump PWM 2. New external (11.67 Ipm) DFU [at back of instrument]
value approaches 80% It is recommended to change both DFUs on the same day.
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1. Scope and Applicability

This standard operating procedure (SOP) provides instructions for servicing meteorological

instruments measuring wind speed, wind direction, temperature, and relative humidity. Operating
procedures for these instruments are listed in Section 3.

2. Routine Maintenance

Routine maintenance tasks are designed to maintain the meteorological equipment in good working
condition and reduce the frequency of non-routine maintenance. They are described in detail below.

2.1 Maintenance Checklist

Table 1 shows the maintenance activities that must be performed during each site visit to ensure all
instruments are performing correctly.

Table 1. Routine maintenance checklist.

| fem [ Ao

Tower?

Anemometer

Temperature/
Sensor
Shield

Check that the tower is securely anchored to the shelter.

Check the tower for signs of damage or excessive wear.

Inspect all bolts at the tower base for any signs of corrosion (rust).
Check the tower’s vertical alignment.

Note whether any component (tail, propeller) is missing or has suffered
obvious damage.

Check that the whole sensor moves freely with a changing wind direction
and the propeller rotates freely when windy.

Inspect the hardware holding the temperature/RH sensor shield assembly
to the tower and tighten the bolts if necessary.

Check that the cable connections are secure and that the cables are not
fraying.

Clean the glass domes on the sensors with an alcohol wipe or a soft, clean
towel and water. Replace the silica gel desiccant when needed (it will turn
from blue to pink when it needs to be replaced).

Check that the air intake tube at the bottom of the pressure sensor housing

is not blocked. Clean with cotton swab and water if needed.

Check that cable connections are secure.
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Data Logger ~ Verify that the enclosure is secured inside the shelter and is operational.
Enclosure Check that the cabling to the enclosure is secure and undamaged.

Check the integrity of the cables connecting the data logger box from the
Cables data logger to the sensors.

Check that the sensor cables are attached to the tower.

Where guy wires are used, check that they are taut and that the attachment
Guy Wires points are tight. If the attachment points are loose, call Sonoma Technology
for instructions.

Where solar power is used, check that the solar panel is clean and free of
Solar Power  debris; confirm all connections to the battery are secure and free from
corrosion.

@ Lowering the meteorological tower is not necessary for routine site maintenance visits. Do not attempt to lower
the tower with fewer than two people.

After physically inspecting the meteorological sensors, the technician should

e Record the current weather observations on the Maintenance Site Visit form. This observation
should include general wind direction, wind speed, approximate temperature, clouds, current
weather, the time, and any other observations that could impact meteorological data. For
example, an observation might read:

“Moderate southwest breeze, temps in the 50s F, damp with fog and rain at 1030 PST"

¢ Observe all of the meteorological data parameters on the data logger screen and determine
whether or not they are physically plausible and reasonable (i.e., is a value that should be
positive shown as negative, etc.).

¢ Monitor wind speed and wind direction on the screen and compare with the visually
estimated orientation of the wind monitor and strength of the wind. Note: The typical range
for wind speed is 0 m/s to 10 m/s. Use Tables 2 and 3 to help estimate wind speed and
temperature.
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Table 2. Wind speed estimation.

o Wind Speed .
Range (m/s) How to Estimate Speed

Calm 0to 0.2 Calm, smoke rises vertically
Light air 03to 1.5 Smoke drifts with the wind
Light breeze 1.6 to 3.3 Wind felt on face; leaves rustle

Leaves and small twigs in constant motion; wind

Gentle breeze 35t054 sveierndls ol s
Moderate Raises dust and loose paper; small branches are
55t07.9
breeze moved
Fresh breeze 8.0to 10.7 Small trees with leaves begin to sway

Table 3. Temperature conversions.

L Temperatre
K

-4—124710131618212427

e If any parameter appears unreasonably high or low, or simply implausible, try to identify the
cause (check cables, connections, etc.). If you cannot find the source of the problem, contact
Sonoma Technology.

2.2 Securing the Shelter

Turn off the computer’s display monitor, and record your completion time in the Site Log form. Turn
off the shelter lights and lock the shelter.

3. Calibration and Standard Operating Procedures for
Meteorological Sensors

Audits are conducted on meteorological instrumentation with reference to the recommendations in
the EPA’s Quality Assurance Handbook for Air Pollution Measurement Systems (QA Handbook),
Volumes |, Il, and IV (U.S. Environmental Protection Agency, 2017b, 1994, 2008) and in accordance
with the Technical Assistance Document for the National Air Toxics Trends Stations Program, Revision
3 (U.S. Environmental Protection Agency, 2016a) and the Technical Assistance Document for Sampling
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and Analysis of Ozone Precursors for the Photochemical Assessment Monitoring Stations Program,
Revision 2 (Battelle, 2018).

As part of the calibration process, each instrument will first be tested to determine whether it is
operating within the prescribed operational limits and whether non-routine maintenance or
adjustments are required. Based on an instrument'’s response to the initial performance test with
respect to the minimum acceptable performance criteria (see data quality objectives in the QAPP),
the instrument will then be repaired, calibrated, or in rare cases, replaced. A standard form is used to
document the performance of each sensor before and after any adjustments. A digital copy of this
document is to be kept on the Sonoma Technology servers. Notes on what was performed are also
to be recorded in the station logbook. The performance criteria for meteorological sensors are listed
in Table 4.

Table 4. EPA-recommended meteorological specifications.

. . Measurement

Wind Speed £0.2 m/s 0.2 m/s
Wind Direction +5° 3°
Ambient Temperature +0.5°C 0.3°C
Relative Humidity +5% RH 1.0% RH
Barometric Pressure +1 hPa 0.3 hPa
Vertical Temperature Difference  +0.1°C 0.1°C

10 W/m?3 below 200 W/m? above

Solar Radiation 200 W/m? +5%

1.0 W/m?

3.1 Wind Direction Calibration

The wind direction calibration is performed by comparing the wind direction sensor readouts on the
data acquisition system (DAS) and chart recorder (if applicable) with known wind directions
established by using a theodolite or precision compass. Several points over the measurement range
are verified using a calibration fixture, assigned compass reference points, or established distant
sighting targets. Differences between reference and sensor measured directions are recorded. The
starting threshold for the direction vane is checked using a torque disc or watch gauge.

3.1.1 Materials Needed

e Pocket transit or precision compass with tripod

¢ RM Young Model 18212 Vane Angle Fixture

¢ RM Young Model 18331 Vane Torque Gauge

e Current magnetic declination angle for the site to be calibrated
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Procedure

Calibration procedures are in accordance with the guidelines of the EPA Quality Assurance Handbook
for Air Pollution Measurement Systems: Volume IV, Version 2.0 Final (U.S. Environmental Protection
Agency, 2008b).

1.

For wind direction instruments that have crossarms, prior to lowering the tower or the
crossarm, determine the crossarm alignment by sighting along it using a precision compass
corrected for magnetic declination. Current magnetic declination should be obtained using
the latitude/longitude or UTM coordinates of the site and a magnetic declination calculation
computer program. Optionally, if a solar viewing is possible, a theodolite can be set up and
oriented using a solar angle computer program. Using this method, a technician can view the
crossarm through the theodolite to verify alignment with reference to True North.

Once the crossarm is lowered, position the wind vane exactly parallel to the crossarm and
record the reading.

Determine the sensor’s accuracy and linearity by mounting a direction template or calibration
fixture, and fixing the vane in 30-degree increments around the full 360- or 540-degree
range of the sensor. The vane is rotated sequentially through the increments clockwise and
counter-clockwise, and the DAS readouts are recorded. The tip and the tail of the vane may
also be pointed at established distant sighting targets.

The difference between the station and calibration wind directions is calculated using the
following equation:

Difference = Station Wind Direction - Reference Wind Direction

The differences calculated above are compared with the EPA State and Local Air Monitoring
Stations (SLAMS)-recommended criteria of "5E for the entire system” (orientation plus
linearity). If results exceed these criteria, recalibrate the sensor or replace the potentiometer
or sensor.

Determine the starting threshold of the wind vane by measuring the shaft rotational torque
of the sensor using a torque gauge or disc. The measured torque should be less than the
maximum allowable torque provided by the manufacturer corresponding to a 0.5 m/s wind
speed threshold.

If the measured torque exceeds this value, replace the bearings or sensor. If necessary,
calculate the torque value that corresponds to the starting threshold of 0.5 m/s for a 10E
deflection by using the "k" value provided by the manufacturer and the following equation:

T = kU? (Where: T = torque in gm-cm, U = wind speed in m/s, and k = constant)

This torque gauge test determines if the wind vane starting threshold is less than or equal to
the required specifications. The wind vane is considered to be within the recommended
criteria if the indicated torque value is less than or equal to the calculated or stated maximum
starting torque value.
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The wind speed calibration is performed by temporarily replacing the anemometer cups or propeller
with a synchronous motor, and comparing the speed corresponding to the rotation rate (supplied by
the manufacturer) with the equivalent wind speed displayed by the instrument and recorded by the
DAS. Starting thresholds are checked using a torque disc to measure shaft rotational torque.

3.2.1

3.2.2

Materials Needed

RM Young Model 18810 anemometer drive
RM Young Model 18310 Torque Disc

Procedure

Calibration procedures conform to the guidelines of the EPA Quality Assurance Handbook for Air
Pollution Measurement Systems: Volume IV, Version 2.0 Final (U.S. Environmental Protection Agency,

2008b).
1.

The starting threshold is calibrated by checking the sensor shaft’s rotational torque with a
torque disc. With the anemometer sensor in the horizontal position, remove the propeller
and install the RM Young Model 18310 Torque Disc on the anemometer shaft. Use the
manufacturer-provided allowable torque values, or calculate the torque value that
corresponds to the starting threshold of 0.5 m/s using the "k" value provided by the
manufacturer and the following equation:

T = kU? (Where: T = torque in gm-cm; U = wind speed in m/s; and k = constant)

Install the 0.1 gm screw weight in the appropriate hole of the torque disc that corresponds to
the calculated torque value, and position the weight so that it is level with the anemometer
shaft. Release the weight and note whether the torque disk and anemometer shaft rotate
freely. To measure the actual starting torque, change the position of the screw weight
starting at the location closest to the shaft, and move outward until the weight rotates freely
from the horizontal. The weight of the screw multiplied by the distance from the shaft equals
the torque in gm-cm.

The accuracy of wind speed measurements are tested at zero and at least two speeds within
the operational range of the sensor. The RM Young Model 18810 selectable speed
anemometer drive is used to generate stable calibration input speeds over the range of the
sensor. Remove the propeller and join the wind speed sensor shaft to the calibration motor
with a coupling device.

Calculate the difference between the system and calibration wind speeds using the following
equation:

Difference = Station Wind Speed - Reference Wind Speed
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The differences calculated above are compared with the EPA SLAMS recommended criteria of
"0.25 m/s when speeds are <5 m/s; +5% when speeds are >5 m/s, not to exceed +2.5 m/s.”

Materials Needed

A NIST-traceable digital thermometer
Three thermos bottles—one with hot water, one with warm water, and one with ice

Procedure

Calibration procedures are in accordance with the guidelines of the EPA Quality Assurance Handbook

for Air Pollution Measurement Systems: Volume IV, Version 2.0 Final (U.S. Environmental Protection
Agency, 2008b).

1.

3.4.1

Temperature sensing systems are calibrated by collocated intercomparison with a calibrated
reference standard.

If immersion in water is possible:

a. The station temperature sensing system thermistor and the calibrated audit thermometer
is immersed in a common stirred water bath.

b. Readings are compared at 3 points over the expected temperature range.

If delta-temperature is measured, simultaneously insert both temperature sensors in the
same medium and compare the outputs.

Calculate the difference between the station and audit temperatures using the following
equation:

Difference = Station Temperature - Reference Temperature

The differences calculated above will then be compared with the EPA-recommended criteria
of 1.0°C. If the delta temperature is calibrated, the difference between the output of the two
sensors is compared with the EPA-recommended criteria of 0.1°C.

Materials Needed

Calibrated digital relative humidity (RH) probe, or a Sato or similar motor aspirated
psychrometer

Booklet of psychometric tables and a portable barometer (if motor aspirated psychrometer is
being used)
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o Water
e Large plastic bucket (approx. 5 gallon size)

3.4.2 Procedure

Calibration procedures are in accordance with the guidelines of the EPA Quality Assurance Handbook
for Air Pollution Measurement Systems: Volume IV, Version 2.0 Final (U.S. Environmental Protection
Agency, 2008b).

1. The relative humidity calibration is performed by collocating the calibrated RH sensor or
motor-aspirated psychrometer adjacent to the site sensor. The sensors are placed in a
shaded location and allowed to equilibrate.

2. Multiple readings are taken over several hours.

3. Calculate the difference between the station and reference relative humidity readings using
the following equation:

% RH Difference = Station % RH - Reference % RH

4. Compare the mean of the percent differences calculated above with the EPA-recommended
criteria of 10% relative humidity.

4. References

U.S. Environmental Protection Agency (1994) Quality assurance handbook for air pollution
measurement systems, Volume I: a field guide to environmental quality assurance. Report
prepared by the U.S. Environmental Protection Agency, Research Triangle Park, NC, EPA/600/R-
94/038a. Available at

U.S. Environmental Protection Agency (2008a) Quality assurance handbook for air pollution
measurement systems, Volume Il: ambient air quality monitoring program. Prepared by the U.S.
Environmental Protection Agency, Office of Air Quality Planning and Standards, Air Quality
Assessment Division, Research Triangle Park, NC, EPA-454/B-08-003, December. Available at

U.S. Environmental Protection Agency (2008b) Quality assurance handbook for air pollution
measurement systems, Volume IV: meteorological measurements version 2.0 (final). Prepared by
the U.S. Environmental Protection Agency, Office of Air Quality Planning and Standards, Air
Quality Assessment Division, Research Triangle Park, NC, EPA-454/B-08-002, March. Available at

U.S. Environmental Protection Agency (2016) Technical assistance document for the National Air
Toxics Trends Stations Program, Revision 3. Prepared for the Office of Air Quality Planning and
Standards, Research Triangle Park, NC, by Battelle, Columbus, OH, October. Available at
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https://www3.epa.gov/tthamtil/files/ambient/airtox/NATTS%20TAD%20Revision%203_FINAL%200
ctober%202016.pdf.

U.S. Environmental Protection Agency (2017) Quality assurance handbook for air pollution
measurement systems, Volume Il: ambient air quality monitoring program. Prepared by the U.S.
Environmental Protection Agency, Office of Air Quality Planning and Standards, Air Quality
Assessment Division, Research Triangle Park, NC, EPA-454/B-17-001, January. Available at
https://www3.epa.gov/tthamtil/qalist.html.

5. Maintenance Form: Quarterly Meteorology Station
Checklist

DATE: Location:

Check that the tower is securely anchored to
the shelter.

Check the tower for signs of damage or
Tower? excessive wear.

Inspect all bolts at the tower base for any
signs of corrosion (rust).

Check the tower’s vertical alignment.

Note whether any component (tail, propeller)
is missing or has suffered obvious damage.

Anemometer Check that the whole sensor moves freely with
a changing wind direction and the propeller
rotates freely when windy.

Inspect the hardware holding the
temperature/RH sensor shield assembly to the
tower and tighten the bolts if necessary.

Check that the cable connections are secure
and that the cables are not fraying.

Temperature/ Clean the glass domes on the sensors with an

Sensor alcohol wipe or a soft, clean towel and water.

Shield Replace the silica gel desiccant when needed
(it will turn from blue to pink when it needs to
be replaced).

Check that the air intake tube at the bottom of
the pressure sensor housing is not blocked.
Clean with cotton swab and water if needed.
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Data Logger
Enclosure

Cables

Guy Wires

Solar Power

Check that cable connections are secure.

Verify that the enclosure is secured inside the
shelter and is operational.

Check that the cabling to the enclosure is
secure and undamaged.

Check the integrity of the cables connecting
the data logger box from the data logger to
the sensors.

Check that the sensor cables are attached to
the tower.

Where guy wires are used, check that they are
taut and that the attachment points are tight.
If the attachment points are loose, call
Sonoma Technology for instructions.

Where solar power is used, check that the
solar panel is clean and free of debris; confirm
all connections to the battery are secure and
free from corrosion.

Estimated Temperature Temp Sensor Reading Difference / Comment

°C °C

Estimated RH

RH Sensor Reading Difference / Comment

% %

Estimated Wind Speed Wind Sensor Reading Difference / Comment

mph mph

Estimated Wind Direction ~ Wind Direction Reading Difference / Comment

Additional Comments:
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6. Maintenance Form: Meteorology Station Calibration

DATE:

Temp Standard Model:
Temp Standard Serial Number:
Temp Standard Cal Due Date:

RH Standard Model:
RH Standard Serial Number:
RH Standard Cal Due Date:

Temp/RH Sensor Model:
Temp/RH Sensor Serial Number:

As Found:

Temp Standard Reading

°C
°C
°C
°C
°C

RH Standard Reading

%
%
%
%
%

Location:

Temp Sensor Reading Difference
°C °C
°C °C
°C °C
°C °C
°C °C
RH Sensor Reading Difference

%

%

%

%

%

%

%

%

%

%




As Left (if sensor was changed or adjusted):

New Temp/RH Sensor Model:
New Temp/RH Sensor Serial Number:

Temp Standard Reading

°C
°C
°C
°C
°C

RH Standard Reading

%

%

%

%

%
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Temp Sensor Reading Difference
°C °C
°C °C
°C °C
°C °C
°C °C
RH Sensor Reading Difference
% %
% %
% %
% %
% %




Driver Model:
Driver Serial Number:
Driver Cal Due Date:

Anemometer Model:
Anemometer Serial Number:

Propeller Serial Number:

Compass Model Number:
Compass Serial Number:

GPS Coordinates:

Magnetic Declination:

As Found:

Wind Direction:
Expected Measured

0° CW

Difference
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45° CW

90° CW

135° CW

180° CW

225° CW

270° CW

315° CW

360° CW

315° CCW

270° CCW

225° CCW

180° CCW

135° CCW

90° CCW

45° CCW

0° CCW

355° CCW

5° CCW




Directional Torque:
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cw gm-cm

CcCw gm-cm

Wind Speed:

Expected (m/s) Measured Difference

0 m/s (0 RPM) m/s m/s
1.54 m/s (300 RPM) m/s m/s
3.07 m/s (600 RPM) m/s m/s
6.14 m/s (1200 RPM) m/s m/s
13.31 m/s (2600 RPM) m/s m/s
25.60 m/s (5000 RPM) m/s m/s
18.43 m/s (3600 RPM) m/s m/s
Wind Torque: gm-cm

Alignment:

Expected Measured Difference
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As Left (if sensor was changed or adjusted):
New Anemometer Model:

New Anemometer Serial Number:

New Propeller Serial Number:

Wind Direction:

Expected Measured Difference

0° CW ° °
45° CW ° °
90° CW ° °
135° CW ° °
180° CW ° °
225° CW ° °
270° CW ° °
315° CwW ° °
360° CW ° °
315° CCW ° °
270° CCW ° °
225° CCW ° °
180° CCW ° °
135° CCW ° °
90° CCW ° °
45° CCW ° °
0° CCW ° °
355° CCW ° °
5° CCW ° °

Directional Torque:

Ccw gm-cm

CcCcw gm-cm

Wind Speed:

Expected Measured Difference

0 m/s (0 RPM) m/s m/s
1.54 m/s (300 RPM) m/s m/s
3.07 m/s (600 RPM) m/s m/s
6.14 m/s (1200 RPM) m/s m/s
13.31 m/s (2600 RPM) m/s m/s
25.60 m/s (5000 RPM) m/s m/s

18.43 m/s (3600 RPM) m/s m/s




Wind Torque:

Alignment:
Expected
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gm-cm

Measured

Difference

NOTES:
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Summary

This document describes the steps necessary to calibrate and maintain the Belfort Instrument
Visibility Sensor Model 6400. The procedure is intended to verify that the equipment is performing to
expectations and the detection and communication links are functioning correctly. Hard copies of
this procedure and associated audit forms will be kept on site. Upon completion of the audit
procedure, a copy of the audit form showing the results will be sent to the Refinery Project Manager.

Safety

Work should conform to manufacturer guidance and site health and safety practices. Standard
refinery personal protective equipment (PPE) should be worn at all times, including laser safety
glasses with side shields, a hard hat, goggles, steel-toed boots, hearing protection, fire-retardant
clothing (FRC), an Hz2S monitor, and appropriate gloves that are adequate for this procedure.

Personnel Qualifications

Installing, operating, and servicing Belfort visibility sensors should only be performed by personnel
who are trained in the operation of the system components and are familiar with handling the
testing equipment. These procedures should not be performed by personnel who do not understand
the system, technology, or hazards of the materials involved.

General Maintenance

Belfort Instrument Company suggests conducting the initial visibility sensor maintenance three
months after installation. The technician will need to adjust this time frame based on the individual
site environment where the instrument is installed. Factors may include but are not limited to insects
at the site, weather conditions, dust, blowing debris, and deposits from water spray. Table 1 provides
a schedule of maintenance activities for the sensor.

The technician should periodically inspect the sensor for dirt, spider webs, bird nests, and other
obstructions. When necessary, carefully clean the protective glass windows in the Receiver and
Transmitter with a commercially available glass cleaner. When maintenance is complete, the
maintenance forms on page 8 of this document should be saved in the maintenance folder for the
project located on Sonoma Technology's shared drive.

There are no user serviceable components in the sensor. Should a failure occur, return the sensor to
Belfort Instrument for repair. Data will be flagged in a manner consistent with the QAPP if there are
issues that cannot be immediately corrected. In the case of extended down time, the sensor should
be replaced with a working sensor.

STI-6991



Table 1. Schedule of maintenance activities for the Belfort Model 6400 Visibility Sensor.

Monthly | Annually

Visually inspect the system, including all cables. v
Inspect optics on detector and clean if necessary. v
Check calibration. v

Contact Belfort Instruments or Sonoma Technology to receive a digital copy of the manual.

Prepare for Calibration

Before beginning the calibration, make sure you have these materials:

e Serial cable with hook or alligator clips
e Opaque filter

e Scatter plate

e Laptop with terminal emulator

If the calibration is being performed in the field, select a clear day with low wind speeds (less than 10
knots). Fog will also affect calibration results, so choose a day that isn't foggy. For calibration to be
valid, visibility must be at least 1 mile. The sensor needs to have been powered on for at least 45
minutes before beginning calibration. Check that the sensor windows are clean and clear of any
noticeable dirt, spider webs, or other obstructions before getting started.

The technician will need to set up a serial connection with the sensor, perform a zero calibration, and
complete a span calibration (in that order).

Set Up the Serial Connection

1. Disconnect the three serial wires connected to the CR310 data logger’s terminals and
reconnect them to the serial cable with hooks (or alligator clips). Note: the red wire is RX, the
brown wire is TX, and the bare wire is the ground. Next, connect the serial cable to a laptop.

2. Use Device Manager to check the com port you are connected to under the Ports section.

3. Open a terminal emulator, such as Tera Term, and set it to the com port you have connected
to. Make sure the serial settings match that of the Belfort 6400 (baud rate 9600, 8 bit, no
parity, 1 stop bit, no flow control).

4. Test the connection by typing the FL command into the terminal without pressing Enter.
Immediately, a list of values should be returned similar to this:

P,00223, 1, 0.19333965, 40.33408642, 1.45484,Mi, 1.281314 0000



If nothing is returned, try swapping the red and brown wires. If it still doesn't work, check the
serial settings to make sure they are correct.

Before the calibration commands can be entered, the terminal must be given super user
privilege. Hold down the Ctrl key and press the V key. Then type in the password foggy and
press Enter. You should see the message, “Password accepted, Operator is now Super User.”
To stop being a super user at any time, press Ctrl-V and Enter again without entering the
password. Turning the sensor off and on will also end super user status. DO NOT USE ANY
COMMANDS NOT STATED IN THIS SOP WHILE IN SUPER USER MODE. Doing so could
compromise the sensor’s functionality.

Zero Calibration

1.

Push the black foam opaque filter into the receiver hood, which is the hood on the left when
facing the front of the sensor (see Figure 1). You are facing the front when you can see the
"Belfort” logo on the device. Make sure the filter is completely blocking the receiver window.
Warning: the hood might be hot to the touch if the heaters are on.

In the terminal emulator, enter the command FZ. The sensor will ask for verification before
starting the calibration routine. Type the letter Y to accept (or Esc to abort).

The zero calibration routine will run for 3 minutes, allowing the sensor to reach a stable zero
state, after which it will run for 2 more minutes while taking an average of the zero offset.

At the end of the zero calibration routine, the operator will be prompted to accept the new
zero offset value. If the operator does not respond within 3 minutes, the sensor aborts the

calibration (discarding the value generated). After accepting the new value, record it along

with the previous value in eSIMS or a laboratory/field notebook.

Do not forget to remove the opaque filter after doing the zero calibration, as failure to do so
will result in constant high visibility readings regardless of actual conditions.

s o

o =

Figure 1. Inserting the opaque filter.



Span Calibration

1.

Make sure the opaque filter has been removed from the receiver hood. Check the scatter
plate for smudges and scratches. Clean off any smudges with a commercial glass cleaner (do
not use harsh solvents as they will melt the plastic on the scatter plate). If the scatter plate
is badly scratched, contact the manufacturer before use.

Carefully hang the scatter plate on the sensor by hooking the top bracket over the top of the
sensor's cross arm. Center the scatter plate on the cross arm an equal distance from the edge
of each hood to the plate. Make sure the plate is secure and not swinging or rotating on the
sensor’s cross arm (see Figure 2).

In the terminal emulator, enter the command FN. A list of configuration parameters will be
returned. Verify that the value of Cal_ExtCo (Calibration Extinction Coefficient) is equal to the
value marked on the scatter plate's label. If they do not match, enter the command FC. A
similar list of parameters will appear, followed by a prompt to change them. The prompt will
go through each parameter one by one. Press Enter to go to the next parameter until you
reach the Cal_ExtCo parameter. Enter the value found on the scatter plate’s label and press
Enter. Then press Esc. DO NOT CHANGE ANY OTHER PARAMETERS. Doing so could
compromise the sensor’s functionality.

Enter the FS command. When the sensor asks for verification before starting the calibration
routine, type the letter Y to accept (or Esc to abort).

The span calibration routine will run for 3 minutes, allowing the sensor to reach a stable span
state, after which it will run for 2 more minutes making periodic adjustments to the slope as
it attempts to minimize the error.

At the end of the span calibration routine, the operator will be prompted to accept the new
span factor value. If the operator does not respond within 3 minutes, the sensor aborts the

calibration (discarding the value generated). After accepting the new value, record it along

with the previous value in eSIMS or a laboratory/field notebook.

Do not forget to remove the scatter plate from the sensor and carefully put it away in a safe
place.

Record the procedure details, results, date, operator name, etc., in eSIMS or a laboratory
notebook.



Figure 2. Scatter plate mounting.

Completing the Process

1.

Disconnect the serial cable from the laptop, disconnect the Belfort 6400's three serial wires
from the cable, and reconnect them to the CR310 data logger. The red wire goes to the C1
terminal, the brown wire goes to the C2 terminal, and the bare wire goes to the G terminal of
the CR310.

Connect to the CR310 through Loggernet (either via a micro-USB cable to a field laptop or
via the DMZ server connection) and check to see if values are coming in and if they make
sense. Note: the values might initially be lower than expected, so wait 5 to 10 minutes for the
sensor to adjust.
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Belfort Model 6400 Visibility Sensor Audit Record

DATE: Location:

Test Technician 1 :

Test Technician 2 :

Zero State Calibration

Start Time:

Previous Zero Offset:

New Zero Offset:

Stop Time:

Notes:

Span Calibration

Start Time:

Scatter Plate ExCo:

Span Factor:

New Span Factor:

Stop Time:

Notes:
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1. Scope and Application

This standard operating procedure (SOP) describes the verification and validation of fenceline
monitoring data, including daily checks and quarterly analyses. Additional information is provided in
the corresponding fenceline air monitoring plan (FAMP) and Section D.2 of the quality assurance
project plan (QAPP).

2. Introduction and Overview

At all fenceline monitoring sites, a Data Acquisition System (DAS), or data logger, performs basic
quality control (QC), averages data to 5-min resolution, and aggregates data into a desired file
format. Data are then transmitted from each sampling site to a cloud-based file storage service via
cellular modem, where they are stored and available for retrieval as needed. Data from the cloud are
ingested into Sonoma Technology's Insight® data management system (DMS), where a robust
automated QC (AutoQC) logic assigns data flags in real time based on instrument diagnostics and
local meteorological measurements. Data are stored within the DMS and any changes to data are
recorded via chain-of-custody logs. These preliminary data are displayed on the public website
within 10-15 minutes of collection.

Data are reviewed daily by air quality data analysts to assess system operations, confirm the
automated data flagging is correct, and ensure any corrections to data flagging are propagated to
the public website immediately. Extended analyses are performed every calendar quarter and
reviewed by the project Quality Assurance (QA) Manager. Figure 1 illustrates the general data flow
and QC schematic.

Gl Internal Website

Data Management
System

Automated QC

Data
o Cloud-Based
o Acquisition - ~
File Transfer
System

External Data Manual QC
Back Up - .
Daily Data Quarterly ir Quality
Checks Review Management
District (AQMD)

Figure 1. Data flow and QC schematic.

Public Website
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3. Definitions

Data verification is a process of comparing how the data were gathered to the procedures
established by the project QAPP and SOPs. It is a data review technique that evaluates the
conformance of data collection practices to established methods, procedures, or specifications. Data
verification consists of checking that SOPs were followed and QC activities were performed.’

Data validation is a process of confirming that reported values meet the quality objectives of the
project. It is a data review technique that examines whether the particular requirements for a specific,
intended use are fulfilled. Data validation examines whether acceptance criteria outlined in the QAPP
were achieved.

Acceptance criteria are the defined performance criteria for the project that data must meet to be
considered acceptable for reporting. Additional information regarding acceptance criteria is provided
in Section A.7 of the QAPP.

Data flags are assigned to each data point based on instrument diagnostics and local meteorological
measurements. Within the Sonoma Technology Insight DMS, data flags are composed of QC and
operational (OP) codes. Additional information regarding data flags is provided in Section D.2 of the
QAPP.

The minimum detection limit (MDL) is the lowest concentration of each parameter that can be
measured by each analyzer at each sampling path. Additional information regarding MDLs is
provided in Section B.2 of the QAPP.

Spectral data refers to the individual absorbance spectra collected at each open-path monitoring site.
The analytic software evaluates raw spectral data in real time to report concentration data, and can
be reviewed if data validation efforts identify potential issues that require investigation. Additional
information regarding spectral data is provided in Section B.10 of the QAPP.

A spectral match parameter is used to identify parameters of interest and potential interferences
present with open-path sampling. Spectral subtraction is used in cases with overlapping absorbance
features, and the subtraction technique is proprietary to the instrument manufacturer. Additional
information regarding spectral match parameters is provided in Section B.2 of the QAPP.

4. Safe Work, Hazard Identification, and Training for Data Review

Data verification and validation is performed remotely in an office environment away from field
sampling sites. Common office hazards include slips and trips, sprains and strains, poor workstation
ergonomics, indoor air-quality problems, insufficient or excessive lighting, noise, and electrical

" EPA Quality Assurance Handbook Vol I,
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hazards. These hazards are identified and mitigated through safety walkthroughs, formal reporting of
unsafe conditions, and regular training sessions on correcting safety hazards.

Training for data review is conducted by senior staff with at least one year of experience with refinery
fenceline monitoring systems, as well as analyzer manufacturers. Project personnel are provided
copies of the QAPP and SOPs, and receive updated versions when available. Initial training is
provided prior to personnel performing work, and refresher trainings are conducted on an annual
basis. The QA Manager will identify specific training requirements for all project personnel and will
determine when trainees are qualified to work independently. Training records will be maintained by
the Field Staff Manager.

5. Data Review and Quality Control

Data for the fenceline monitoring network appears on both public and internal websites (Figure 1).
The internal website allows for detailed QC and flagging of the data, which are checked daily and
finalized quarterly as outlined in Section D.2 of the QAPP. The following text describes how to
perform daily and quarterly data verification and validation.

5.1 Daily Checks

Data are manually reviewed on a daily basis by qualified analysts. An internal, non-public field
operations website (Sonoma Technology's Insight DMS) is used for customized data queries and
visualizations, and the public-facing website is reviewed to ensure the real-time display is current and
accurate. Instrument performance issues or data gaps are escalated to the field operations team, and
the Project Manager determines the appropriate actions to resolve issues in a timely manner.

Data analysts are qualified to perform daily checks after a training period of at least two weeks.
Training includes education on monitoring rules and requirements, instrumentation, automated QC
processing, expected concentration ranges, diagnostic thresholds, and internal procedures to
escalate a data issue. Trainees shadow an experienced data analyst during daily checks for a week,
and are then overseen by an experienced analyst while they perform their first week of data checks.

This daily data review allows the analyst to visualize fenceline concentrations and instrument
diagnostics, thereby identifying potential instrument performance issues and confirming the current
operational status of the network. Instances of missing or invalid data, instrument signal strength
below defined thresholds, repeated (stuck) data values, rapid changes (spikes or dips) in data values,
or negative concentrations are recorded in a spreadsheet that tracks observations across a calendar
quarter. This form provides a template for data analysts to check relevant parameters against
acceptance criteria and commonly expected values for routine reference. Daily data check
spreadsheets from past quarters are maintained in an archive with other project documentation.

The following procedure details the daily data check for an individual monitoring network:
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Log in to the Sonoma Technology Insight DMS with the facility-specific credentials for the
check being performed. Credentials are stored in a secure password management software.

Navigate to the Dashboard, which contains configurable widgets showing time series plots of
relevant parameters.

Record any periods of missing data and verify that (1) missing data alerts were sent and
(2) resolution is being pursued by the field operations team. If this cannot be verified,
escalate the finding to the Project Manager.

Review any detection events and confirm the validity determination made by the after-hours
on-call team through review of instrument diagnostic parameters and spectral validation (see
Section 5.3 of this SOP).

Review recent visibility measurements and note any periods with visibility <2.5 miles on the
spreadsheet.

a. Periods with visibility <2.5 miles may impact performance of open-path analyzers and
often correlate with observations of invalid data at multiple sampling paths.

Check that meteorological instrumentation is functional and that measured values are
within reason (e.g. directional measurements are between 0-360 degrees, speeds generally
match local weather conditions). Record any instances of missing or abnormal
meteorological measurements in the daily observation spreadsheet and escalate to the field
operations team.

Compare the current open-path analyzer diagnostic parameters to the acceptance criteria
(see Section A.7 of the QAPP) to assess operational status of the monitoring network.

a. Periods with diagnostic parameters (e.g. signal strength) outside of acceptance
criteria will result in invalid data and may result from open-path analyzer
misalignment. Record these periods in the spreadsheet and escalate to the field
operations team for necessary site visits.

Because data flagging for each compound is determined by the analyzer diagnostic
parameters, review one representative compound concentration time series for each
analyzer at each sampling site, and note the following information:

a. Any periods of missing or invalid data.

b. Any periods of data flagged for additional review (i.e. automated checks for range,
rate-of-change, and sticking).

c. For periods where data were flagged as invalid due to environmental conditions,
confirm that (1) analyzer diagnostic parameters are outside of acceptance criteria,
and (2) visibility is <2.5 miles.

d. Any QC and OP codes that are inconsistent with the expected values, based on
analyzer diagnostic parameters.



Data Verification and Validation SOP, STI-8194
August 5, 2024

Version 1

Page 7 of 17

e. Instances of apparent baseline drift.

f.  Reported concentrations (valid data) not within the expected range for each
compound.

i. Verify that concentration patterns are reasonable with respect to the time of
day, season, and current meteorological conditions, and whether they
correlate across multiple sampling sites.

ii. Verify that concentrations are within the limits of what can be measured by
the instrument.

9. Perform any edits to QC and OP codes to reflect the findings of the daily data check.
Additional information regarding propagation of these changes to the public website is
provided in Section D.3 of the QAPP.

a. Changes to concentration values are extremely infrequent and should only be made
if a problem with the analytical concentration determination or the averaging scheme
is discovered. Changes to QC and OP codes are often sufficient to correctly reflect
data quality.

b. Changes to QC and OP codes are infrequent, and are only made if a clear reason to
do so is discovered.

i. For example, invalidate data if a violation of the acceptance criteria that was
not captured by AutoQC logic is discovered.

ii. Similarly, validate data that was flagged for additional review if it meets
acceptance criteria.

c. All edits to data and data quality flags are captured by chain-of-custody logs within
the DMS.

10. Verify detection events with elevated concentrations (>5-10 times the minimum detection
limit) by performing spectral validation according to Section 5.3 of this SOP.

11. Navigate to the public website for the facility, review the 5-min time series plot for each
individual compound, and verify that:

a. Data displayed on the public site matches the data viewed in the non-public data
review website (Sonoma Technology's Insight DMS). Note any discrepancies in the
spreadsheet and escalate to the Project Manager.

b. Periods of missing or invalid data are correctly reflected on the public website.
c. Detection events are correctly reflected on the public website.

12. Report any observed anomalies to the field operations team and Project Manager, and
update the daily data check spreadsheet in the project documentation archive. Additional
information regarding project documentation is provided in Section A.9 of the QAPP.
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Typical observations for select diagnostic parameters and compounds monitored under Rule 1180
are shown in Table 1. The full list of measured compounds is provided in Section A.5 of the QAPP.

Table 1. Typical observations for select compounds monitored under South Coast AQMD Rule 1180.

Observational Notes

Visibility

Signal Strength
(UV-DOAS)

Signal Strength
(FTIR)

Winds

Benzene
Toluene
Ethylbenzene

Xylene

SO,

H.S

The maximum value measured by the sensor is 30 miles. Values <10 miles may
affect instrument performance, and values <2.5 miles may result in invalid data due
to environmental conditions if analyzer diagnostics are also not within acceptance
criteria.

This parameter is commonly >10%. A pattern of low signal strength can indicate
poor instrument alignment.

This parameter is commonly >0.1 V. A pattern of low signal strength can indicate
poor instrument alignment.

Wind speeds are typically 1-20 mph, and wind direction should generally follow
expected patterns due to local terrain (e.g., sea and land breezes along the coast).

This parameter is typically below the detection limit of the instrument.
This parameter is typically below the detection limit of the instrument.
This parameter is typically below the detection limit of the instrument.
This parameter is typically below the detection limit of the instrument.

This parameter is typically below the detection limit of the instrument, but ambient
background concentration are detected occasionally.

This parameter is typically below the detection limit of the instrument.

5.2 Quarterly Validation

Quarterly validation is performed after each calendar quarter to ensure quality and in accordance
with Rule 1180 requirements. The 5-min resolution data for all relevant parameters are exported
from the Sonoma Technology Insight DMS and imported into an R analysis workbook. Here, analysts
perform additional analyses, visualizations, and assessments to verify AutoQC, confirm
determinations made during daily data checks, and perform completeness calculations (see

Section A.7 of the QAPP).

Data analysts are qualified to perform quarterly analysis after a training period of at least three
months. Training includes the daily data check steps outlined in Section 5.1, experience conducting
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daily data checks for a period of three months, and shadowing an experienced data analyst during at

least one complete quarterly analysis process. The trainee’s work is reviewed by the experienced

analyst while they perform their first round of quarterly analysis, and they are released for

independent work during their second round.

The following procedure details the quarterly analysis process for an individual monitoring network:

1.

Log in to the Sonoma Technology Insight DMS with the facility-specific credentials for the
check being performed. Credentials are stored in a secure password management software.

Navigate to the Data Export page, where configurable export queries can be programmed
and executed. Export all relevant parameters collected during the quarter as “.csv” files.

Import these exported data files into an R workspace using the most recent quarterly analysis
script(s), maintained in the Sonoma Technology Bitbucket code repository.

Execute the quarterly analysis script(s), which performs the following tasks:

a. Assign data flags using the same AutoQC logic as real-time data flagging (see
Sections B.10 and D.2 of the QAPP).

b. Flag negative outliers as invalid, using “-3 x MDL" as the threshold for comparison.

c. Generate a series of output tables, figures, and “.csv” files for additional review.

Review the quarterly data set in detail. Note that findings pertaining to missing or invalid
data are usually identified and corrected during the quarter, meaning the quarterly analysis
process is commonly a redundant check on previously identified issues and resolutions. Any
new findings identified during quarterly analysis must be escalated to the Project Manager
for investigation, and proposed resolutions must be approved by the QA Manager.

a. If >5% of diagnostic parameters (signal strength, spectral match) are missing,
escalate the finding to the Project Manager for additional investigation.

b. If >25% of missing or invalid data is associated with one analyzer or sampling site,
escalate the finding to the Project Manager for additional investigation.

c. If concentration data were collected but coincident diagnostic information was
missing or outside of the expected range, AutoQC determinations are manually
inspected to ensure accurate data flagging.

i. If visibility data is missing during a period of invalid concentration data,
manual data review confirms that concentration data are not flagged as
“invalid due to environmental conditions.” In the absence of visibility data to
confirm low-visibility conditions, data count against completeness (see
Section A.7 of the QAPP).
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ii. If instrument diagnostic parameters are missing but concentration data are
reported, a malfunction of the analyzer software has occurred and data are
flagged as invalid.

iii. If spectral match parameters are reported outside of the expected range (e.g.
<0 or >100 for percent match), a malfunction of the data acquisition script
has occurred and data are flagged as invalid.

Review periods where visibility data is <2.5 miles, ensuring that only concentration
data with diagnostic parameters outside of acceptance criteria are flagged as “invalid
due to environmental conditions” and are not counted against completeness.

Review periods of invalid or missing data lasting longer than two hours and escalate
findings to the Project Manager. Create null records in the place of missing data
according to Section C.2 of the QAPP.

Review periods of planned and unplanned maintenance and compare them to field
logbooks and maintenance records. Ensure that routine maintenance was performed
as scheduled, logs reflect a sufficient level of detail, and all bump tests results are
within acceptance criteria.

i. Any failed bump tests should have been followed by additional maintenance
and retesting as outlined in the individual instrument SOPs.

ii. Maintenance logs may explain data anomalies and justify adjustments to QC
and OP Codes, following discussion with the Project Manager.

If applicable, review any questionable data for which investigation was not performed
and QC and OP codes were not adjusted during the daily data checks. Adjust QC and
OP codes according to Section D.2 of the QAPP and escalate the finding(s) to the
Project Manager.

Review any and all changes to QC and OP codes, including their justification, with the
Project Manager.

Assess the data reasonableness through statistical analyses, review of exceptional conditions
off-refinery, and comparisons to outside data.

For all sampling sites and parameters, calculate the monthly and quarterly 5-min
concentration mean, standard deviation, and minimum and maximum values. Non-
detections are assigned a value of "0 ppb” for statistical analysis.

i. Compare observations to previous quarters and typical observations (Table 1)
and escalate any anomalies to the Project Manager.

ii. Confirm that known detection events observed during the quarter are
correctly reflected in the calculated monthly and quarterly maxima.

iii. Verify that the calculated monthly and quarterly minima are > “-3 x MDL,"
and escalate the finding of any negative outliers to the Project Manager.
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b. In the event of anomalous data, review exceptional conditions off-refinery in
conjunction with meteorological data to assess potential impacts to fenceline
measurements.

c. Inthe event of anomalous data, retrieve available outside data sources for
comparison according to Section B.9 of the QAPP.

7. Review any detection events and periods where reported concentrations are >5-10 times the
minimum detection limit, according to Section 5.3 of this SOP.

8. For all sites and compounds, calculate data completeness according to Section A.7 of the
QAPP.

a. Review the resulting completeness tables and compare against logbooks and
maintenance logs.

b. Escalate findings of data completeness <95% to the Project Manager for additional
investigation.

9. For all sites and compounds, manually calculate the rolling hourly average data from quality-
controlled 5-min data, following the same logic used in real-time by the public website.

a. Investigate the cause of any discrepancies between hourly values reported on the
website and hourly values calculated during quarterly analysis, and escalate findings
to the Project Manager.

5.3 Spectral Validation

Measurements made in real time by open-path analyzers can be replicated with manufacturer-
provided data processing software. This enables analysts to visualize and confirm each real-time
analytic determination made by the analyzer during daily and quarterly analysis, to ensure data
accuracy and quality.

The following procedure details the spectral validation process:

1. Retrieve the relevant (raw) data files from the analyzer of interest, which correspond to the
event requiring spectral validation.

a. This consists of:
i. The daily data summary file corresponding to the day of interest.

ii. Individual absorbance spectra (including applicable background spectra)
corresponding to the time period of interest.

iii. Instrument libraries from the analyzer of interest.

iv. The analytic software configuration file from the analyzer of interest.
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2. Open the manufacturer-provided data processing software and adjust the analysis
parameters to match the configuration file retrieved from the analyzer of interest.

3. Where applicable, load the instrument libraries and verify that the available compounds
match the expected values for the monitoring network.

4. Examine the daily data summary file from the date and time period of interest to determine
which individual absorbance spectra are of interest, and (where applicable) which dynamic
background was loaded for each absorbance spectrum.

5. Load the applicable background and absorbance spectra. The software will automatically
duplicate the analysis, according to the configuration parameters (see Step 2 above), and
generate a differential absorbance spectrum overlaid with the applicable instrument library.

6. Select the compound of interest and visually inspect the plot, confirming the curve fitting to
the library reference spectrum, and associated spectral match determination relative to the
programmed analysis regions.

7. Report any discrepancies or incorrect peak fits to the Project Manager for additional
investigation.

5.4 Quality Assurance Management

Following the completion of quarterly analysis, an independent review of post-QC quarterly data sets
is completed by the QA Analyst. This independent review is conducted on a representative sub-set of
data using similar methods to those described in Section 5.2 of this SOP. Data are reviewed without
input from the data analyst who prepared the post-QC quarterly data set.

Findings of the independent review are compared to those of the quarterly analysis in a joint
meeting between the Data Analyst, QA Analyst, and QA Manager. The QA Manager conducts an
informal interview process to ensure that quarterly analysis was conducted according to the QAPP,
and that field documentation reflects the procedures outlined by the QAPP. New findings or
deviations are reported to the Project Manager by the QA Manager for additional investigation, and
any necessary resolutions must be approved by the QA Manager before quarterly data are submitted
(see Section C.2 of the QAPP).

6. Public Website Display

Data is displayed on the public website according to the data flags (QC and OP codes) for each
record. Data flags are assigned by the AutoQC logic and further evaluated according to Section D.2
of the QAPP. Display behavior is the same for both 5-min data and rolling hourly average data.

Valid detections (e.g. QC=0, OP=0) are shown on the website (Figure 2). Concentrations are reported
as recorded by the analyzer, with numeric values shown in the time series detail panel (left), the map
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detail panel (middle), and the map marker (right). For valid detections with concentrations below the
MDL (e.g. QC=0, OP=17), numeric values are shown but data are flagged as “<MDL.” For hourly data
only, the outer ring of the map marker visualizes the concentration relative to an hourly threshold,
with green indicating values below the threshold and orange indicating values above the threshold.

12:30 PM July 31, 2024 v 1-HOUR AVG v

Sulfur Dioxide '\

All data shown are preliminary until validated every 90 days.

300
2024-07-31 12:30 PM FDT
== Path 1, Sulfur Dioxide: 0 ppb (=<MDL)
Path 2, Sulfur Dioxide: 3.96 ppb

T Palh 3, Sulfur Diozide: 0 ppb (<MDL)

: Path 4, Sulfur Dioxide: 0 ppb (<MDL)

= == Path 5, Sulfur Dioxide: 0 ppb (<MDL} Open Path Monitor 2

< 52 == Path 6, Sulfur Dioxide: 0 ppb (<MDL) )

- == Path 7, Sulfur Dioxide: (Invalid)

% 100 Path 8, Sulfur Dioxide: (Invalid)
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Figure 2: Example of valid detections as displayed on the public website.

Valid non-detections (e.g. QC=0, OP=74) are shown on the website (Figure 3). Concentrations are
reported as “0 ppb"” on the time series detail panel (left) according to Section D.2 of the QAPP. On
the map detail panel (middle) and map marker (right), valid non-detections are flagged as “<MDL."
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Figure 3: Example of valid non-detections as displayed on the public website.

Questionable data (e.g. QC=5) are shown on the website (Figure 4). Concentration values are
reported on the time series detail panel (left), either as recorded (e.g. OP=72) or as "0 ppb” (e.g.
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OP=76), depending on whether or not they correspond to detection events. The map detail panel
(middle) and map marker (right) may or may not display values (depending on the specific cause of
the questionable data) and indicate that further review is needed. This additional review is completed
according to Section D.2 of the QAPP.
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m m m m No additional information available. Pending further D
m review. epub

Figure 4: Example of questionable data as displayed on the public website.

Invalid data (e.g. QC=9) are not shown on the website (Figure 5). Concentration values are not
reported on the time series detail panel (left), the map detail panel (middle), or the map marker
(right) because the data do not meet acceptance criteria.

12:30 PM July 31, 2024 v 1-HOUR AVG v

Sulfur Dioxide "

All data shown are preliminary until validated every 90 days.

300

2024-07-31 12:30 PM PDT
== Path 1, Sulfur Dioxide: 0 ppb (<MDL)

- Path 2, Sulfur Dioxide: 3.96 ppb

2 Path 3, Sulfur Dioxide: 0 ppb (<MDL) Path 8

= 200 Path 4 Sulfur Dioxide: 0 ppb (<MDL) # Open Path Monitor 8

g == Path 5, Sulfur Dioxide: 0 ppb (<MDL)

< S == Path 6, Sulfur Dioxide: 0 ppb (<MDL) )

- == Path 7, Sulfur Dicxide: (Invalid)

% 100 Path 8, Sulfur Dioxide: (Invalid)

7] Path 9, Sulfur Dioxide: 0 ppb (<MDL) REL

= Path 10, Sulfur Dioxide: 0 pplb (<MDL) - Invalid
o ! Sulfur Dioxide
01.00 PM 05:00 PM 09:00 PM 01:00 AM 05:00 AM 09:00 AM . .
A problem (such as low visibility, power failure, Path 8
m m m @ calibration, etc.) prevented the instrument from —
" E

[ Path 10] collecting or reporting the data

Figure 5: Example of invalid data as displayed on the public website.

Missing data (e.g. QC=8) are not shown on the website (Figure 6). Concentration values are not
reported on the time series detail panel (left), the map detail panel (middle), or the map marker
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(right) because data were not collected. Missing data results in internal alerts to the project team (see
Section B.6 of the QAPP).

7:00 AM July 10, 2024 v 1-HOUR AVG v

Styrene v

All data shown are preliminary until validated every 90 days.

Bk

2024-07-10 07:00 AM PDT
== Path 1, Styrene: 0 ppb (<MDL) REL

Path 2, Styrene: (Missing)
Path 3, Styrene: 0 ppb (<MDL) Open Path Monitor 2
== Path 4, Styrene: 0 ppb (<MDL)

== Path 5, Styrene: 0 ppb (<MDL)
== Path 6, Styrene: 0 ppb (<MDL) )
== Path 7, Styrene: 0 ppb (<MDL)
Path 8, Styrene: (Invalid)
== Path 9, Styrene: 0 ppb (<MDL)
== Path 10, Styrene: 0 ppb (<MDL)

=
=

~
Styrene ppb

- Missing
Styrene Path 2
01:00 PM 05:00 PM 09:00 PM 01:00 AM 05:00 AM 09:00 AM A problem (such as low visibility, power failure,

calibration, etc ) prevented the instrument from
D €D €D D  Fatho ]

collecting or reporting the data.

N
o =

Figure 6: Example of missing data as displayed on the public website.
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Complete the checks described below and record observations in the space provided. Note any
corrective action or issues that were escalated to the field operations team or Project Manager.
Additional information regarding acceptance criteria is provided in Section A.7 of the QAPP.

Data Analyst:

Date and Time:

Internal Website Review (5-min data)

Signal Intensity

Representative Parameter
(e.g., benzene)

Signal Intensity
Zero Path Distance (ZPD) Position

Representative Parameter
(e.g., Total VOCs)

Visibility
Wind Direction
Wind Speed

Black Carbon

Hydrogen Sulfide

UV-DOAS
Confirm that values >10%
Record any instances of invalid data
Record any instances of missing data
Record maximum concentration
FTIR
Confirm that values >0.1 V
Confirm that values are 256-257
Record any instances of invalid data
Record any instances of missing data
Record maximum concentration
Met

Confirm that values >2.5 mi

Point Monitors
Record any instances of invalid data
Record any instances of missing data
Record maximum concentration
Record any instances of invalid data
Record any instances of missing data

Record maximum concentration

Confirm that values are reasonable (0-360 degrees)

Confirm that values are within typical values for this site

Public Website Review (5-min data)

UV-DOAS

Record any instances of invalid data

Record any instances of missing data

Record any benzene detection events

Record any toluene detection events

Record any o-xylene detection events
Record any m-xylene detection events

Record any p-xylene detection events

Record any SOz detection events

Record any ethylbenzene detection events
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Record any instances of invalid data
Record any instances of missing data
Record any hydrogen cyanide detection events
Record any nitrogen dioxide detection events
Record any 1,3-butadiene detection events
Record any ammonia detection events
PR Record any acrolein detection events
Record any formaldehyde detection events
Record any acetaldehyde detection events
Record any carbonyl sulfide detection events
Record any styrene detection events
Record any total VOCs detection events
Record any instances of invalid data
Record any instances of missing data
Point Monitors
Record any benzene detection events
Record any toluene detection events
Record any instances of invalid data
Record any instances of missing data
Record any benzene detection events
Optical Tent System Record any toluene detection events
(Wilmington Refinery Only) Record any ethylbenzene detection events
Record any o-xylene detection events
Record any m-xylene detection events
Record any p-xylene detection events

All Compounds Record any instances of missing data
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